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PREFACE 
 
The Volpe National Transportation Systems Center (Volpe Center) of the United States 
Department of Transportation’s Research and Innovative Technology Administration has 
developed a modeling system to assist the National Highway Traffic Safety Administration 
(NHTSA) in the evaluation of potential new Corporate Average Fuel Economy (CAFE) 
standards.  Given externally-developed inputs, the modeling system estimates how 
manufacturers could apply additional fuel-saving technologies in response to new CAFE 
standards, and estimates how doing so would, relative to a given baseline scenario, increase 
vehicle costs, reduce national fuel consumption and carbon dioxide emissions, and result in other 
effects and benefits to society.  The modeling system can also be used to estimate the stringency 
at which an attribute-based CAFE standard satisfies various criteria.  For example, the system 
can estimate the stringency that produces a specified average required fuel economy level, or that 
maximizes net benefits to society. 
 
This report documents the design and function of the CAFE Compliance and Effects Modeling 
System as of August 1, 2012; specifies the content, structure, and meaning of inputs and outputs; 
and provides instructions for the installation and use of the modeling system. 
 
The authors of this report are Mark Shaulov, Kevin Green, Ryan Harrington, Joe Mergel, Donald 
Pickrell, Ryan Keefe, and John Van Schalkwyk. 
 
The authors acknowledge the technical contributions of individuals who have been involved in 
guiding recent changes to the modeling system, including Ken Katz, Gregory Powell, Jim 
Tamm, and Lixin Zhao of NHTSA.  The authors further acknowledge former DOT staff who 
participated in the development of earlier versions of the modeling system, including Gregory 
Ayres, Phil Gorney, Kristina Lopez-Bernal, José Mantilla, Arthur Rypinski, and Kenneth 
William. 
 
The authors further acknowledge the technical contributions of individuals who have reviewed 
detailed results of the model (and/or earlier versions of the model) and/or provided specific 
suggestions regarding the model’s design.  Among these individuals are Steve Plotkin and 
Michael Wang of the Department of Energy’s Argonne National Laboratory, Jeff Alson, William 
Charmley, Ben Ellies, David Haugen, Ari Kahan, Richard Rykowski, and Todd Sherwood of the 
U.S. Environmental Protection Agency (EPA), Gary Rogers of FEV Engine Technology, Inc., 
David Boggs, Anrico Casadei, Scott Ellsworth, and Sandy Stojkovski of Ricardo, Inc., Jamie 
Hulan of Transport Canada, and Jonathan Rubin of the University of Maine. 
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Chapter One Introduction 
 
The Energy Policy and Conservation Act (EPCA), as amended by the Energy Independence and 
Security Act of 2007 (EISA), requires the National Highway Traffic Safety Administration 
(NHTSA), an agency within the U.S. Department of Transportation (DOT), to promulgate and 
enforce Corporate Average Fuel Economy (CAFE) standards. NHTSA has been administering 
these standards since 1975. 
 
The Volpe National Transportation Systems Center (Volpe Center) provided technical support to 
the Department in connection with the establishment of the CAFE program in the 1970s, and has 
continued to provide such support since that time. The Volpe Center is a Federal fee-for-service 
organization within DOT's Research and Innovative Technology Administration (RITA). 
 
In 2002, the Volpe Center began developing a new modeling system to support NHTSA’s 
analysis of options for future CAFE standards. Objectives included, but were not limited to, the 
following: the ability to utilize detailed projections of light vehicle fleets to be produced for sale 
in the United States, the ability to efficiently estimate how manufacturers could apply available 
technologies in response to CAFE standards, the ability to quickly evaluate various options for 
future CAFE standards, and the ability to estimate a range of outcomes (in particular, changes in 
fuel consumption and emissions) resulting from such standards. 
 
Since 2002, the Volpe Center has made many changes to this modeling system. Some changes 
were made in response to comments submitted to NHTSA in connection with CAFE 
rulemakings, and in response to a formal peer review of the system. Some changes were made 
based on observations by NHTSA and Volpe Center technical staff. As NHTSA began 
evaluating attribute-based CAFE standards (i.e., standards under which CAFE requirements 
depend on the mix of vehicles produced for U.S. sale), significant changes were made to enable 
evaluation of such standards. At the same time, the system was expanded to provide the ability to 
perform uncertainty analysis by randomly varying many inputs. Later, the system was further 
expanded to provide automated statistical calibration of attribute-based standards, through 
implementation of Monte Carlo techniques, as well as automated estimation of stringency levels 
that meet specified characteristics (such as maximizing estimated net benefits to society). In 
2007, NHTSA and Volpe Center staff worked with technical staff of the U.S. Environmental 
Protection Agency (EPA) on major changes to the range of fuel-saving technologies 
accommodated by the model, as well as the logical pathways for applying such technologies.  In 
2008, NHTSA and Volpe Center staff collaborated on further revisions, particularly with respect 
to the representation of available fuel-saving technologies, support for the reexamination of 
which was provided by Ricardo, Inc. 
 
In support of the 2010 rulemaking, a multi-year technology application feature was introduced 
into the modeling system.  Additionally, for the 2011 rulemaking, a feature to evaluate voluntary 
overcompliance has been added as well. 
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Chapter Two System Design 
 
Section 1 Overall Structure 
 
The basic design of the CAFE Compliance and Effects Modeling System developed by the 
Volpe Center is as follows: The system first estimates how manufacturers might respond to a 
given CAFE scenario, and from that the system estimates what impact that response will have on 
fuel consumption, emissions, and economic externalities. A CAFE scenario involves 
specification of the form, or shape, of the standards (e.g., flat standards, linear or logistic 
attribute-based standards, scope of passenger and nonpassenger regulatory classes), and 
stringency of the CAFE standard in each model year to be analyzed. 
 
Manufacturer compliance simulation and effects estimation encompass numerous subsidiary 
elements. Compliance simulation begins with a detailed initial forecast, provided by the user, of 
the vehicle models offered for sale during the simulation period. The compliance simulation then 
attempts to bring each manufacturer into compliance with CAFE standards defined in an input 
file developed by the user; for example, CAFE standards that increase in stringency by 4 percent 
per year for 5 consecutive years, and so forth. The model sequentially applies various 
technologies to different vehicle models in each manufacturer’s product line in order to simulate 
how a manufacturer might make progress toward compliance with CAFE standards. Subject to a 
variety of user-controlled constraints, the model applies technologies based on their relative cost-
effectiveness, as determined by several input assumptions regarding the cost and effectiveness of 
each technology, the cost of CAFE-related civil penalties, and the value of avoided fuel 
expenses. For a given manufacturer, the compliance simulation algorithm applies technologies 
either until the manufacturer achieves compliance, or until the manufacturer exhausts all 
available technologies, or, if the manufacturer is assumed to be willing to pay civil penalties, 
until paying civil penalties becomes more cost-effective than increasing vehicle fuel economy. 
The user may disable the civil penalty paying option for manufacturers expected to be unwilling 
to pay them, thus effectively “forcing” the manufacturer to add additional technology even once 
it might otherwise be preferable to pay penalties (considering the cost to add further technology 
as compared to the estimated value of the resultant saved fuel). At this stage, the system assigns 
an incurred technology cost and updated fuel economy to each vehicle model, as well as any 
civil penalties incurred by each manufacturer. 
 
This point marks the system’s transition between compliance simulation and effects calculations. 
At the conclusion of the compliance simulation for a given model year, the system contains a 
new fleet of vehicles with new prices, fuel types (e.g., diesel, electricity), fuel economy values, 
and curb weights that have all been updated to reflect the application of technologies in response 
to CAFE requirements. For each vehicle model in this fleet, the system then estimates the 
following: lifetime travel, fuel consumption, and carbon dioxide and criteria pollutant emissions. 
After aggregating model-specific results, the system estimates the magnitude of various 
economic externalities related to vehicular travel (e.g., noise) and energy consumption (e.g., the 
economic costs of short-term increases in petroleum prices). 
 
Different categorization schemes are relevant to different types of effects. For example, while a 
fully disaggregated fleet is retained for purposes of compliance simulation, vehicles are grouped 
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by type of fuel and regulatory class for the energy, carbon dioxide and criteria pollutant 
calculations, and by safety and regulatory classes for the additional fatalities calculations. The 
system may be expanded in the future to represent CAFE-induced market responses (i.e., mix 
shifting), in which case such calculations would group vehicles by market segment.  Therefore, 
this system uses model-by-model categorization and accounting when calculating most effects, 
and aggregates results only as required for efficient reporting. 
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Section 2 CAFE Compliance Simulation 
 
S2.1 Compliance Simulation Algorithm 
 
Each time the modeling system is used, it evaluates one or more CAFE scenarios. Each of these 
scenarios is defined in the “scenarios” input file described in Section A.5 of Appendix A. Each 
scenario describes an overall CAFE program in terms of the program’s coverage, applicability of 
multi-fuel vehicles, the structure and stringency of the standards applicable to passenger and 
nonpassenger automobiles, and the adjustments for improvements in air conditioning. The 
system is normally used to examine and compare at least two scenarios.  The first scenario is 
identified as the baseline scenario, usually defined as the world in the absence of new CAFE 
standards (which itself can be considered in a variety of ways), providing results to which results 
for any other scenarios are compared. Although many scenarios can be examined with each run 
of the model, for simplicity in this overview, we will only describe one scenario occurring in one 
model year. 
 
The compliance simulation applies technology to each manufacturer’s product line based on the 
CAFE program described by the current scenario and the assumed willingness of each 
manufacturer to pay civil penalties rather than complying with the program. The first step in this 
process involves definition of the fleet’s initial state—that is, the volumes, prices, and attributes 
of all vehicles as projected without knowledge of future CAFE standards—during the study 
period, which can cover one or more consecutive model years (MYs). The second step involves 
evaluating the applicability of each available technology to each vehicle model, engine, and 
transmission in the fleet. The third and final step involves the repeated application of 
technologies to specific vehicle models, engines, and transmissions in each manufacturer’s fleet. 
For a given manufacturer, this step terminates when CAFE standards have been achieved or all 
available technologies have been exhausted. Alternatively, if the user specifies that some or all 
manufacturers should be considered willing to pay civil penalties for noncompliance, this step 
terminates when it would be less expensive to pay such penalties than to continue applying 
technology. Furthermore, if the system has been configured to evaluate voluntary 
overcompliance, this step would not terminate until all cost-effective solutions, for all 
manufacturers, were applied, beyond what is necessary to meet the CAFE standard. 
 
S2.1.1 Initial State of the Fleet 
 
The fleet’s initial state is developed using information contained in the vehicle models, engine, 
and transmission worksheets described in Section A.1 of Appendix A. The set of worksheets 
uses identification codes to link vehicle models to appropriate engines, transmissions, and 
preceding vehicle models.  Figure 1 provides a simplified example illustrating the basic structure 
and interrelationship of these three worksheets, focusing primarily on structurally important 
inputs. These identification codes make it possible to account for the use of specific engines or 
transmissions across multiple vehicle models. They also help the compliance simulation 
algorithm to realistically “carry over” technologies between model years. 
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Figure 1. Basic Structure of Input File Defining the Fleet’s Initial State 

MY11 MY12 MY11 MY12

1 Veh1 20.95 11,516 10,963 27,500 28,875 1 2

2 Veh2 21.78 93,383 97,767 23,000 24,150 1 3

3 Veh3 18.33 46,880 49,367 31,250 32,813 2 4

4 Veh4 22.02 65,054 68,505 24,250 25,463 3 3

5 Veh5 18.51 21,843 25,838 31,500 33,075 4 4

1 Eng1 G 6 3.5 2

2 Eng2 G 8 4 2

3 Eng3 G 6 3.5 4

4 Eng4 G 8 4 4

1 M5 C 5 M

2 A4 T 4 A

3 A5 T 5 A

4 A6 T 6 A

Engine Worksheet

Trn
ID Name Type Gears Control

Transmission Worksheet

NameEng
ID

Valves per
CylinderDisplacementCylFuel

Veh
ID

Sales MSRP

Vehicle Models Worksheet

Transmission
Code

Engine
CodeFEModel
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S2.2 Vehicle Technology Application within the CAFE Model 
 
Vehicle technologies are a set of possible improvements available for the vehicle fleet. The 
vehicle technologies, referred to below simply as ‘technologies’, are defined by the user in the 
technology input file for the model (see Section A.2 in Appendix A). As a part of the definition 
for each technology there is an associated cost for the technology, an improvement factor (in 
terms of percent reduction of fuel consumption), the introduction year for the technology, 
whether it is applicable to a given class of vehicle, grouping (by technology group – engine, 
transmission, etc.), and phase-in parameters (the amount of fleet penetration allowed in a given 
year). Also defined in the technology inputs file are cost synergies and improvement synergies. 
 
Having defined the fleet’s initial state, the system applies technologies to each manufacturer’s 
fleet based on the CAFE program for the current model year. The set of technologies 
accommodated by the model is discussed in the Preliminary Regulatory Impact Analysis (PRIA) 
and Technical Support Document (TSD) for the 2017-2025 Notice of Proposed Rulemaking 
(NPRM) regarding CAFE standards for passenger cars and light trucks produced for sale in the 
United States in model years 2017-20251. 
 
As discussed in the PRIA and TSD, the set of technologies, and the methods for considering their 
application, include all of those discussed in the 2012-2016 final rule documentation2 albeit with 
updated fuel efficiency effectiveness estimates as well as newly defined technologies for the 
2017-2025 timeframe.  The technologies discussed in 2012-2016 final rule were based on a 2002 
National Academy of Sciences report.3  That study estimated that the applicability of different 
technologies would vary based on vehicle type. Since the publication of the 2002 NAS study, 
NHTSA and EPA have agreed on technology-related estimates extending through MY2025, 
based on a range of newer studies and research, and NHTSA has developed corresponding inputs 
for use in the CAFE model.  The development of these technology estimates is discussed in the 
preamble to the proposed rule, and in the supporting technical support document and regulatory 
impact analysis.  Although the model now represents a wider range of technologies than the 2002 
NAS study, and uses different logical sequences for considering their addition to manufacturers’ 
fleets, the model retains the ability for differentiation based on vehicle type. 
 
  

                                                 
1 Available at http://www.nhtsa.gov/fuel-economy. 
2 75 FR 25324 (May 7, 2010). 
3 National Research Council, ‘‘Effectiveness and Impact of Corporate Average Fuel Economy (CAFE) Standards,’’ 
National Academy Press, Washington, DC (2002).  Available at 
http://www.nap.edu/openbook.php?isbn=0309076013 (last accessed Nov. 13, 2011). 

http://www.nap.edu/openbook.php?isbn=0309076013
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S2.2.1 Vehicle Technology Class 
 
The CAFE model uses twelve technology classes as shown in Table 1: 
 

Table 1. CAFE Technology Vehicle Classes 
Class Description 
Subcompact PC Subcompact passenger car. 
Subcompact Perf PC Subcompact performance oriented passenger car 
Compact PC Compact passenger car 
Compact Perf PC Compact performance oriented passenger car 
Midsize PC Midsized passenger car 
Midsize Perf PC Midsized performance oriented passenger car 
Large PC Large passenger car 
Large Perf PC Large performance oriented passenger car 
Small LT Small sport utility vehicles and pickups 
Midsize LT Midsize sport utility vehicles and pickups 
Large LT Large sport utility vehicles and pickups 
Minivan Minivans 

 
S2.2.2 Technology Groups 
 
The CAFE Model organizes technologies into groups, which allows the model to seek the next 
“best” technology application in any of these groups.4 There are seven groups defined: engine 
technologies, transmission technologies, electrical accessory technologies, mass reduction 
technologies, low rolling resistance tires technologies, dynamic load reduction technologies, and 
aerodynamic load reduction technologies. The table below lists the technologies represented by 
the system, and the grouping we have applied to enable the system to follow a logical 
incremental path within any given group without being unnecessarily prevented from 
considering technologies in other groups. This “parallel path” approach is discussed below. 
 

Table 2. Technology Group Assignments 
Technology Group Group Members5 
Vehicle Engine 
Technology Group 
(EngMod) 

Low Friction Lubricants - Level 1 (LUB1) 
Engine Friction Reduction - Level 1 (EFR1) 
Low Friction Lubricants and Engine Friction Reduction - Level 2 (LUB2_EFR2) 
Variable Valve Timing (VVT) 

• VVT - Coupled Cam Phasing on SOHC (CCPS) 
• VVT - Intake Cam Phasing (ICP) 
• VVT - Dual Cam Phasing (DCP) 

Cylinder Deactivation 
• Cylinder Deactivation on SOHC (DEACS) 
• Cylinder Deactivation on DOHC (DEACD) 

                                                 
4 Within the context of the compliance simulation, “best” is defined from the manufacturers’ perspective.  The 
system assumes that the manufacturer will seek to progress through the technology decision trees in a manner that 
minimizes effective costs, which include (a) vehicle price increases associated with added technologies, (b) 
reductions in civil penalties owed for noncompliance with CAFE standards, and (c) the value vehicle purchasers are 
estimated to place on fuel economy. 
5 Some technologies were evaluated during the initial development of the modeling system; however, they were later 
excluded from analysis.  These technologies appear grayed out in the table. 
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• Cylinder Deactivation on OHV (DEACO) 
Variable Valve Lift & Timing 

• Discrete Variable Valve Lift (DVVL) on SOHC (DVVLS) 
• Discrete Variable Valve Lift (DVVL) on DOHC (DVVLD) 
• Continuously Variable Valve Lift (CVVL) (CVVL) 
• Variable Valve Actuation - CCP and DVVL on OHV (VVA) 

Stoichiometric Gasoline Direct Injection (GDI) (SGDI) 
Stoichiometric Gasoline Direct Injection (GDI) on OHV (SGDIO) 
Turbocharging and Downsizing - Level 1 (18 bar BMEP) 

• Small Displacement (TRBDS1_SD) 
• Medium Displacement (TRBDS1_MD) 
• Large Displacement (TRBDS1_LD) 

Turbocharging and Downsizing - Level 2 (24 bar BMEP) 
• Small Displacement (TRBDS2_SD) 
• Medium Displacement (TRBDS2_MD) 
• Large Displacement (TRBDS2_LD) 

Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) 
• Small Displacement (CEGR1_SD) 
• Medium Displacement (CEGR1_MD) 
• Large Displacement (CEGR1_LD) 

Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) 
• Small Displacement (CEGR2_SD) 
• Medium Displacement (CEGR2_MD) 
• Large Displacement (CEGR2_LD) 

Advanced Diesel6 
• Small Displacement (ADSL_SD) 
• Medium Displacement (ADSL_MD) 
• Large Displacement (ADSL_LD) 

Vehicle Transmission 
Technology Group 
(TrMod) 

6-Speed Manual/Improved Internals (6MAN) 
High Efficiency Gearbox (Manual) (HETRANSM) 
Improved Auto. Trans. Controls/Externals (IATC) 
6-Speed Trans with Improved Internals (NAUTO) 
6-speed Dual Clutch Transmission (DCT) 
8-Speed Trans (Auto or DCT) (8SPD) 
High Efficiency Gearbox (Auto or DCT) (HETRANS) 
Shift Optimizer (SHFTOPT) 

Electrical Accessory 
Technology Group 
(ELEC) 
Includes Hybrid Technologies 

Electric Power Steering (EPS) 
Improved Accessories - Level 1 (IACC1) 
Improved Accessories - Level 2 (IACC2) 
12V Micro-Hybrid (MHEV) 
Integrated Starter Generator (ISG) 
Strong Hybrid - Level 1 (SHEV1) 
Conversion from SHEV1 to SHEV2 (SHEV1_2) 
Strong Hybrid - Level 2 (SHEV2) 
Plug-in Hybrid - 30 mi range (PHEV1) 
Plug-in Hybrid (PHEV2) 
Electric Vehicle (Early Adopter) - 75 mile range (EV1) 
Electric Vehicle (Early Adopter) - 100 mile range (EV2) 
Electric Vehicle (Early Adopter) - 150 mile range (EV3) 
Electric Vehicle (Broad Market) - 150 mile range (EV4) 
Fuel Cell Vehicle (FCV) 

Mass Reduction Mass Reduction - Level 1 (MR1) 
                                                 
6 Replacing a gasoline engine with a diesel engine. 
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Technology Group 
(MSM) 

Mass Reduction - Level 2 (MR2) 
Mass Reduction - Level 3 (MR3) 
Mass Reduction - Level 4 (MR4) 
Mass Reduction - Level 5 (MR5) 

Low Rolling Resistance Tires 
Technology Group 
(ROLL) 

Low Rolling Resistance Tires - Level 1 (ROLL1) 
Low Rolling Resistance Tires - Level 2 (ROLL2) 
Low Rolling Resistance Tires - Level 3 (ROLL3) 

Dynamic Load Reduction 
Technology Group 
(DLR) 

Low Drag Brakes (LDB) 
Secondary Axle Disconnect (SAX) 

Aerodynamic Reduction 
Technology Group 
(AERO) 

Aero Drag Reduction, Level 1 (AERO1) 
Aero Drag Reduction, Level 2 (AERO2) 

 
Input estimates for each of these technologies are specified in the technologies input file, and are 
specific to each of the CAFE technology vehicle classes, as shown in the following table. Table 3 
lists some of the input assumptions specified in this file7. 
 

Table 3. Technology Input Assumptions 
Input Definition 
Applicable If the technology is available for applicability. 
Year Available First model year the technology is available for applicability. 
Year Retired Last model year the technology is available for applicability. 

TechType Technology group of which the technology is a member, as shown in Table 2 
above. 

FC Overall fuel consumption improvement estimate of the technology. 

FCg Fuel consumption improvement estimate to apply to the gasoline fuel economy 
value when a vehicle is being converted to a PHEV. 

FCg Share Assumed percentage of miles driven by the vehicle on the gasoline fuel after 
being converted to a PHEV. 

Off-Cycle Credit PC Amount of off-cycle credit that the vehicles regulated as passenger automobiles 
incur as a result of applying the technology. 

Off-Cycle Credit LT Amount of off-cycle credit that the vehicles regulated as light trucks incur as a 
result of applying the technology. 

Cost Table Fully learned-out table of costs by model year8 (in 2009 dollars). 

Maintenance Cost Table Fully learned-out table of additional maintenance costs, by model year, incurred 
by a vehicle as a result of applying additional technologies. 

Repair Cost Table Fully learned-out table of additional non-warranty repair costs, by model year, 
incurred by a vehicle as a result of applying additional technologies. 

Loss of Value The consumer welfare loss resulting from the decreased range of electric 
vehicles. 

Delta Weight (%) Percentage by which the vehicle's weight changes after technology is applied. 
 
Among other things, the technology input assumptions define applicability, cost, fuel 
consumption reduction factors, off-cycle credits, consumer welfare losses, as well as the 
technology group of which the technology is a member. 
 
S2.2.3 Technology Availability 
                                                 
7 Additional technology assumptions are further discussed in Section A.2 of Appendix A. 
8 Because mass reduction is applied as a percentage of curb weight, the corresponding cost estimates are in dollars 
per pound of incremental change in curb weight. 
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The technology input assumptions provide two methods of defining technology availability. 
First, the Applicability field determines whether the technology is generally available for 
application on a particular class of vehicle. If this field is set to TRUE, the technology may be 
considered for application by the modeling system; otherwise, the technology will be 
unavailable. 
 
If Applicability is set to TRUE, the Year Available and Year Retired fields from the input 
assumptions are further considered in determining the technology’s availability. Together, these 
two fields define a range of model years during which the technology may be applied. If the year 
being evaluated by the CAFE Model is prior to the setting in the Year Available field or after the 
Year Retired field, then the technology will be unavailable for the particular class of vehicle. 
 
Besides those mentioned, additional technology applicability factors are considered by the 
modeling system. For example, there are controls for individual vehicles, engines, or 
transmissions in the market data file that can override the controls here (see Sections A.1.2, 
A.1.3, and A.1.4 in Appendix A). There are also dynamic considerations made while the model 
is running based on vehicle configuration (e.g., cylinder deactivation is not applied to vehicles 
with manual transmissions), as well as technology combination factors (e.g., DVVLD is 
incompatible with CVVL). Additionally, technology phase-in caps may limit the availability of 
technologies if a particular penetration rate is reached for a vehicle’s manufacturer. 
 
S2.2.4 Technology Fuel Consumption Reduction Factors 
 
The technology input assumptions define the fuel consumption reduction factors FC and FCg. 
The reduction in fuel consumption values are on a gallons-per-mile basis and represent a percent 
reduction in fuel consumption. The formula to find the increase in fuel economy (miles-per-
gallon) of a vehicle with fuel consumption reduction factors from one or more technologies is: 
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  (1) 

 
where FEorig is the original fuel economy for the vehicle, FCReduction0,1,…n are the fuel 
consumption reduction factors attributed to 0-th to n-th technologies, and FEnew is the resulting 
fuel economy for the same vehicle. 
 
Whenever the modeling system converts a vehicle model to a Plug-In Hybrid/Electric Vehicle 
(PHEV), that vehicle is assumed to operate on gasoline and electricity fuel types simultaneously. 
In such a case the FC field represents the overall improvement in the combined (gasoline and 
electricity) vehicle fuel economy, while the FCg field specifies what the improvement in the 
gasoline-only component of the vehicle’s fuel economy would be.9 Lastly, the FCg Share field 
specifies the assumed amount of miles driven by the vehicle in gasoline-only operation. 

                                                 
9 When being converted to a Plug-In Hybrid, the vehicle’s fuel economy while operating on gasoline may 
potentially increase due to improvements in regenerative breaking associated with a bigger battery. Presently, 
however, it is assumed that no such improvement exists, and the FCg field is listed as zero (0). 
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S2.2.5 Technology Cost Tables 
 
The technology input assumptions provide a fully “learned-out” table of year-by-year technology 
costs, as specified by the Cost Table field. 
 
Some technology costs have a cost basis associated with them.  For instance, for mass reduction 
technologies, the technology input costs must be multiplied by the reduction of vehicle curb 
weight, in pounds, to get the full cost of applying the technology.  Similarly some engine 
technologies have costs determined on a per-cylinder or per-bank (configuration) basis. 
 
Along with the base Cost Table, the input assumptions also define the Maintenance Cost Table 
and the Repair Cost Table.  Both of these tables are specified for each model year and account 
for the learning effect, wherever applicable.  The former identifies the changes in the amount 
buyers are expected to pay for maintaining a new vehicle10, while the latter identifies the 
increases in non-warranty repair costs attributed to application of additional technology. 
 
Further discussion of the technology cost input assumptions can be found in Section A.2 of 
Appendix A. 
 
S2.2.6 Technology Synergies 
 
Technology synergies exist when the combination of two technologies yields a fuel consumption 
reduction which differs from the value that would be derived directly from equation (1). The 
synergy can be positive (e.g., increased reduction of fuel consumption) or negative (decreased 
reduction of fuel consumption). The model also uses some cost “synergies” to ensure correct cost 
accounting as the model proceeds down the decision trees. 
 
Synergy relationships between technologies are captured in the two synergies table in the 
technology input file. The system reads the information from the table and, for each technology, 
stores the synergy factors between that technology and all other technologies. For cases where 
there is no synergy relationship, there will be no listing in the table, and the synergy factor will 
be zero (0.0). In cases where there are synergies, that applicable factor is added to the fuel 
consumption reduction or to the cost value. 
 
In the case of fuel consumption reduction synergies, negative synergies lessen the fuel 
consumption reductions of a technology, the system assumes technologies will not combine to 
degrade fuel economy (i.e., to produce negative reductions in fuel consumption). For synergies 
involving technology costs, the final result is allowed to become negative. 
 
The layout of the synergy table in the technology input file is discussed in Section A.2.1 of 
Appendix A. 
 
                                                 
10 The maintenance costs may lead to increases in cost to consumers, such as for advanced diesel engines, or in cost 
saving to consumers, such as for of electric vehicles.  In the case of electric vehicles, the cost savings result from 
avoiding traditional vehicle maintenance such as engine oil changes. 
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S2.2.7 Technology Applicability and Backfill 
 
The modeling system determines the applicability of each technology to each vehicle model, 
engine, and transmission. If the technology is available in the current model year, the system 
identifies the technology as potentially applicable. However, technology “overrides” can be 
specified for specific vehicle models, engines, and transmissions in the corresponding input 
files.11 If any such overrides have been specified, the algorithm reevaluates the technology’s 
applicability, as shown in Figure 2. 
 

 
Figure 2. Technology Applicability Determination 

 
In some cases, technologies may be bypassed because they are not cost-effective. If the modeling 
system applies a technology that resides later in the sequence, it will ‘backfill’ anything that was 
previously skipped in order to fully account for technology costs and improvements, each of 
which are specified on an incremental basis. This backfill, however, will not occur if a 
                                                 
11 These overrides, described in Sections A.1.2, A.1.3, and A.1.4 of Appendix A, provide a means of accounting for 
engineering and other constraints not otherwise represented by input data or the overall system. 
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technology is not applicable to the vehicle. In the case where the backfill operation requires 
backtracking through branches in the sequence, the modeling system will first resolve any 
engineering constraints and limitations, as well as applicability issues to determine whether the 
branch still exists. If there is still a branch, the system will follow the technology path that would 
result in lower overall costs.12 
 
S2.2.8 Technology Sequencing and Branching 
 
The sequence of applying technology works in the following way: Within each group, the 
technology sequence of application proceeds as shown in the technology input file. There are 
some points where the sequence path can branch onto a different course, as discussed below. The 
groups are independent of each other, although there may be some interactions. 
 
S2.2.8.1 Sequencing and Branching within a Technology Group 
 
Within each technology group, the choice of technologies that can be applied may vary from 
vehicle to vehicle based on the baseline configuration of the vehicle or on the previous 
application of technologies. Both the engine and transmission technology groups have optional 
paths. The choice of which path depends upon a variety of factors, which include the vehicle 
class, the vehicle configuration, technology override settings for that vehicle, previous 
applications of technology, technology availability (year available), and phase-in restrictions. 
When left with a choice of two or more technologies, cost-effectiveness is used to choose the 
technology to apply. 
 
S2.2.8.2 Bypassing a Technology 
 
In cases where a technology is already installed in the baseline vehicle configuration or is 
unavailable for other reasons (e.g., it is not compatible with this vehicle class), that technology is 
simply bypassed in the technology path. For example, if engine friction reduction has previously 
been installed, the next available engine technology after low-cost lubricants on a vehicle with 
overhead valves (OHV) is cylinder deactivation. 
 
Branching within a technology group sequence occurs for the following reasons: 1) normal 
branch where there are two or more different (and mutually incompatible) technology choices – 
the model can choose one or another path; 2) limitations of technology choice based on vehicle 
configuration; 3) combination of both. 
 
An example of normal branching is DVVLD and CVVL in the engine technology group. 
 
An example of the limitations would be within the engine technology group, as shown in Figure 
3, below, where there is a separate path for engines with overhead valves (OHV) engines, single 

                                                 
12 Given the complexity associated with having to evaluate the effectiveness of backfilled branches (due to its 
recursive nature), and considering the extremely rare situations where such branches occur, the modeling system 
does not attempt to evaluate the full cost-effectiveness of a technology for the purposes of picking a backfill path.  
Instead, the model simply determines the path to follow based on lower costs.  However, once a backfill path is 
chosen, the model does evaluate the full cost-effectiveness of all technologies in that path. 
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overhead cam engines (SOHC), and for engines with dual overhead cams (DOHC).  Likewise, as 
shown in Figure 4 further down, the transmission technology group follows two distinct paths – 
one for manual transmissions and another for automatics. 
 
S2.2.8.3 Engine Technology Sequencing and Branching 
 
The engine technology sequence, shown in Figure 3, includes there primary paths: single 
overhead cam (SOHC); dual overhead cam (DOHC); and overhead valve (OHV). The modeling 
system determines the choice of path for a vehicle model based on that vehicle’s engine 
attributes. An additional branch, between DVVLD and CVVL technologies, exists within the 
DOHC branch. The model chooses which path to follow based on availability for the specific 
vehicle and the vehicle technology class, the technology phase-in constraints, and the technology 
cost-effectiveness. 
 
Further down within the engine technology sequence is another branch, which culminates in a 
choice between dieselization and a strong hybrid path. The path that the model chooses is, again, 
based on availability for the specific vehicle and the vehicle technology class, the technology 
phase-in constraints, and the technology cost-effectiveness. 
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Figure 3. Engine Technology Group Technology Sequence 
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S2.2.8.4 Transmission Technology Sequencing 
 
The transmission technology sequence, shown in Figure 4, contains two separate paths, one used 
for automatic transmissions, and the other for manual transmissions.  Depending on the 
transmission that the vehicle initially starts with, one sequence or the other will be followed. 
 

 
Figure 4. Transmission, Electrification/Accessory, and Hybrid Technology Decision Tree  
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S2.2.8.5 Electrical Accessory & Strong Hybrid Technology Sequencing 
 
The electrical accessory technology sequence has no branches, as shown in Figure 4. The 
technologies on the electrical accessory path can be applied to a vehicle any time, provided they 
meet engineering and phase-in constraints. However, the technologies in the strong hybrid path 
(i.e., strong hybrids, plug-in hybrids and electric vehicles) can only be applied once the engine 
(with the exception of the Advanced Diesel technology) and transmission paths have been fully 
applied. Furthermore, if a strong hybrid technology is applied before exhausting the 
electrification path, any preceding electrification technologies will be backfilled. Thus the 
engine, transmission, and (to a certain extent) electrification technologies are considered 
“enablers” that must be installed on a vehicle prior to the application of the strong hybrid 
technologies. 
 
S2.2.8.6 Vehicle (Other) Technology Sequencing 
 
The rest of the technology sequences (mass reduction, low rolling resistance tires, dynamic load 
reduction, and aerodynamic load reduction), shown in Figure 5, have no branches. However, 
with the exception of dynamic load reduction technologies, before the modeling system is able to 
apply a technology appearing later on the decision tree, the preceding technologies must be 
applied to a vehicle. 
 

 
Figure 5.  Vehicle Technology Decision Tree 
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S2.3 Compliance Simulation Loop 
 
If a given technology is still considered applicable after considering any overrides, the algorithm 
again re-evaluates applicability based the following engineering conditions: 
 

Table 4. Engineering Conditions for Technology Applicability 
Technology Constraint 
All technologies Do not apply if already present on the vehicle. 
Low-Friction Lubricants Do not apply if engine oil is better than 5W30. 
Variable Valve Timing Family Do not apply to diesel or rotary engines.  
Variable Valve Lift and Timing 
Family 

Do not apply to diesel or rotary engines. Do not apply to vehicles with VVLT 
technology already in place. Once a VVLT (continuous or discrete) are 
applied, the other VVLT cannot be applied. 

Cylinder Deactivation Do not apply to engines with inline configuration, and/or fewer than 6 
cylinders. Do not apply to turbocharged and downsized, diesel or rotary 
engines.  Do not apply to vehicles with manual transmissions. 

Turbocharging and downsizing Do not apply to diesel or rotary engines.  
Turbocharging and downsizing, 
Level 2 

Do not apply if vehicle has a manual transmission with fewer than 6 gears or 
an automatic/DCT transmission with fewer than 8 gears. 

Cooled Exhaust Gas 
Recirculation (Level 1 & 2) 

Do not apply if vehicle has a manual transmission with fewer than 6 gears or 
an automatic/DCT transmission with fewer than 8 gears. 

Stoichiometric GDI Do not apply to diesel or rotary engines. 
Advanced Diesel Do not apply to strong hybrid, plug-in hybrid, or electric vehicles. 
Strong Hybrids, Plug-in 
Hybrids, and Electric Vehicles 

Do not apply to diesel vehicles.  Do not apply until all engine and transmission 
technology improvements were already made to a vehicle. 

 
Having determined the applicability of each technology to each vehicle model, engine, and/or 
transmission, the compliance simulation algorithm begins the process of applying technologies 
based on the CAFE standards applicable during the current model year. This involves repeatedly 
evaluating the degree of noncompliance, identifying the “best next” (as described above) 
technology available on each of the parallel technology paths mentioned above, and applying the 
best of these. Figure 6 gives an overview of the process. If, considering all regulatory classes, the 
manufacturer owes no CAFE civil penalties, then the algorithm applies no technologies beyond 
any carried over from the previous model year, because the manufacturer is already in 
compliance with the standard. If the manufacturer does owe CAFE civil penalties, then the 
algorithm first finds the best next applicable technology in each of the technology groups (e.g., 
engine technologies), and applies the same criterion to select the best among these. If this 
manufacturer is assumed to be unwilling to pay CAFE civil penalties (or, equivalently, if the user 
has set the system to exclude the possibility of paying civil penalties as long as some technology 
can still be applied), then the algorithm applies the technology to the affected vehicles. If the 
manufacturer is assumed to be willing to pay CAFE civil penalties and applying this technology 
would have a lower “effective cost” (discussed below) than simply paying penalties, then the 
algorithm also applies the technology. In either case, the algorithm then reevaluates the 
manufacturer’s degree of noncompliance. If, however, the manufacturer is assumed to be willing 
to pay CAFE civil penalties and doing so would be less expensive than applying the best next 
technology, then the algorithm stops applying technology to this manufacturer’s products. After 
this process is repeated for each manufacturer. It is then repeated again for each modeling year. 
Once all modeling years have been processed, the compliance simulation algorithm concludes. 
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Figure 6. Compliance Simulation Algorithm 

 
Whether or not the manufacturer is assumed to be willing to pay CAFE penalties, the algorithm 
uses CAFE penalties not only to determine whether compliance has been achieved, but also to 
determine the relative attractiveness of different potential applications of technologies. 
Whenever the algorithm is evaluating the potential application of a technology, it considers the 
effective cost of applying that technology to the group of vehicles in question, and chooses the 
option that yields the lowest effective cost.13 The effective cost is used for evaluating the relative 
attractiveness of different technology applications, not for actual cost accounting. The effective 

                                                 
13 Such groups can span regulatory classes. For example, if the algorithm is evaluating a potential upgrade to a given 
engine, that engine might be used by a station wagon in the domestic passenger automobile fleet, a large car in the 
imported passenger automobile fleet, and a minivan in the nonpassenger automobile fleet. If the manufacturer’s 
domestic and imported passenger automobile fleets both comply with the corresponding standard, the algorithm 
accounts for the fact that upgrading this engine will incur costs and realize fuel savings for all three of these vehicle 
models, but will only yield reductions of CAFE fines for the nonpassenger fleet. 
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cost is defined as the change in total technology costs incurred by the manufacturer (adjusted 
downward by 23% to account for vehicles’ future resale value) plus the change in CAFE 
penalties incurred by the manufacturer minus the value of any reduction of fuel consumed by 
vehicles sold by the manufacturer. The calculation can span multiple modeling years. If the 
candidate technology was enabled for application in a previous year and not used, then it can 
remain as a candidate to be applied and then carried forward to the current model year. The 
impact of the technology application in each of these years is summed to obtain the effective 
cost. 
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(2)  

 
where PresentMY is the current modeling year, BaseMY is the first year of the potential 
application of the technology (can be less than or equal to PresentMY), ΔTECHCOST is simply 
the product of the unit cost of the technology, WELFARELOSSi is the loss of value to the 
consumer resulting from the reduction in travel range of electric vehicles, and the total sales (Nj) 
of the affected cohort of vehicles (j) for all years involved in the candidate technology 
application. The value of the reduction in fuel consumption achieved by applying the technology 
in question to all vehicles i in cohort j is calculated as follows:14 
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(3) 

 
where SURVv is the car and truck average probability that a vehicle of that vintage will remain in 
service, MIv is the car and truck average number of miles driven in a year at a given vintage v, 
VMTGROWTHMY+v is the growth factor to apply to the base miles driven in the current model 
year MY at the given vintage v, FT is the fuel type the vehicle operates on (gasoline, diesel, or 
electricity), (FEFT)i and (FE'FT)i are the vehicle’s fuel economy for a specific fuel type prior to 
and after the pending application of technology, (FSFT)i and (FS'FT)i are the vehicle’s assumed 
share of operating on a specific fuel type prior to and after the pending application of technology, 
GAPFT is the relative difference between on-road and laboratory fuel economy for a specific fuel 
type, Ni is the sales volume for model i in the current model year MY, (PRICEFT)MY+v is the price 
of the specific fuel type in year MY+v, and PB is a “payback period”, or number of years in the 
future the consumer is assumed to take into account when considering fuel savings. As discussed 
in Section A.3 of Appendix A, SURVv, MIv, VMTGROWTHMY+v, (PRICEFT)MY+v, and GAPFT are 
                                                 
14 This is not necessarily the actual value of the fuel savings, but rather the increase in vehicle price the manufacturer 
is assumed to expect to be able impose without losing sales. 
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all specified in the parameters input file, while the values for PB are specified in the market data 
input file (see Section A.1.1 in Appendix A). 
 
In equation (2), FINE is the change in total CAFE penalties (i.e., accounting for all regulatory 
classes in the current CAFE scenario and model year). Typically, FINE is negative because 
applying a technology would increase CAFE.15 FINE is calculated by evaluating the following 
before and after the pending technology application, and taking the difference between the 
results: 
 

 ( )MIN ,0F C
C

FINE k CREDIT= − ∑  (4) 

 
Here, kF is in dollars per mpg (e.g., $55/mpg) and specified in the scenarios file. 
 
Within each regulatory class C, the net amount of CAFE credit created (noncompliance causes 
credit creation to be negative, which implies the use of CAFE credits or the payment of CAFE 
penalties) is calculated by subtracting the CAFE level achieved by the class from the standard 
applicable to the class, and multiplying the result by the number of vehicles in the class. Taking 
into account attribute-based CAFE standards, this is expressed as follows:  
 
 ( ) ( )STD , CAFE ,C C C C C C C CCREDIT N= −  N A N FE  (5) 

 
where AC is a vector containing the value of the relevant attribute for each vehicle model in 
regulatory class C, CAFEC is the CAFE level for regulatory class C (e.g., if the standard depends 
on curb weight, AC contains each vehicle model’s curb weight), FEC is a vector containing the 
fuel economy level of each vehicle model in regulatory class C, NC is the total sales volume for 
regulatory class C, NC is a vector containing the sales volume for each vehicle model in 
regulatory class C, and STDC(NC ,AC) is a function defining the standard applicable to 
regulatory class C. Figure 7 gives an overview of the logic the algorithm follows in order to 
identify the best next technology application for each technology group. 
 
Within a given technology group, the algorithm considers technologies in the order in which they 
appear. If the phase-in limit for a given technology has been reached, the algorithm proceeds to 
the next technology. If not, the algorithm determines whether or not the technology remains 
applicable to any sets of vehicles, evaluates the effective cost of applying the technology to each 
such set, and identifies the application that would yield the lowest effective cost. 
 
As shown in Figure 7, the algorithm repeats this process for each technology group, and then 
selects the technology application yielding the lowest effective cost. As discussed above, the 
algorithm operates subject to expectations of the willingness of each manufacturer to pay fines. 
COSTeff is determined, as above, by equations (2), (3), and (4), irrespective of the manufacturer’s 
willingness to pay fines. 
 

                                                 
15 Exceptions can occur, for example, if mass reduction is applied under a CAFE system in which attribute standards 
are weight-based rather than footprint-based. 
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At the end of each year in the model year loop, the vehicle/technologies combinations that can be 
candidates for application in multi-year processing are identified. 
 

 
Figure 7. Determination of "Best Next" Technology Application 
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Chapter Three Calculation of Effects 
 
This chapter describes the way the CAFE modeling system estimates the effects of potential new 
CAFE standards on energy use, as well as on emissions of greenhouse gases and other air 
pollutants.  These effects are caused by improvements in the fuel economy of individual vehicle 
models that manufacturers make in response to the implosion of higher CAFE standards.  This 
section also describes how these energy use and environmental impacts are translated into 
estimates of economic benefits or costs, and identifies which of these economic impacts are 
borne privately by vehicle owners and by society as a whole. 
 
The effects on energy use and emissions from tightening or reforming CAFE standards are 
estimated separately for each individual vehicle model and vintage (or model year) over its 
expected life span in the U.S. vehicle fleet.  A vehicle model’s life span extends from the initial 
model year when it is produced and sold, through the year when vehicles produced during that 
model year have reached the maximum age assumed in the CAFE model.16  Each of the effects 
of raising CAFE standards is measured by the difference in the value of a variable – such as total 
gallons of fuel consumed by a vehicle model and vintage over its lifetime – with its baseline fuel 
economy level, and its estimated fuel economy if that model were instead required to comply 
with a stricter CAFE standard.  A vehicle model’s baseline fuel economy level is usually (but not 
necessarily) defined as the level of fuel economy it would be expected to have if the CAFE 
standard currently in effect for its vehicle class (automobiles or light trucks) remained in effect 
for the future model year when it is produced. 
 
Although these effects are calculated for individual vehicle models, vintages, and future calendar 
years over their respective lifetimes, they are typically reported at the aggregate level for all 
vehicle models in a CAFE regulatory class (domestic automobiles, imported automobiles, and 
light trucks) produced during each model year affected by a proposed standard.  Cumulative 
impacts for each CAFE regulatory class and model year over its expected life span are reported 
both in undiscounted terms and as their present value discounted to the calendar year when each 
model year is produced. 
 
  

                                                 
16 We adopt the simplifications that vehicle model years and calendar years are identical, and that all vehicles 
produced during a model year are sold and placed into service during the corresponding calendar year. 
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Section 1 Light-Duty Vehicle Production and Lifetimes 
 
The forecast number of new vehicles of a specific model k produced and sold during a given 
model year MY is: 
 
 , ,k MY MY k MYn N P=  (6) 
 
Where NMY denotes total sales of all models produced during that model year, and Pk,MY is the 
proportion of total production and sales during that model year that is accounted for by model k.  
 
The number of vehicles of a specific model and model year (or vintage) that remains in service 
during each subsequent calendar year is calculated by multiplying the number originally 
produced by estimates (model inputs) of the proportion expected to remain in service at each age 
up to an assumed maximum lifetime.  Thus the number of vehicles of model k produced during 
model year MY that remain in use during a future calendar year t, or nk,MY,t, is: 
 
 

, , , ,k MY t k MY k an n s=
 (7) 

 
where sk,a denotes the proportion of vehicles of model k expected to remain in use at the age a 
that vehicles produced during model year MY will have reached during calendar year t.  The age 
of a vehicle model produced in model year MY during calendar year t is defined as: 
 
 a = t – MY.17 (8) 
 
The CAFE model currently accommodates different schedules of survival rates by vehicle age 
for passenger automobiles and light trucks, where light trucks are separated into vans, SUVs, and 
pickups, as reported in Section A.3.1 of Appendix A.  Based on analysis of recent registration 
data, the maximum ages of passenger automobiles and light trucks are estimated to be 30 years 
and 37 years, respectively.18 
 
Each vehicle model k produced during a model year MY is designated as operating on a specific 
fuel type or employing a specific technology; all units of that model produced during a model 
year are assumed to be of the same fuel or technology type.  The CAFE model currently 
recognizes five fuel or technology types: gasoline, diesel, flexible-fuel vehicles (or FFVs, which 
are capable of operating on gasoline or on gasoline blended with up to 85% ethanol), plug-in 
hybrid electric vehicles (or PHEVs, which can operate on either gasoline or electricity generated 
off-board and stored in on-board batteries), and electric vehicles (or EVs, which operate only on 
electricity generated off-board and stored in on-board batteries).  The fractions of total mileage 

                                                 
17 We define a vehicle’s age to be 0 during the year when it is produced and sold; that is, when t=MY.  Thus, for 
example, a model year 2005 vehicle is defined to be 10 years old during calendar year 2015.  Because we do not 
attempt to forecast changes in the proportion of vehicles produced during future model years that are expected to 
survive to each age, a vehicle’s age depends only on the difference between its model year (MY) and the calendar 
year (t) for which these calculations are performed, and not on their specific values. 
18 These are defined as the ages when the number of vehicles of a model year that remain in service has declined to 
fewer than 2% of those originally produced. 
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for which FFVs operate on gasoline and ethanol-blend fuels, and the fractions of total mileage 
for which PHEVs operate on gasoline and stored electricity, are inputs to the model. 
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Section 2 Vehicle Use and Total Lifetime Mileage 
 
The CAFE model employs the widely-documented relationship between vehicle age and 
declining average vehicle use to estimate the number of miles that individual vehicle models are 
driven annually and in total over their expected lifetimes.  Initial estimates of the relationship 
between vehicle age and average annual miles driven were tabulated from the sample of 
approximately 140,000 household vehicles included in the 2009 National Household Travel 
Survey (NHTS).19  Separate schedules of average annual miles driven by age of vehicle were 
developed for passenger automobiles and light trucks, where light trucks are separated into vans, 
SUVs, and pickups, as reported in Section A.3.1 of Appendix A. 
 
Two adjustments are applied to these mileage schedules to forecast the average number of miles 
that vehicles produced during future model years will be driven each year over their expected 
lifetimes.  First, the estimates of annual miles driven by passenger cars and light trucks during 
2008 are adjusted to reflect assumed future growth in average vehicle use.20  The average 
number of miles driven by cars and light trucks of all ages is assumed to grow by 0.5% per year 
from 2008 on. 
 
Second, the estimates of average annual miles driven by cars and light trucks of each age derived 
from the NHTS (and adjusted for expected future growth as described above) are further adjusted 
by applying the estimated elasticity of vehicle use with respect to fuel cost per mile to the 
difference in inflation-adjusted gasoline price per gallon between 2008 (when the NHTS data on 
vehicle use were collected) and each subsequent calendar year.  This adjustment employs actual 
gasoline prices for the years 2009-2010, forecasts for 2011-2035 reported in the U.S. Energy 
Information Administration’s Annual Energy Outlook 2011, and extrapolations of gasoline 
prices beyond the year 2035 developed by EPA.21  This adjustment assumes an elasticity of 
annual vehicle use with respect to fuel cost per mile of -0.10, corresponding to a fuel economy 
rebound effect of 10%. 
 
Thus the average number of miles driven by surviving vehicles of model k and model year MY 
during calendar year t, or mk,MY,t , is given by: 
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19 For a description of the survey and methods for estimating annual vehicle use, see 2009 National Household 
Travel Survey User’s Guide, Version 3, January 2004, available at 
http://nhts.ornl.gov/2001/usersguide/UsersGuide.pdf (last accessed November 30, 2011). 
20 Increases in the average number of miles cars and trucks are driven each year have been an important source of 
historical growth in total car and light truck use, and are expected to represent an important source of future growth 
in total light-duty vehicle travel as well. 
21 See U.S. Energy Information Administration, Annual Energy Outlook 2011, Reference Case, “Petroleum Product 
Prices,” available at http://www.eia.gov/oiaf/aeo/tablebrowser/#release=AEO2011&subject=0-AEO2011&table=12-
AEO2011&region=0-0&cases=ref2011-d020911a (last accessed November 30, 2011). 

http://nhts.ornl.gov/2001/usersguide/UsersGuide.pdf
http://www.eia.gov/oiaf/aeo/tablebrowser/#release=AEO2011&subject=0-AEO2011&table=12-AEO2011&region=0-0&cases=ref2011-d020911a
http://www.eia.gov/oiaf/aeo/tablebrowser/#release=AEO2011&subject=0-AEO2011&table=12-AEO2011&region=0-0&cases=ref2011-d020911a
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where mtype,t-MY,2008 is the average annual mileage for a car or light truck that was of age t-MY 
during 2008, r is the rate of growth in average annual miles per vehicle beginning in 2008, t-
2008 is the number of years that have elapsed between 2008 and calendar year t, εm,cpm is the 
elasticity of annual vehicle use with respect to fuel cost per mile, Ck,MY,t is fuel cost per mile 
during year t for a car or light truck model k, and Ck,t-MY,2008 is fuel cost per mile for a car or light 
truck that was of age t-MY during 2008. 
Because the value of mtype,t-MY,t,2008 in equation (9) differs between cars and light trucks, the value 
of mk,MY,t will take one of two values, depending on whether model k is classified as an 
automobile or a light truck. 
 
The value of fuel cost per mile for vehicle model k of model year MY during each year t of its 
expected lifetime, denoted Ck,MY,t,CAFE in equation (9), depends on both the price per gallon of 
gasoline during year t and the actual fuel economy model k achieves in on-road driving.  
Specifically, 
 
 

)1(,,
,,, gapmpg
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=  (10) 

 
where Pt is the inflation-adjusted price per gallon of gasoline forecast for year t, and 
mpgk,MY,CAFE is the rated fuel economy that model k achieves for model year MY with the 
assumed CAFE standard in effect.  Each model’s rated fuel economy is assumed to be 
determined during the model year when it is produced, and to remain fixed throughout its 
lifetime.  However, its actual on-road fuel economy is assumed to fall short of that rating by the 
on-road fuel economy “gap” (a model input, currently assumed to be 20% for gasoline, diesel, 
and ethanol-85 fuel types, and 30% for electricity fuel type).  Furthermore, the on-road fuel 
economy of electric vehicles, as well as the electricity fuel economy component of plug-in 
hybrid/electric vehicles, is further reduced by the petroleum equivalency factor. 
 
Equations (9) and (10) together indicate that the average number of miles that surviving vehicles 
of a model k and model year MY are driven during each year t of their lifetimes depends on their 
fuel economy.  The fuel economy that each vehicle model is projected to achieve can differ 
between the baseline market forecast for model year MY, which assumes that the CAFE standard 
prevailing during the previous model year would be extended to apply to model year MY, and 
any alternative CAFE standard that is considered for model year MY. 
 
As a consequence, the average number of miles that vehicles of model k and model year MY are 
driven during year t will also differ between the baseline market forecast and an alternative 
CAFE standard, depending on whether its manufacturer elects to increase that model’s fuel 
economy as part of its strategy to comply with the alternative standard.  This difference reflects 
the fuel economy rebound effect, which occurs because buyers of new vehicles respond to the 
reduction in their operating costs that results from their higher fuel economy by driving slightly 
more.22 
                                                 
22 Average annual vehicle use under both the baseline market forecast of fuel economy and a higher CAFE standard 
are calculated by reference to the schedules of average annual mileage by age derived from the 2001 NHTS, as 
equations (9) and (10) indicate.  Thus the difference between a model’s annual use under those two scenarios differs 
slightly from the estimate that would have resulted from first calculating annual use under the baseline market 
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The total number of miles driven by all vehicles of a specific model and vintage (model year) 
during each calendar year they remain in the fleet is then calculated by multiplying the 
appropriate estimate of annual miles driven per vehicle by the number of vehicles of that model 
year remaining in service during that year.  Thus the total miles driven during year t by the 
surviving vehicles of model k that were originally produced during model year MY, denoted 
Mk,MY,t,CAFE, is calculated as: 
 
 CAFEtMYktMYkCAFEtMYk mnM ,,,,,,,, =  (11) 

 
where mk,MY,t,CAFE is as defined above. 
 
  

                                                                                                                                                             
forecast of MPG from the 2001 NHTS, and then adding the increase in use estimated by applying the rebound effect 
to the reduction in fuel cost per mile resulting from the increase in its fuel economy between the baseline forecast 
and a higher CAFE standard. 
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Section 3 Fuel Consumption and Savings 
 
Fuel consumption by vehicles of each model and vintage during a future year depends on the 
total mileage that the surviving vehicles are driven during that year, as well as on the fuel 
efficiency they obtain in actual driving.  As indicated previously, the fuel economy levels that 
new vehicles achieve in real-world driving falls significantly short of the rated fuel economy 
levels that are used to assess manufacturers’ compliance with CAFE standards. 
 
The number of gallons of each type of fuel (or gasoline gallon equivalents of fuel energy, in the 
case of electricity) consumed by vehicles of model k and model year MY during year t, denoted 
gk,MY,t,fuel, is calculated from: 
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where sk,MY,CAFE,fuel is the share of miles that model k produced in model year MY operates on 
each type of fuel, mpgk,MY,CAFE,fuel is its fuel economy in miles per gallon (or miles per gasoline 
gallon equivalent, in the case of electricity) on each type of fuel, and gapfuel (a model input) 
indicates the proportional difference between the fuel economy of vehicles using that fuel as 
measured for CAFE purposes and their actual on-road fuel economy.23 
 
The CAFE models estimates use of four different types of fuel energy: gasoline, diesel, E85 (a 
blend of 85% ethanol and 15% gasoline), and electricity.  Dedicated gasoline, diesel, and electric 
vehicle models will each have mileage shares of 100% for the fuel they are designed to utilize, 
and 0% mileage shares for all other fuels.  FFVs are currently assumed to operate on E85 for 
15% of their annual mileage each year over their lifetimes, while PHEVs are assumed to operate 
on electricity for 50% of their annual mileage and on gasoline for the remaining 50%.  These 
values are inputs to the CAFE model, and can be adjusted by the user. 
 
As equation (12) indicates, many of the factors determining a vehicle model’s consumption of 
different fuels can vary depending on the CAFE standard that is in effect during the model year it 
is produced.  Specifically, the shares of miles for which it operates on different fuels, its fuel 
economy when using each different fuel, and as discussed previously, its average annual mileage 
can each differ between the baseline market forecast and any alternative CAFE level that the 
model is used to analyze.  These differences occur because manufacturers will increase the fuel 
economy of some models in response to increases in CAFE standards from their baseline level, 
and may convert some gasoline-powered models to diesel, FFVs, or PHEVs. 
 
Total use of each type of fuel during year t by all vehicles in use that were originally produced 
during a single model year is the sum of fuel consumed by the surviving vehicles of each model 
operating on that type of fuel.  Denoting this quantity GMY,t,CAFE,fuel, it is computed as: 
 

                                                 
23 We assume that a vehicle’s fuel economy is constant over its lifetime, and that the test versus on-road fuel 
economy gap for each fuel is identical for all vehicle types and ages using that fuel. 
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fuelCAFEtMYkfuelCAFEtMY gG ,,,,,,,  (13) 

 
Similarly, total consumption of each type of fuel by all vehicle models produced during a model 
year over their expected lifetimes, denoted GMY,CAFE,fuel, is given by: 
 
 ∑∑=

t k
fuelCAFEtMYkfuelCAFEMY gG ,,,,,,  (14) 

 
As with annual consumption of different types of fuels by individual vehicle models, total annual 
consumption of each fuel by all vehicle models will differ depending on the CAFE standard that 
prevailed during the model year when they were originally produced.  The change in fuel use 
that results from imposing a different CAFE standard is always measured relative to expected 
fuel use with some baseline or comparison standard in effect. 
 
The usual assumption employed in the CAFE model is that the baseline fuel economy levels for 
vehicles produced during a future model year would be those that manufacturers would provide 
if the most recently adopted standard were extended to apply to future model years.  Thus for 
example, the baseline fuel economy levels projected for vehicles produced during model years 
2017-25 are estimated under the assumption that the recently-adopted CAFE standards for model 
year 2016 cars and light trucks would be extended to apply to model years 2017-25.  Estimated 
fuel consumption with the 2016 CAFE standard assumed to remain in effect for model years 
after 2016 provides the baseline for measuring reductions in fuel use expected to result from 
adopting higher CAFE standards for model years 2017-25. 
 
The change in total consumption of each fuel type during year t from imposing a higher CAFE 
standard for model year MY than that assumed to be in effect under the baseline forecast is given 
by: 
 
 fuelBASEtMYfuelCAFEtMYfuelCAFEtMY GGG ,,,,,,,,, −=∆  (15) 

 
Similarly, the savings in total consumption of each type of fuel by all vehicle models produced 
during a model year over their expected lifetimes is computed as: 
 
 ∑∑∑ −==∆

t
fuelBASEtMY

t
fuelCAFEtMY

t
fuelCAFEtMYfuelCAFEMY GGGG ,,,,,,,,,,,  (16) 

 
In addition, the model calculates corresponding energy consumption (in British thermal units) 
total energy consumption attributable to each fuel (and to electricity), reporting these quantities 
on a total and incremental basis.  
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Section 4 Greenhouse Gas Emissions 
 
Fuel savings from imposing stricter CAFE standards will result in lower emissions of carbon 
dioxide (CO2), the primary greenhouse gas emitted during the refining, distribution, and 
combustion of transportation fuels.24  Lower fuel consumption reduces carbon dioxide emissions 
directly, because the largest source of these emissions from transportation activity is fuel use by 
internal combustion engines.  The CAFE model calculates CO2 emissions from vehicle operation 
by multiplying the number of gallons of fuel consumed by the carbon content per gallon of fuel, 
and then applying the ratio of carbon dioxide emissions generated per unit of carbon consumed 
during the combustion process.25 
 
Emissions of carbon dioxide resulting from fuel consumption by all vehicle models produced in 
model year MY during year t, denoted CO2veh

MY,t,CAFE, are calculated from their consumption of 
each fuel type as: 
 
 ( )∑ 






=

fuel
fuelfuelfuelCAFEtMYCAFEtMY

veh CdGCO
12
442 ,,,,,  (17) 

 
where dfuel is the mass density of a fuel (measured in grams per gallon), Cfuel is the fraction of 
each fuel’s mass that represents carbon, and (44/12) is the ratio of the molecular weight of 
carbon dioxide to that of elemental carbon.  This ratio measures the mass of carbon dioxide that 
is produced by complete combustion of mass of carbon contained in each gallon of fuel.  
Vehicles operating on electricity are assumed to generate no CO2 emissions during vehicle use. 
   
As with the model’s calculations of fuel consumption, estimates of annual CO2 emissions from 
fuel use are summed over the calendar years that cars and light trucks produced during each 
model year are projected to remain in use to obtain estimates of lifetime emissions. Specifically, 
lifetime CO2 emissions from fuel consumption by cars or light trucks produced during model 
year MY are given by: 
 
 ∑=

t
CAFEtMYCAFEMY

veh COCO ,,, 22  (18) 

 
where t ranges from MY to MY plus the maximum age of a car or light truck. 
 
By reducing the volume of fuel consumed, raising CAFE standards will also affect carbon 
dioxide emissions from refining and distributing liquid fuels, as well as from generating 
electricity.  Carbon dioxide emissions occur during the production of petroleum-based fuels as a 

                                                 
24 Carbon dioxide emissions account for more than 97% of total greenhouse gas emissions from the refining and use 
of transportation fuels; see U.S. Environmental Protection Agency, Draft Inventory of GHG Emissions and Sinks 
(1990-1999), Tables ES-1 and ES-4, http://www.epa.gov/globalwarming/publications/emissions/us2001/energy.pdf. 
25 The carbon content of gasoline used in the CAFE model is a weighted average of those for different types of 
gasoline in use.  Although the model does not explicitly account for incomplete conversion of carbon to carbon 
dioxide, input values specifying carbon content can be adjusted accordingly (i.e., reduced to 99-99.5% of actual 
carbon content). 
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result of energy use for petroleum extraction, transportation, storage, and refining, as well as 
during storage and distribution of refined fuel.  Producing the chemical feedstocks or agricultural 
products from which non-petroleum fuels such as ethanol are derived also entails energy use and 
generates CO2 emissions, as does refining, storing, and distributing those fuels.  Generating 
electricity for use by PHEVs and EVs using fossil energy sources such as coal or natural gas also 
produces CO2 emissions. 
 
The CAFE model calculates reductions in carbon dioxide emissions from each stage of liquid 
fuel production and distribution using estimates of emissions in each stage of these processes per 
unit of fuel energy supplied.  These estimates are converted to a per-gallon basis using the 
energy content per gallon of gasoline, diesel, and ethanol, and multiplied by the volume of each 
fuel consumed to estimate total carbon dioxide emissions from fuel production and distribution.  
Emissions from generating electricity are estimated from electricity consumption by PHEVs and 
EVs together with average CO2 emissions per unit of energy generated, assuming the U.S. 
average mix of fuel sources and transmission distances. 
 
Total CO2 emissions from producing and distributing fuel consumed by vehicles of model year 
MY during year t of their lifetimes, denoted CO2ref

MY,t,CAFE, is given by: 
 
 ( )∑ ++=
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ref COCOCOGCO 2222 ,,,,,  (19) 

 
where CO2f

fuel represents carbon dioxide emissions from feedstock production or extraction per 
gallon of each type of fuel, CO2r

fuel represents emissions per gallon of each type of fuel refined, 
and CO2d

fuel represents carbon dioxide emissions per gallon from transportation, storage, and 
distribution of liquid fuels.  For electricity, the sum of these three emission rates is replaced by a 
single rate, CO2 emissions per gasoline gallon equivalent of electrical energy generated.  This 
rate depends on the mix of fuels that is assumed to be used for generating electricity, and can be 
adjusted by the model user. 
 
Annual CO2 emissions generated by fuel production and distribution are then summed over the 
lifetimes of automobiles and light trucks produced during each model year: 
 
 ∑=

t
CAFETMYCAFEMY

ref COCO ,,, 22  (20) 

 
where t again ranges from MY to (MY+30) for cars or (MY+37) for light trucks.   
 
Finally, CO2 emissions from fuel consumption are combined with emissions generated during 
the fuel supply process to yield total CO2 emissions from fuel production and consumption by 
vehicles produced during a model year over their expected lifetimes.  Total lifetime emissions 
attributable to cars or light trucks produced during model year MY are: 
 
 CAFEMY
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CAFEMY
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CAFEMY

tot COCOCO ,,, 222 +=  (21) 
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The presence of the CAFE subscript on total emissions indicates that these depend on the 
specific CAFE standard in effect, because that standard affects the fuel economy of individual 
vehicle models and their lifetime total fuel consumption.  The change in CO2 emissions expected 
to result from imposing a new CAFE standard for that model year is calculated as the difference 
in total lifetime emissions of cars or light trucks produced in that model year with the new 
standard in effect, and their total emissions with the baseline CAFE standard in effect: 
 
 BASEMY

tot
CAFEMY

tot
CAFEMY

tot COCOCO ,,, 222 −=∆  (22) 
 
Because imposing a higher CAFE standard reduces fuel consumption over the lifetimes of 
vehicles produced during the model years it affects, and CO2 emissions are a direct product of 
the volume of fuel produced and consumed, imposing a higher CAFE standard also reduces their 
lifetime CO2 emissions. 
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Section 5 Air Pollutant Emissions 
 
Stricter CAFE standards can result in higher or lower emissions of criteria air pollutants, by-
products of fuel combustion that are also emitted during the production and distribution of fuel.  
Criteria pollutants that are emitted in significant quantities by light-duty motor vehicles include 
carbon monoxide, various hydrocarbon compounds, nitrogen oxides, sulfur dioxide, and fine 
particulate matter. 
 
The increased use of vehicle models with improved fuel economy that occurs through the fuel 
economy rebound effect causes increased emissions of most criteria pollutants, since federal 
standards regulate permissible emissions of these pollutants on a per-mile basis.26  In contrast, 
reductions in the volume of fuel consumed that result from requiring higher fuel economy cause 
emissions of criteria pollutants during fuel production and distribution to decline.  The net 
change in total emissions of each criteria pollutant that results from imposing a higher CAFE 
standard depends on the relative magnitudes of changes in emissions from vehicle use and from 
fuel refining and distribution. 
 
The CAFE model calculates emissions of most criteria pollutants resulting from vehicle 
operation by multiplying the number of miles driven by vehicles of a model year during each 
year they remain in service by per-mile emission rates for each pollutant, which are derived from 
EPA’s Motor Vehicle Emissions Simulator (MOVES).  These emission rates differ among 
automobiles and light trucks operating on different fuel types; PHEVs operating on electricity 
and EVs are assumed to generate no emissions of criteria air pollutants during vehicle use. 
 
Total emissions of a criteria pollutant from the use of cars or light trucks produced during model 
year MY during year t of their lifetimes, denoted Eveh

MY,t, are thus: 
 
 ∑∑ −=

fuel k
fuelMYtkfuelCAFEMYkCAFEtMYkCAFEtMY

veh esME ,,,,,,,,,,  (23) 

 
where, as in equation (12) above, Mk,MY,t,CAFE is total miles driven during year t by vehicles of 
model k originally produced during model year MY, and sk,MY,CAFE,fuel is the share of those miles 
that model k operates on each type of fuel.27 
 
In equation (23), ek,t-MY,fuel is the per-mile rate at which vehicles of model k emit a criteria air 
pollutant during year t when using each type of fuel.  These emission rates can depend on a 
vehicle model’s age and accumulated mileage, and during year t, vehicles produced during 
model year MY will have reached age (t-MY).28  Emission rates from vehicle use also depend on 

                                                 
26 The exception is sulfur dioxide, which is estimated from the sulfur content of each type of fuel using a procedure 
exactly analogous to the estimation of CO2 emissions from the carbon content of each fuel type. 
27 As in equation (12), the CAFE subscript on s indicates that the type of fuel on which a vehicle model produced 
during a specific model year operates can depend on the CAFE standard in effect for that model year.  
28 The emission rates derived from MOVES are projected to be identical for all model years after 2011, and to 
remain constant over those vehicles’ lifetimes. 
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fuel type, although vehicles using electricity are assumed to produce no emissions during their 
operation. 
 
As with fuel use and CO2 emissions, annual emissions of each criteria air pollutant are summed 
over the future years that vehicle models originally produced during each model year are 
expected to be in service, in order to produce estimates of their total lifetime emissions: 
 
 ∑=

t
CAFEtMY

veh
CAFEMY

veh EE ,,,  (24) 

 
where as usual, t begins at a value of MY and increases to MY plus the maximum lifetimes 
assumed for automobiles and light trucks. 
 
Emissions of criteria air pollutants that occur during fuel refining and distribution are estimated 
by applying emission factors for each pollutant per gallon of fuel refined to the total volumes of 
gasoline, diesel, and ethanol projected to be consumed during future years.  Emissions from 
generating electricity used by PHEVs and EVs are calculated using emission factors for each 
criteria air pollutant per unit of electricity generated.  In contrast to CO2 emissions, which are 
included regardless of where petroleum extraction and fuel refining occur throughout the world, 
only domestic emissions of criteria air pollutants are included. 
 
Thus emissions of each criteria air pollutant from producing and distributing the fuel consumed 
by cars or light trucks of model year MY during year t of their lifetimes, denoted Eref

MY,t,CAFE, are: 
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where ef

fuel, er
fuel, and ed

fuel are emissions of a criteria air pollutant per gallon of fuel supplied that 
occur during feedstock production or extraction, fuel refining, and transportation, storage, and 
distribution of refined fuel.  Because different fuels utilize different feedstocks, refining 
processes, and distribution networks, each of these factors can differ by type of fuel.  The 
parameter rfuel indicates the fraction of each type of fuel that is refined domestically (using either 
domestically-produced or imported feedstocks), while ffuel indicates fraction of domestic refining 
that utilizes domestically-produced feedstocks. 
 
For vehicles operating on electricity, the bracketed expression in equation (25) is replaced by a 
single factor measuring criteria pollutant emissions per gasoline gallon equivalent of electricity 
generated.  As with CO2 emissions, the values of these emission factors for each criteria air 
pollutant depend on the fuel mix assumed to be used for generating electricity, and can be 
adjusted accordingly by the model user.  All electricity consumed by PHEVs and EVs is 
assumed to be generated domestically. 
 
Emissions of each criteria pollutant attributable to producing and distributing the fuel consumed 
by cars or light trucks initially produced during model year MY over their lifetimes are: 
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Finally, total emissions of each criteria pollutant over the lifetimes of cars or light trucks of 
model year MY are the sum of emissions that occur as a result of their lifetime use, and emissions 
from producing and distributing the fuel they consume over their lifetimes: 
 
 CAFEMY

ref
CAFEMY

veh
CAFEMY

tot EEE ,,, +=  (27) 
 
Again, the presence of the CAFE subscript in equation (27) indicates that vehicles’ lifetime 
emissions depend on the CAFE standard in effect during the model year they are produced, 
through its effect on their fuel economy, usage, and fuel consumption. 
 
As a consequence, total lifetime emissions of each criteria air pollutant by cars and light trucks 
produced during future model years will differ between the baseline CAFE standard and any 
alternative standard that is specified.  The model calculates the effect of imposing a higher CAFE 
standard on emissions of criteria air pollutants as the difference between lifetime emissions by 
cars and light trucks produced during each model year it would affect, and those vehicles’ 
emissions under the baseline CAFE standard: 
 
 BASEMY

tot
CAFEMY
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tot EEE ,,, −=∆  (28) 
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Section 6 Private versus Social Costs and Benefits 
 
Improving the fuel efficiency of new vehicles produces a wide range of benefits and costs, many 
of which affect buyers of those vehicles directly.  Depending upon how manufacturers attempt to 
recoup the costs they incur for improving the fuel efficiency of selected models, buyers are likely 
to face higher prices for some – and perhaps even most – new vehicle models.  Purchasers of 
models whose fuel economy is improved benefit from the resulting savings in the cost of fuel 
their vehicles consume, from any increase in the range they can travel before needing to refuel, 
and from the added driving they do as a result of the rebound effect.  Depending on the 
technology manufacturers use to improve fuel economy and its consequences for vehicle power 
and weight, these benefits may be partly offset by a slight decline in the performance of some 
new models. 
 
At the same time, the reduction in fuel production and use resulting from improved fuel economy 
produces certain additional benefits and costs to society as a whole.  Potential social benefits 
from reduced fuel use include any value that society or the U.S. economy attaches to saving fuel 
over and above its private value to new vehicle buyers, lower emissions of air pollutants and 
greenhouse gases generated from fuel production, distribution, and consumption, and reduced 
economic costs associated with U.S. imports of crude petroleum and refined fuel.  By causing 
some additional driving through the rebound effect, improving fuel economy can also increase a 
variety of social costs, including the economic value of health effects and property damages 
caused by increased air pollution, the value of time delays to motorists from added traffic 
congestion, added costs of injuries and property damage resulting from more frequent traffic 
accidents, and economic costs from higher levels of traffic noise. 
 
The following sections discuss how each of these benefits and costs can result from improving 
the fuel economy of new vehicles, the factors affecting their likely magnitudes, and how their 
values are commonly measured or estimated.  Section A.3 of Appendix A provides examples of 
specific unit economic values and other parameters used to estimate the aggregate value of these 
various benefits and costs, and explains how these sample values were derived. 
 
S6.1 Benefits and Costs to New Vehicle Buyers 
 
S6.1.1 Increases in New Vehicle Prices 
 
Depending upon how manufacturers attempt to recover the costs they incur in complying with 
CAFE regulations, purchase prices for some new models are likely to increase.  Because we 
assume that manufacturers fully recover all costs they incur for installing fuel economy 
technologies to comply with CAFE in the form of higher prices for some models, the total 
increase in vehicle sales prices has already been accounted for in estimating technology costs to 
manufacturers.  Nevertheless, the total value of these price increases represent a cost of CAFE 
regulation from the viewpoint of buyers of vehicle models whose prices rise. 
 
In addition to increases in the prices paid by buyers who elect to purchase these models even at 
the higher price points, higher prices result in losses in welfare or consumer surplus to buyers 
who decide to purchase different models instead.  These losses are extremely complex to 
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estimate if prices change for a large number of models, and in any case are likely to be small 
even in total.  Thus we do not attempt to estimate their value. 
 
S6.1.2 The Value of Fuel Savings 
 
The CAFE modeling system estimates the economic value of fuel savings to buyers of new 
vehicle models whose fuel economy is improved by applying the forecast (an input to the model) 
of future retail fuel prices to each year’s estimated fuel savings for those models.  The annual 
fuel savings for a model during each year of its lifetime in the vehicle fleet is multiplied by the 
number of those initially sold that are expected to remain in use during that year to determine the 
total annual value of fuel savings to buyers of that model. 
 
The forecast retail price of fuel per gallon – including federal and average state fuel and other 
taxes – during that year is used to estimate the value of these fuel savings as viewed from the 
perspective of their buyers.  Based on evidence from previous studies of consumer purchases of 
automobiles and durable appliances, we assume that new vehicle buyers value these savings over 
the approximate number of years (an input to the model) they expect to own a new vehicle, and 
that they discount these expected savings to the year in which they purchase new vehicles. 
 
S6.1.3 Benefits from Additional Driving 
 
The rebound effect also results in additional benefits to new vehicle buyers in the form of 
consumer surplus from the increased driving it produces.  These benefits arise from the value to 
drivers and passengers of the social and economic opportunities made available to them by 
additional traveling.  As evidenced by the fact that they elect to make more frequent or longer 
trips when improved fuel economy reduces the cost of driving, the benefits from this additional 
travel exceed the costs drivers and their passengers incur in making more frequent or longer 
trips.  The amount by which these benefits from additional travel exceed its cost to them – which 
has been reduced by improved fuel economy – represents the increase in consumer surplus 
associated with additional rebound effect driving. 
 
The system estimates the value of these benefits using the conventional approximation of one 
half of the product of the decline in fuel cost per mile driven and the resulting increase in the 
annual number of miles driven.  This value is calculated for each year that a model whose fuel 
economy is improved remains in the fleet, multiplied by the number of vehicles of that model 
expected to remain in use during each year of its lifetime, and discounted to its present value as 
of the year it was purchased.  Given typical input values (e.g., for fuel prices), this benefit is 
relatively small by comparison to most other economic impacts of raising CAFE standards. 
 
S6.1.4 The Value of Extended Refueling Range 
 
Manufacturers’ efforts to improve the fuel economy of selected new vehicle models will also 
increase their driving range per tank of fuel.  By reducing the frequency with which drivers 
typically refuel their vehicles, and by extending the upper limit of the range they can travel 
before requiring refueling, improving fuel economy thus provides some additional benefits to 
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their owners.29  No direct estimates of the value of extended vehicle range are readily available, 
so the CAFE model calculates the reduction in the annual number of required refueling cycles 
that results from improved fuel economy.  The change in required refueling frequency for 
vehicle models with improved fuel economy reflects the increased driving associated with the 
rebound effect, as well as the increased driving range stemming from higher fuel economy. 
 
S6.1.5 Changes in Performance and Utility 
 
The system currently assumes that the costs and effects of fuel-saving technologies reflect the 
application of these technologies in a manner that holds vehicle performance and utility constant.  
Therefore, the system currently does not estimate changes in vehicle performance or utility. 
 
S6.1.6 Social Benefits and Costs from Increased Fuel Economy 
 
S6.1.6.1 The “Social Value” of Fuel Savings 
 
The economic value to society of the annual fuel savings resulting from stricter CAFE standards 
is also assessed by applying estimated future fuel prices to each year’s estimated fuel savings.  
Unlike the value of fuel savings to vehicle buyers themselves, however, the pre-tax price per 
gallon is used in assessing the value of fuel savings to the economy as a whole.  This is because 
reductions in payments of state and federal taxes by purchasers of fuel will be exactly offset by 
reduced spending on the construction and maintenance of streets and highways that fuel taxes are 
mainly used to finance, and thus do not reflect a net savings in resources to the economy. 
 
When estimating the nationwide aggregate economic benefits and costs from CAFE regulation, 
we include this “social” value of fuel savings rather than their private value to vehicle buyers.  In 
computing the social value of fuel savings, we include their annual value over the entire 
expected lifetimes of vehicle models whose fuel economy is improved, reflecting the presumably 
longer-term horizon of society as a whole compared to that of vehicle buyers, who may be 
concerned with fuel savings only over the time they expect to own newly-purchased vehicles. 
 
S6.1.6.2 Economic Benefits from Reduced Petroleum Imports 
 
Importing petroleum into the United States is widely believed to impose significant costs on 
households and businesses that are not reflected in the market price for imported oil, and thus are 
not borne by consumers of refined petroleum products.  These costs include three components: 
(1) higher costs for oil imports resulting from the combined effect of U.S. import demand and 
OPEC market power on the world oil price; (2) the risk of reductions in U.S. economic output 
and disruption of the domestic economy caused by sudden reductions in the supply of imported 
oil; and (3) costs for maintaining a U.S. military presence to secure imported oil supplies from 
unstable regions, and for maintaining the Strategic Petroleum Reserve (SPR) to cushion against 
price increases.  By reducing domestic demand for gasoline, tighter CAFE standards can reduce 
petroleum imports, and thus reduce these social costs to the extent that their magnitude varies 

                                                 
29 If manufacturers instead respond to improved fuel economy by reducing the size of fuel tanks to maintain a 
constant driving range, the resulting savings in costs will presumably be reflected in lower sales prices. 
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with the volume of U.S. oil imports.  Any reduction in their magnitude represents an additional 
category of economic benefits from tighter fuel economy standards. 
 
In this analysis, the reduction in petroleum imports resulting from higher CAFE standards is 
estimated by assuming that the resulting savings in gasoline use during each future year is 
translated directly into a corresponding reduction in the annual volume of U.S. oil imports during 
that same year.  The value to the U.S. economy of reducing petroleum imports – in the form of 
lower crude oil prices and reduced risks of oil supply disruptions – is estimated by applying the 
sum of the previously reported estimates of these benefits to the estimated annual reduction in oil 
imports. 
 
S6.1.6.3 Valuing Changes in Environmental Impacts 
 
The CAFE modeling system estimates the economic value of the net change in emissions of 
criteria pollutants, including carbon monoxide, volatile organic compounds, nitrogen oxides, 
sulfur dioxide, and fine particulates, using estimates of the economic damage costs per ton of 
emissions of each of these pollutants.  As indicated previously, emissions of criteria pollutants 
can rise or fall when fuel economy increases, so the economic costs of these emissions can 
increase or decline in response to higher CAFE standards. 
 
The model estimates changes in damage costs caused by carbon dioxide emissions by 
multiplying the magnitude of the change in emissions by the estimated value of damages per unit 
of emissions. 
 
S6.1.7 Social Costs of Added Driving 
 
In addition to increasing emissions of criteria pollutants, any added driving associated with the 
fuel economy rebound effect may contribute to increased traffic congestion, motor vehicle 
accidents, and highway noise.  Additional vehicle use can contribute to traffic congestion and 
delays partly by increasing recurring congestion on heavily-traveled facilities during peak travel 
periods, depending on how the additional travel is distributed over the day and on where it 
occurs.  Added driving can also increase the frequency of incidents such as collisions and 
disabled vehicles that cause prolonged delays, although the extent to which it actually does do 
will again depend partly on when and where the added travel occurs.  Finally, added vehicle use 
from the rebound effect may also increase traffic noise, which causes inconvenience, irritation, 
and potentially even discomfort to occupants of other vehicles, pedestrians and other bystanders, 
and residents or occupants of surrounding property. 
 
The CAFE modeling system uses estimates of the increases in external costs – that is, the 
marginal social costs – from added congestion, property damages and injuries in traffic 
accidents, and noise levels caused by additional vehicle usage.  It does so by applying estimates 
of the increases in these costs that result from each added mile of travel by different types of 
vehicles (passenger and nonpassenger automobiles) to the increase in the total number of miles 
driven projected to result from the rebound effect. 
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Appendix A Model Inputs 
 
The CAFE Compliance and Effects Modeling System utilizes a set of data files used as input to 
the analysis.  All input files are specified in Microsoft® Excel format and are outline in Table 5 
below.  The user can define and edit all inputs to the system.  For example, the system does not 
require market data constructed using confidential business information. 
 

Table 5. Input Files 
Input File Contents 

Market Data 
(Manufacturers Worksheet) 

Contains an indexed list of manufacturers available during the study period, along 
with manufacturer’s willingness to pay fines and other manufacturer-specific 
modeling settings. 

Market Data 
(Vehicles Worksheet) 

Contains an indexed list of vehicle models available during the study period, along 
with sales volumes, fuel economy levels, prices, other attributes, domestic labor 
utilization, references to specific engines and transmissions used, and optional 
settings related to technology applicability, designation as a passenger or 
nonpassenger automobile, and coverage of vehicles with GVWR above 8,500 
pounds. 

Market Data 
(Engines Worksheet) 

Contains an indexed list of engines available during the study period, along with 
various engine attributes and optional settings related to technology applicability. 

Market Data 
(Transmissions Worksheet) 

Contains an indexed list of transmissions available during the study period, along 
with various transmission attributes and optional settings related to technology 
applicability. 

Technologies Specifies estimates of the availability, cost, and effectiveness of various 
technologies, specific to various vehicle categories. 

Parameters 
Provides inputs used to calculate travel demand, fuel consumption, carbon dioxide 
and criteria pollutant emissions, and economic externalities related to highway travel 
and petroleum consumption. 

Tailpipe Emissions Provides inputs used to project the tailpipe emissions of various pollutants. 

Scenarios Specifies coverage, structure, and stringency of CAFE standards for scenarios to be 
simulated. 

EIS Parameters Provides additional inputs necessary for calculating VMT and fuel use for the EIS.  
This input file is required for EIS modeling only. 

EIS Tailpipe Emissions Provides inputs necessary for calculating tailpipe emissions for the EIS .  This input 
file is required for EIS modeling only. 
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A.1 Market Data File 
 
The market data file contains four worksheets:  Manufacturers, Vehicles, Engines and 
Transmissions.  Taken together, the manufacturers, vehicle models, engines, and transmissions 
worksheets provide “initial state” historical and/or forecast data for the light vehicle fleet.  The 
sections below describe each worksheet in greater detail. 
 
A.1.1 Manufacturers Worksheet 
 
The manufacturers input worksheet contains a list of all manufacturers that produce vehicle 
models offered for sale during the study period.  Each manufacturer has a unique code and is 
represented by a unique manufacturer name.  For each manufacturer, the manufacturer code, 
name, cost allocation strategy, discount rate, payback periods, and willingness to pay CAFE 
fines must all be specified.  Available credits, if applicable, should be expressed in Vehicle/MPG 
and is applied directly as a credit (positive or negative) to the CAFE level for the given 
manufacturer in the given model year.  If no available credits are to be specified, a value of zero 
(0.0) can be used or the cell can be left blank. 
 

Table 6. Manufacturers Worksheet 
Category Column Units Definition/Notes 

G
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Manufacturer Code integer Unique number assigned to each manufacturer. 
Manufacturer Name text Name of the manufacturer. 

Cost Allocation 
Strategy integer 

The cost allocation strategy the manufacturer will use for allocating costs. 
  0 = allocate technology costs on an as-incurred basis 
  1 = distribute technology costs and fines based on the share of aggregate sales revenue 
  2 = not used 
  3 = distribute technology costs and fines evenly 

Discount Rate number Represents the manufacturer specific discount rate, which factors into the effective cost 
calculation. 

Payback Period number The number of years required for an initial investment to be repaid in the form of future 
benefits or cost savings. 

Payback Period 
(After Compliance) number The payback period to use after the manufacturer reached compliance. 

Optimize text Y = consider the manufacturer during optimization 
N = do not consider the manufacturer during optimization 
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2011 text 
Represents the manufacturer's willingness to pay fines. 
  Y = pay fines instead of applying ineffective technologies 
  N = apply ineffective technologies instead of paying fines 

2012 text 
… 
2024 text 
2025 text 
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2011 vehicle-mpg 

Represents the manufacturer's available credits towards CAFE compliance for vehicles 
regulated as Domestic Automobiles. 

2012 vehicle-mpg 
… 
2024 vehicle-mpg 
2025 vehicle-mpg 

A
va

ila
bl

e 
Im

po
rte

d 
A

ut
o 

C
re

di
ts 

(m
pg

) 2011 vehicle-mpg 

Represents the manufacturer's available credits towards CAFE compliance for vehicles 
regulated as Imported Automobiles. 

2012 vehicle-mpg 
… 
2024 vehicle-mpg 
2025 vehicle-mpg 
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) 2011 vehicle-mpg 

Represents the manufacturer's available credits towards CAFE compliance for vehicles 
regulated as Light Trucks. 

2012 vehicle-mpg 
… 
2024 vehicle-mpg 
2025 vehicle-mpg 

Credits Apply to Baseline text Y = apply manufacturer's credits to the baseline scenario 
N = do not apply manufacturer's credits to the baseline scenario 
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A.1.2 Vehicles Worksheet 
 
The vehicles worksheet contains information regarding each vehicle model offered for sale 
during the study period.  Each vehicle model is represented as a single row of input data. Data in 
Table 7, Table 8, and Table 9 list the different columns of information specified in the vehicle 
models file.  To make the information readable, the Vehicle Models tables are presented 
vertically and divided into sections. 
 
In the “General” category, the vehicle code, manufacturer, model, nameplate, engine code, 
transmission code, and origin must be specified for each vehicle model.  The engine and 
transmission codes must refer to a valid engine and transmission, respectively, for the relevant 
manufacturer in the engines and transmissions worksheets.  Vehicle’s fuel economy and assumed 
share of operating on a specific fuel are specified in the “Fuel Economy” section.  Known or 
projected sales are specified in the “Sales” section for each model year in which the model is 
offered.  The known or projected MSRP should be specified in its corresponding section for each 
model year in which the vehicle model is offered for sale.  In the “Regulatory Classification” 
section, the regulatory, technology, and safety class assignments for each vehicle must be 
specified. 
 

Table 7. Vehicles Worksheet (1) 
Category Column Units Definition/Notes 
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Vehicle Code integer Unique number assigned to each vehicle. 
Manufacturer text The manufacturer of the vehicle. 
Model text Name of the vehicle model. 
Nameplate text The nameplate of the vehicle. 
Engine Code integer The engine code of the engine that the vehicle uses. 
Transmission Code integer The transmission code of the transmission that the vehicle uses. 
Origin text D = domestic; I = imported 

Fu
el

 E
co
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Fuel Economy (Gasoline) number 

The CAFE fuel economy rating of the vehicle for each fuel type. 
Fuel Economy (Diesel) number 
Fuel Economy (Ethanol-85) number 
Fuel Economy (Electricity) number 
Fuel Economy (Hydrogen) number 
Fuel Share (Gasoline) number 

The percent share that the vehicle runs on each fuel type. 
Fuel Share (Diesel) number 
Fuel Share (Ethanol-85) number 
Fuel Share (Electricity) number 
Fuel Share (Hydrogen) number 

Sa
le

s 

MY2011 units 

Vehicle's projected production for sale in the US. 
MY2012 units 
… 
MY2024 units 
MY2025 units 

M
SR

P 

MY2011 dollars 

Vehicle's projected average MSRP (sales-weighted, including options). 
MY2012 dollars 
… 
MY2024 dollars 
MY2025 dollars 

R
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n Regulatory Class text 
The regulatory assignment of the vehicle. 
  PC = the vehicle should be regulated as a passenger automobile 
  LT = the vehicle should be regulated as a light truck 

Technology Class text The technology class of the vehicle. 

Safety Class text 

The safety class assignment of the vehicle. 
  PC = the vehicle belongs to a passenger automobile safety class 
  LT = the vehicle belongs to a light truck/SUV safety class 
  CM = the vehicle belongs to a light CUV/minivan safety class 
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Within the “Vehicle Information” category, it is important that each vehicle model's class, style, 
structure, drive, footprint, curb weight, GVWR, and fuel capacity be specified.  For any hybrid 
vehicle models, it is necessary to specify the type of hybridization as well.  If a vehicle also 
operates on electricity, the electric power and range need to be available as well.  In the 
“Planning & Assembly” section, the redesign and refresh years must be comma separated and 
contain all known previous and projected future redesign and refresh years. 
 

Table 8. Vehicles Worksheet (2) 
Category Column Units Definition/Notes 

V
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Class text Vehicle class. 
Style text Vehicle style. 
Structure text Vehicle structure (ladder or unibody). 

Drive text Vehicle drive (A=all-wheel drive, F=front-wheel drive, R=rear-wheel 
drive, 4=four-wheel drive). 

Footprint sq. feet The vehicle footprint; wheelbase times average track width. 

Curb Weight pounds 
Total weight of the vehicle, including batteries, lubricants, and other 
expendable supplies, but excluding the driver, passengers, and other 
payloads (SAE J1100). 

GVWR pounds Gross Vehicle Weight Rating; weight of loaded vehicle, including 
passengers and cargo. 

Seating (Max) integer The number of usable seat belts before folding and removal of seats 
(where accomplished without specific tools). 

Fuel Capacity gallons The capacity of the vehicle's fuel tank in gallons of diesel fuel or gasoline; 
MJ (LHV) of other fuels (or chemical battery energy). 

H
yb

rid
iz

at
io

n Type of 
Hybrid/Electric 
Vehicle 

text Hybridization type of the vehicle, if any. 

Electric Power number The power rating (equivalent to engine horsepower) for an electric vehicle. 
Electric Range number The range of an electric vehicle, in miles, when operating on a battery. 

Pl
an

ni
ng

 
an
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y Refresh Years model year Comma separated list of previous and future refresh years of the vehicle. 

Redesign Year model year Comma separated list of previous and future redesign years of the vehicle. 
Employment Hours 
per Vehicle hours Employment hours associated with the production of each vehicle model. 

 
The applicability of technologies considered on a vehicle model basis (as opposed, for example, 
on an engine basis) can be controlled for each vehicle model by using the “Technology 
Applicability” category.  This section must be completed to prevent double counting of 
technologies. 
 

Table 9. Vehicles Worksheet (3) 
Category Column Units Definition/Notes 
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EPS text 

<blank> = the technology is not used on the vehicle 
USED = the technology is used on the vehicle 
SKIP = the technology is not applicable to the vehicle 

IACC1 text 
IACC2 text 
MHEV text 
ISG text 
SHEV1 text 
SHEV1_2 text 
SHEV2 text 
PHEV1 text 
PHEV2 text 
EV1/EV2/EV3/EV4 text 
FCV text 
MR1/MR2/MR3/MR4/MR5 text 
ROLL1/ROLL2/ROLL3 text 
LDB text 
SAX text 
AERO1 text 
AERO2 text 
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A.1.3 Engines Worksheet 
 
Similar to the vehicles input sheet, the engines worksheet contains a list of all engines used in 
vehicle models offered for sale during the study period.  For each manufacturer, the engine code 
is a unique number assigned to each such engine.  This code is referenced in the engine code 
field on the vehicles worksheet.  For each engine, the engine code, manufacturer, configuration, 
fuel, cycle, aspiration, valve actuation/timing, valve lift, number of cylinders, number of valves 
per cylinder, and horsepower must all be specified.  As in the vehicles worksheet, the technology 
applicability for any engine technology must be specified for any specific engine. 
 

Table 10. Engines Worksheet 
Category Column Units Definition/Notes 
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Engine Code integer Unique number assigned to each engine. 
Manufacturer text The manufacturer of the engine. 
Configuration text Configuration of the engine. 

Fuel text 
One or more fuel types with which the engine is compatible: 
G = gasoline only; D = diesel only; E85 = ethanol-85 only; G+E85 = 
flex fuel engine, running on gasoline and ethanol-85 

Engine Oil Viscosity text 
Ratio between the applied shear stress and the rate of shear, which 
measures the resistance of flow of the engine oil (as per SAE Glossary 
of Automotive Terms). 

Cycle text Combustion cycle of the engine. 
Fuel Delivery System text The mechanism that delivers fuel to the engine. 

Aspiration text Breathing or induction process of the engine (as per SAE Automotive 
Dictionary). 

Valvetrain Design text 
Design of the total mechanism from camshaft to valve of an engine that 
actuates the lifting and closing of a valve (as per SAE Automotive 
Dictionary). 

Valve Actuation/Timing text Valve opening and closing points in the operating cycle (SAE J604). 

Valve Lift text The manner in which the valve is raised during combustion (as per 
SAE Automotive Dictionary). 

Cylinders integer Number of engine cylinders. 
Valves/Cylinder integer Number of valves per cylinder. 
Deactivation text Weighted (FTP+highway) aggregate degree of deactivation. 
Displacement liters Total volume displaced by a piston in a single stroke. 
Max. Horsepower number Maximum horsepower of the engine (horsepower). 
Max. Torque number Maximum torque of the engine (pound-foot). 
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LUB1 text 

<blank> = the technology is not used on the engine 
USED = the technology is used on the engine 
SKIP = the technology is not applicable to the engine 

EFR1 text 
LUB2_EFR2 text 
CCPS text 
DVVLS text 
DEACS text 
ICP text 
DCP text 
DVVLD text 
CVVL text 
DEACD text 
SGDI text 
DEACO text 
VVA text 
SGDIO text 
TRBDS1 (_SD/_MD/_LD) text 
TRBDS2 (_SD/_MD/_LD) text 
CEGR1 (_SD/_MD/_LD) text 
CEGR2 (_SD/_MD/_LD) text 
ADSL (_SD/_MD/_LD) text 
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A.1.4 Transmissions Worksheet 
 
Similar to the vehicles and engines input sheets, the transmissions worksheet contains a list of all 
transmissions used in vehicle models offered for sale during the study period.  For each 
manufacturer, the transmission code is a unique number assigned to each such transmission.  
This code is referenced in the transmission code field on the vehicles worksheet.  For each 
transmission, the transmission code, manufacturer, type, and number of forward gears must all 
be specified.  As in the vehicles worksheet, the technology applicability for any transmission 
technology must be specified for any specific transmission. 
 

Table 11. Transmissions Worksheet 
Category Column Units Definition/Notes 

G
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 Transmission Code integer Unique number assigned to each transmission. 
Manufacturer text The manufacturer of the transmission. 
Type text Type of the transmission. 
Number of Forward Gears integer Number of forward gears the transmission has. 
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6MAN text 

<blank> = the technology is not used on the transmission 
USED = the technology is used on the transmission 
SKIP = the technology is not applicable to the transmission 

HETRANSM text 
IATC text 
NAUTO text 
DCT text 
8SPD text 
HETRANS text 
SHFTOPT text 
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A.2 Technologies File 
 
The technologies input file contains assumptions regarding the fuel consumption benefit, cost, 
applicability, and availability of different vehicle, engine, and transmission technologies during 
the study period.  Input assumptions are specific to each of the following vehicle technology 
classes:  subcompact cars, subcompact performance cars, compact cars, compact performance 
cars, midsize cars, midsize performance cars, large cars, large performance cars, minivans, small 
pickups and SUVs, midsize pickups and SUVs, and large pickups and SUVs.  Input assumptions 
that are common among all technology classes are listed on a separate technologies definitions 
tab.  Table 12 shows the contents of a technologies definitions tab for all classes while Table 13 
shows the contents of the technology assumptions tabs. 
 

Table 12. Technologies Definitions 
Category Column Units Definition/Notes 
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Index integer Unique number assigned to each technology. 
Technology text Name of the technology. 
Abbr. text Abbreviation of the technology. 

TechType text 

The group of a technology: 
  EngMod = the type of the technology is engine modification 
  TrnMod = the type of the technology is transmission modification 
  ELEC = the type of the technology is electric system improvement 
  MR = the type of the technology is mass reduction 
  ROLL = the type of the technology is rolling resistance tires 
  DLR = the type of the technology is dynamic load reduction 
  AERO = the type of the technology is aerodynamics modification 

Ph
as
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PV-1 percentage 

Percentage of the entire fleet to which the technology may be applied. 
PV-2 percentage 

… 
PV-16 percentage 
PV-17 percentage 
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ERC-1 dollars 

Penalty costs associated with replacing (or superseding) a technology early. 
ERC-2 dollars 

… 
ERC-9 dollars 
ERC-10 dollars 

 
The technologies are organized into technology groups specified by the TechType column.  Each 
technology group is populated with specific technologies following the sequence specified by the 
Index column.  The modeling system also follows the index sequence as it evaluates 
technologies for applicability.  The sequence of engine and transmission technologies may be 
split to follow slightly different paths, based on the original vehicle, engine, or transmission 
characteristics, or depending on which technologies have already been applied to a vehicle.  For 
example, if the original vehicle uses a manual transmission with fewer than six gears, the 
available technologies would be the 6-speed manual transmission and high efficiency gearbox 
(HETRANSM).  If the original vehicle, however, starts out with a 5-speed automatic 
transmission, the technologies applied would follow the following path: IATC, 6-speed 
automatic transmission (NAUTO), 6-speed DCT, 8-speed automatic transmission, high 
efficiency gearbox (HETRANS), and shift optimizer (SHFTOPT). 
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Table 13. Technologies Assumptions 
Category Column Units Definition/Notes 

G
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Index integer Unique number assigned to each technology. 
Technology text Name of the technology. 
Abbr. text Abbreviation of the technology. 

TechType text 

The group of a technology: 
  EngMod = the type of the technology is engine modification 
  TrnMod = the type of the technology is transmission modification 
  ELEC = the type of the technology is electric system improvement 
  MR = the type of the technology is mass reduction 
  ROLL = the type of the technology is rolling resistance tires 
  DLR = the type of the technology is dynamic load reduction 
  AERO = the type of the technology is aerodynamics modification 

A
va
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bi

lit
y Applicable boolean TRUE = the technology is available for applicability in a technology class 

FALSE = the technology is not available for applicability in a technology class 
Year 
Avail. model year First year the technology is available for applicability. 

Year 
Retired model year Last year the technology is available for applicability. 

M
isc
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 Electric  

Range number 
What the range, in miles, of an electric vehicle would be when operating on a 
battery, as a result of applying the technology; applies to PHEV and EV 
technologies only. 

Delta 
Weight (%) percentage Percentage by which the vehicle's weight changes as a result of applying the 

technology. 
Delta 
Weight (lbs) number Amount of pounds by which the vehicle's weight changes as a result of applying 

the technology. 
Loss of Value dollars The consumer welfare loss associated with application of the technology. 

FC
 Im
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FC percentage Overall fuel consumption improvement estimate of the technology. 

FCG percentage Fuel consumption improvement estimate to apply to the gasoline fuel economy 
value (applicable to plug-in HEVs only). 

FCG Share percentage Percentage of time the vehicle is expected to run on the gasoline fuel after 
applying the technology (applicable to plug-in HEVs only). 

Off-Cycle 
Credit PC number Amount of off-cycle credit that the vehicles regulated as passenger automobiles 

incur as a result of applying the technology 
Off-Cycle 
Credit LT number Amount of off-cycle credit that the vehicles regulated as nonpassenger 

automobiles inccur as a result of applying the technology 

C
os

t T
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le
 Cost 2009 dollars 

Table of learned out cost estimates for the technology, per model year. 
Cost 2010 dollars 

… 
Cost 2024 dollars 
Cost 2025 dollars 

M
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. T
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le

 Maint. 2009 dollars 

Table of learned out maintenance cost estimates for the technology, per model 
year. 

Maint. 2010 dollars 
… 

Maint. 2024 dollars 
Maint. 2025 dollars 

R
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 Repair 2009 dollars 

Table of learned out repair cost estimates for the technology, per model year. 
Repair 2010 dollars 

… 
Repair 2024 dollars 
Repair 2025 dollars 

 
A.2.1 Technology Synergies 
 
Technology synergies occur when the combined effect of two technologies is greater than (or 
less than) the fuel consumption reduction for the two technologies combined.  To support 
synergies, the technology input file has synergy sections for cost and fuel improvements. 
Contents of the synergy tables are shown in Table 14 below. 
 
The synergy table is most commonly used for synergistic interactions in vehicle technologies 
from differing technology groups (e.g., between engine technologies and transmission 
technologies).  Synergies within a technology group are already built into the cost and fuel 
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reduction values for the technologies.  Therefore, in-group synergies are not likely to occur, 
unless special circumstances arise, such as branching of technology paths. 
 

Table 14. Technology Synergies 
Category Column Units Definition/Notes 
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Type text 

The synergy type relation between two technologies.  The “accounting” 
type indicates that the synergy relation between two technologies is to 
provide accounting adjustments for the decision trees and is the only 
synergy type applied to technology costs.  The “physical” type indicates 
that the synergy relation between two technologies is to address physical 
energy losses. 

Technology A text Abbreviation of the first technology in a synergy pair. 
Technology B text Abbreviation of the second technology in a synergy pair. 
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Subcompact PC 

percentage Values to offset the technology cost or fuel consumption when either of 
technology A or B is being applied when the other is already installed. 

Subcompact Perf. PC 
Compact PC 
Compact Perf. PC 
Midsize PC 
Midsize Perf. PC 
Large PC 
Large Perf. PC 
Minivan LT 
Small LT 
Midsize LT 
Large LT 

 
When a technology is being applied (or is being tested for application), a lookup is performed in 
the “Technology A” and “Technology B” columns of the table.  If found, the vehicle is examined 
to determine if the paired technology (or technologies) have been applied (or are installed as part 
of the base vehicle definition).  If so, the offset value for the applicable vehicle class is obtained, 
summed, and applied to the cost or fuel consumption reduction of the technology being 
examined. 
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A.3 Parameters File 
 
The benefits model parameters file contains a variety of input data and assumptions used to 
estimate various impacts of the simulated response of the industry to CAFE standards.  The file 
contains a series of worksheets, the contents of which are summarized below. 
 
A.3.1 Vehicle Age Data 
 
The Vehicle Age Data worksheet contains age-specific (i.e., vintage-specific) estimates of the 
survival rate and annual accumulated mileage applicable to different vehicle categories. 
 

Table 15. Vehicle Age Data Worksheet 
Category Model Characteristic Units Definition/Notes 

V
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A

ge
 D

at
a Survival Rates proportion Proportion of original vehicle sales that remain in service by 

vehicle age (year 1 to 30 for cars, 1 to 37 for trucks). 

Miles Driven miles Average annual miles driven by surviving vehicles by vehicle 
age (year 1 to 30 for cars, 1 to 37 for trucks). 

 
Separate survival fractions and annual miles driven are used for cars, vans, SUVs, and pickups.  
The survival fractions measure the proportion of vehicles originally produced during a model 
year that remain in service at each age (up to 30 years for automobiles and 37 years for light 
trucks), by which time only a small fraction typically remain in service. 
 
A.3.2 Forecast Data 
 
The Forecast Data worksheet contains estimates of future fuel prices, which are used when 
calculating pre-tax fuel outlays and fuel tax revenues. 
 

Table 16. Forecast Data Worksheet 
Category Model Characteristic Units Definition/Notes 

Fo
re

ca
st 

D
at

a 

Retail Fuel Prices 
(low, average, high) $/gallon 2010 $ per gallon, varies by fuel type, forecast by calendar year 

staring with MY-1975. 

Fuel Taxes $/gallon 2010 $ per gallon, varies by fuel type, forecast by calendar year 
staring with MY-2000. 

 
A.3.3 Fuel Economy Data 
 
The fuel Economy Data worksheet contains historic and projected fuel economy levels for 
passenger cars and light trucks, for each fuel type (gasoline, diesel, ethanol-85, electricity, and 
hydrogen).  The associated fuel shares are also provided. 
 

Table 17. Fuel Economy Data Worksheet 
Category Model Characteristic Units Definition/Notes 

Fu
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Passenger Cars (FE) mpg Historic and projected fuel economy levels for passenger cars. 
Passenger Cars (Share) percentage Historic and projected fuel shares for passenger cars. 
Light Trucks (FE) mpg Historic and projected fuel economy levels for light trucks. 
Light Trucks (Share) percentage Historic and projected fuel shares for light trucks. 
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A.3.4 Economic Values 
 
The Economic Values worksheet contains an estimate of the magnitude of the “rebound effect”, 
as well as the rates used to compute the economic value of various direct and indirect impacts of 
CAFE standards, and the discount rate to apply when calculating present value.  As mentioned 
above, the user can define and edit all inputs.  For example, although the economic values in 
Table 18 were obtained from various sources of information, the system does not require that the 
user rely on these sources. 
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Table 18. Economic Values Worksheet 
Category Model Characteristic Units Definition/Notes 

Ec
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Rebound Effect percentage Increase in the annual use of vehicle models in response to lower per-mile cost of driving a more 
fuel-efficient vehicle. 

Social Discount Rate percentage Percent rate by which the dollar value of a benefit or cost is reduced when its receipt or payment 
is postponed by one additional year into the future; used for calculating socially-valued benefits. 

Private Discount Rate percentage Same as social discount rate, but used for calculating consumer-valued benefits. 
Kf $/mpg The CAFE fine rate a manufacturer would pay for non-compliance. 
Value of Travel Time per 
Vehicle $/hour Amount that the driver of a vehicle would be willing to pay to reduce the time required to make 

a trip. 
Economic Costs of Oil Imports various Economic costs of various oil imports. 

"Monopsony" Component $/gallon 

Demand cost for imported oil; increasing domestic petroleum demand that is met through higher 
oil imports can cause the world price of oil to rise, and conversely that declining imports can 
reduce the world price of oil; determined by a complex set of factors, including the relative 
importance of U.S. imports in the world oil market and demand to its world price among other 
participants in the international oil market. 

Price Shock Component $/gallon 

Expected value of costs to U.S. economy from reduction in potential output resulting from risk 
of significant increases in world petroleum price; includes costs resulting from inefficiencies in 
resource use caused by incomplete adjustments to industry output levels and mixes of 
production input when world oil price changes rapidly. 

Military Security Component $/gallon Costs of taxpayers for maintaining a military presence to secure the supply of oil imports from 
potentially unstable regions of the world and protect the nation against their interruption. 

Total Economic Costs 
($/gallon) $/gallon Total economic costs of oil imports (sum of monopsony, price shock, and military security 

components). 
Total Economic Costs 

($/BBL) $/BBL Total economic costs of oil imports, specified in $/BBL. 

External Costs from Additional 
Vehicle Use Due to "Rebound" 
Effect 

$/vehicle-mile 
Estimates intended to represent costs per vehicle-mile of increased travel compared to 
approximately current levels, assuming current distribution of travel by hours of the day and 
facility types. 

Congestion $/vehicle-mile Congestion component of external costs from additional vehicle use. 
Accidents $/vehicle-mile Accidents component of external costs from additional vehicle use. 
Noise $/vehicle-mile Noise component of external costs from additional vehicle use. 

Emission Damage Costs $/ton Additional costs arising from emission damage. 
Carbon Monoxide $/ton Economic costs arising from Carbon Monoxide damage. 
Volatile Organic Compounds $/ton Economic costs arising from Volatile Organic Compounds damage. 
Nitrogen Oxides $/ton Economic costs arising from Nitrous Oxides damage. 
Particulate Matter $/ton Economic costs arising from Particulate Matter damage. 
Sulfur Dioxide $/ton Economic costs arising from Sulfur Oxides damage. 
Methane (GWP-scalar of 

CO-2 Costs) $/ton Economic costs arising from Methane damage. 

Nitrous Oxide (GWP-scalar 
of CO-2 Costs) $/ton Economic costs arising from Nitrous Oxide damage. 

Annual Growth Rate for 
Average VMT per Vehicle various Annual growth rate for average VMT per vehicle. 

Base Year for Average 
Annual Usage Data (Primary) model year Base year for annual growth rate for average VMT per vehicle. 

Growth Rate at Low Fuel 
Price percentage Annual growth rate for average VMT per vehicle, when using low fuel prices. 

Growth Rate at Average Fuel 
Price percentage Annual growth rate for average VMT per vehicle, when using average fuel prices. 

Growth Rate at High Fuel 
Price percentage Annual growth rate for average VMT per vehicle, when using high fuel prices. 

Cost of CO-2 $/metric ton Economic costs arising from Carbon Dioxide damage, by calendar year; estimates for low, 
average, high, or very high growth rates are provided. 

CO-2 Discount Rates percentage Discount rates to apply to low, average, high, or very high Carbon Dioxide estimates. 
"Gap" between Test and On-
Road MPG (by Fuel Type) percentage Difference between a vehicle's EPA fuel economy rating and its actual on-road fuel economy. 

Average Refueling Time in 
Minutes (by Fuel Type) minutes Average refueling time a spent by a consumer refueling the vehicle tank or recharging the 

vehicle electric battery. 
Average Tank Volume 
Refueled percentage Average tank volume refilled during a refueling stop. 

Ownership and Operating 
Costs   

Taxes & Fees (% of final 
vehicle MSRP) percentage Average percentage of the vehicle's final MSRP the consumer pays in taxes and fees when 

purchasing a new vehicle. 
Financing (% of final vehicle 

MSRP) percentage Average percentage of the vehicle's final MSRP the consumer would pay for financing a new 
vehicle. 

Insurance (% of final vehicle 
MSRP) percentage Average percentage of the vehicle's final MSRP the consumer would pay for insuring a new 

vehicle. 
Relative Value Loss (% of 

final vehicle MSRP, pure EVs 
only) 

percentage Average percentage of the vehicle's final MSRP, which translates into relative value loss to 
consumer due to decreased operating life of pure electric vehicles. 

Resale Value percentage Average percentage of the vehicle's final MSRP the consumer recoups after selling the vehicle. 
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A.3.5 Fuel Properties 
 
The Fuel Properties worksheet contains estimates of the physical properties of gasoline, diesel, 
and other types of fuels, as well as certain assumptions about the effects of reduced fuel use on 
different sources of petroleum feedstocks and on imports of refined fuels.  These fuel properties 
and assumptions about the response of petroleum markets to reduced fuel use are used to 
calculate the changes in vehicular carbon dioxide emissions as well as in “upstream” emissions 
(from petroleum extraction and refining and from fuel storage and distribution) that are likely to 
result from reduced motor fuel use. 
 

Table 19. Fuel Properties Worksheet 
Category Model Characteristic Units Definition/Notes 

Fu
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Share of Total 
Assumed Fuel Mix percentage Estimated share of total fuel consumption by fuel type. 

Energy Density BTU/unit Amount of energy stored in a given system or region of 
space per unit volume, specified by fuel type. 

Mass Density grams/unit Mass per unit volume, specified by fuel type. 

Carbon Content percentage by 
weight Average share of carbon in fuel, specified by fuel type. 

SO-2 Emissions grams/unit Sulfur Oxides emissions rate of gasoline and diesel fuels. 
Share of Fuel Savings 
Leading to 
Lower Fuel Imports 

percentage Assumed value for share of fuel savings leading to lower 
fuel imports. 

Share of Fuel Savings 
Leading to 
Reduced Domestic Fuel 
Refining 

percentage Assumed value for share of fuel savings leading to 
reduced domestic fuel refining. 

Share of Reduced 
Domestic 
Refining from 
Domestic Crude 

percentage Assumed value for share of reduced domestic refining 
from domestic crude. 

Share of Reduced 
Domestic 
Refining from Imported 
Crude 

percentage Assumed value for share of reduced domestic refining 
from imported crude. 

 
A.3.6 Upstream Emissions 
 
The Upstream Emissions worksheet contains emission factors for greenhouse gas and criteria 
pollutant emissions from petroleum extraction and transportation, and from fuel refining, storage, 
and distribution. 
 

Table 20. Upstream Emissions Worksheet 
Category Model Characteristic Units Definition/Notes 
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 Petroleum Extraction grams/mil BTU 
Total emissions by stage of fuel production and 
distribution from petroleum extraction, specified by 
pollutant and fuel type. 

Petroleum Transportation grams/mil BTU 
Total emissions by stage of fuel production and 
distribution from petroleum transportation, specified 
by pollutant and fuel type. 

Petroleum Refining grams/mil BTU 
Total emissions by stage of fuel production and 
distribution from petroleum refining, specified by 
pollutant and fuel type. 

Fuel TS&D grams/mil BTU 
Total emissions by stage of fuel production and 
distribution from refined fuel transportation, storage, 
and delivery, specified by pollutant and fuel type. 

Subtotals grams/mil BTU Subtotals from all stages of fuel production and 
distribution. 
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A.3.7 Safety Values 
 
The Safety Values worksheet contains parameters for estimating additional fatalities resulting 
from decreases in vehicle weight. 
 

Table 21. Safety Values Worksheet 
Category Model Characteristic Units Definition/Notes 

Sa
fe

ty
 V

al
ue

s 

PC Threshold lbs. The boundary between small and large weight effects by  
safety class. LT/SUV Threshold lbs. 

CUV/Minivan Threshold lbs. 
Change per 100 lbs. percentage Change per 100 lbs. below the weight threshold. 

Base per billion miles  
Base fatalities per billion miles below the weight 
threshold. 

Adjustment for new FMVSS  
Adjustment for new FMVSS below the weight 
threshold. 

Monetized Fatalities   Cost Value dollar Social costs arising from vehicle fatalities. 
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A.4 Tailpipe Emissions File 
 
The emissions rates file contains vehicular criteria pollutant emission factors specified by vehicle 
age, fuel type (gasoline, reformulated gasoline, diesel, and ethanol-85), and Mobile6 class (LDV, 
LDT12, LDT34, and HDV).  Covered pollutants include carbon monoxide (CO), volatile organic 
compounds (VOC), nitrogen oxides (NOX), and fine particulate matter (PM2.5, or particulate 
matter less than 2.5 microns in diameter).  Particulate matter includes sulfate particulates, 
elemental carbon, non-volatile organic carbon compounds, and airborne lead, as well as 
particulate emissions from brake and tire wear.  Because we are concerned with increased 
emissions from more intensive use of existing vehicles (rather than from a larger vehicle fleet), 
the emission factors we estimated included only the components associated with vehicle use, and 
omitted those associated with vehicle storage.  Emission components associated with increased 
vehicle use include exhaust emissions during vehicle start-up and operation, evaporative 
emissions during vehicle operation, cool-down (“hot soak”), and refueling, and particulate 
emissions from brake and tire wear. 
 

Table 22. Emissions Rates Worksheet 
Category Model Characteristic Units Definition/Notes 

 Vehicle Age age  
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LDV grams/mile 
Vehicle operation emission rate for MOBILE6 LDV class for 
conventional gasoline, reformulated gasoline, diesel, or 
ethanol-85 fuel types. 

LDT12 grams/mile 
Vehicle operation emission rate for MOBILE6 LDT1 and 
LDT2 classes for conventional gasoline, reformulated 
gasoline, diesel, or ethanol-85 fuel types. 

LDT34 grams/mile 
Vehicle operation emission rate for MOBILE6 LDT3 and 
LDT4 classes for conventional gasoline, reformulated 
gasoline, diesel, or ethanol-85 fuel types. 

HDV grams/mile 
Vehicle operation emission rate for MOBILE6 HDV2b class 
for conventional gasoline, reformulated gasoline, diesel, or 
ethanol-85 fuel types. 
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A.5 Scenarios File 
 
The scenarios file provides one or more worksheets that begin with “SCEN_” and are identified 
as CAFE program scenarios, which are defined in terms of the design and stringency of the 
CAFE program.  The system numbers these scenarios as 0, 1, 2 …, based on their order of 
appearance.  The first worksheet is assigned to Scenario 0, and is identified as the baseline 
scenario to which all others are compared.  Each scenario defines the CAFE program as it relates 
to the following “regulatory classes”: 
 

Table 23. Regulatory Classes 
Reg. Class Includes 
0 Unregulated vehicles 
1 Passenger automobiles (domestic) 
2 Passenger automobiles (imported) 
3 Nonpassenger automobiles 

 
The “Regulatory Class” column on the vehicles worksheet discussed above is used to indicate 
whether the vehicle is regulated as a passenger or nonpassenger automobile.  The vehicle origin 
is further used to differentiate between regulatory classes 1 and 2 (domestic or imported).  
Vehicles from one regulatory class may also be reassigned into another via the Regulatory 
Declassification section of the scenario as shown in Table 24. 
 

Table 24. Regulatory Declassification Codes 
Code Description 
<blank> Specifies that regulatory merging does not apply. 
RC1 Specifies that all passenger automobiles (domestic and imported) 

should be merged into regulatory class 1. 
RC3 Specifies that all vehicles should be merged into regulatory class 3. 

 
Table 25 shows an example of a CAFE scenario definition worksheet. 
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Table 25. Scenario Definition Worksheet (Sample) 

 
 
Each section in Table 25 contains the following: 

• Scenario Description:  A short name describing the key features of the scenario. 

• Scenario Options:  Additional scenario specific options: 

o Preferred Alternative:  Specifies whether the scenario should be treated as the 
preferred alternative. 

2008 2009 2010 2011 2012 … 2024 2025 2026 Preferred Alternative TRUE
1 1 1 1 … 1 1 Regulatory Declassification RC1

2008 2009 2010 2011 2012 … 2024 2025 2026
Fnc Type 1 1 2 6 … 206 206

Coefficients
A 27.5 27.5 31.2 36.2 … 58.3 61.1
B 24.0 28.1 … 43.6 45.6
C 51.4100 0.0005 … 0.0004 0.0004
D 1.9100 0.0059 … 0.0013 0.0012
E … 42.1 42.1
F … 31.5 31.5
G … 0.0005 0.0005
H … 0.0020 0.0020

Alt. Minimum
mpg 27.5 27.5 … 27.5 27.5

% average 92% 92% … 92% 92%

2008 2009 2010 2011 2012 … 2024 2025 2026
Fnc Type 1 1 2 6 … 206 206

Coefficients
A 23.1 23.5 27.1 30.0 … 48.1 50.4
B 21.1 22.3 … 28.8 30.2
C 56.4050 0.0005 … 0.0004 0.0004
D 4.2847 0.0147 … 0.0035 0.0033
E … 35.4 35.4
F … 25.2 25.2
G … 0.0005 0.0005
H … 0.0096 0.0096

Alt. Minimum
mpg …

% average …

2008 2009 2010 2011 2012 … 2024 2025 2026
Include AC N N N Y … Y Y

Passenger Auto
CO2 Adj (g/mi) 1.6 … 5.0 5.0
Cost ($) 21 … 51 50

Nonpassenger Auto
CO2 Adj (g/mi) 1.4 … 7.2 7.2
Cost ($) 15 … 51 50

2008 2009 2010 2011 2012 … 2024 2025 2026
Passenger Auto … 10.0 10.0
Nonpassenger Auto … 10.0 10.0

2008 2009 2010 2011 2012 … 2024 2025 2026
PHEV Tax Credit ($)
EV Tax Credit ($)

Nonpassenger
Automobile
Standards

Regulatory
Incentives

Off-Cycle
Credits Cap

(g/mi)

Scenario Options

Adjustment for
Improvements in
Air Conditioning

CAFE Scenario Definition

Applicability of Multi-Fuel Vehicles

Model Year

Scenario Description Preferred Alternative

Passenger
Automobile
Standards
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o Regulatory Declassification:  Specifies whether vehicles from one regulatory 
class should be merged with vehicles from another regulatory class.  Table 24 
above shows the codes that may be used for regulatory declassification. 

• Passenger Automobile Standards:  The CAFE functional or flat standards to use during 
modeling of the scenario.  The “Fnc Type” subsection determines the functional form the 
system will use for the specific scenario.  Presently, the supported functional forms are:  
1, for flat standards; 2 for a logistic area-based functional form; 6, for a linear area-based 
functional form, and 206, for a dual-linear area-based functional form.  The 
“Coefficients” subsection contains corresponding coefficient values.  The “Alt. 
Minimum” sub-section applies to non-flat standard scenarios and represents the 
alternative minimum CAFE standards to apply to manufacturers whose required 
functional CAFE standard is below a specific minimum (mpg), or less than the specific 
percentage of the industry average (% average).  In the example scenario in Table 25, 
function type “206” is used for model year 2024, indicating that passenger automobiles 
should use a dual-linear area-based functional form, with the coefficients specified in 
fields A through H. 

• Nonpassenger Automobile Standards:  Same as the Passenger Automobile Standards 
section above, but applies to nonpassenger automobiles. 

• Adjustment for Improvements in Air Conditioning:  Provides functionality for including 
AC adjustments during compliance and effects calculations on a scenario basis.  The 
“Include AC” subsection determines during which model years the AC adjustments 
should be used for compliance.  The “CO2 Adj (g/mi)” and “Cost ($)” values, under the 
“Passenger Auto” and “Nonpassenger Auto” subsections, specify the AC adjustment 
factor and the cost of the AC adjustment respectively.  For the adjustment factor, a 
positive value should be used to represent a decrease in vehicle CO-2 emissions, while a 
negative value should be used to represent an increase in vehicle CO-2 emissions. 

• Off-Cycle Credits Cap (g/mi):  Specifies the maximum amount of off-cycle credits that 
may be accrued by a manufacturer.  Credits are accrued and capped separately for 
passenger automobiles and nonpassenger automobiles. 

• Regulatory Incentives:  Provides additional regulatory incentives, such as amount of tax 
credit to a buyer for purchasing a plug-in hybrid/electric vehicle or a pure electric 
vehicle. 
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A.6 EIS Parameters File 
 
The EIS parameters file contains additional modeling parameters required to perform 
supplemental analysis necessary for the Environmental Impact Statement (EIS).  The file 
contains a series of worksheets, the contents of which are summarized below. 
 
A.6.1 Fleet Data and Sales Data 
 
The Fleet Data worksheet provides historic data of vehicles remaining on the road, specified by 
model year for each vehicle age, for the car and truck fleets.  The period of years covered is 
between 1975 and 2010. 
 

Table 26. Fleet Data Worksheet (Sample) 

 
 
 

1975 1976 1977 1978 1979 1980 1981 1982 … 2009 2010
1 7,459,274 9,452,325 10,267,394 10,573,362 10,277,491 8,707,110 8,127,671 7,303,353 … 6,894,305 4,393,208
2 7,395,419 9,371,408 10,110,566 10,358,469 10,119,116 8,712,739 8,141,874 7,332,088 … 7,577,453 5,389,361
3 7,206,478 9,096,899 9,823,405 10,165,079 9,950,999 8,635,812 8,045,038 7,310,447 … 7,171,436 6,848,631
4 6,911,003 8,797,199 9,649,940 10,029,281 9,887,960 8,571,932 8,043,169 7,213,789 … 7,206,951 7,539,262
… … … … … … … … … … … …
26 212,919 300,888 392,570 448,988 528,824 338,916 289,038 257,489 … 448,178 791,060
27 187,363 267,571 356,875 401,147 461,134 0 0 0 … 304,201 617,169
28 169,579 268,922 320,266 349,590 0 0 0 0 … 262,313 368,417
29 162,788 245,921 280,102 0 0 0 0 0 … 0 254,821
30 150,873 220,318 0 0 0 0 0 0 … 0 227,745
31 135,272 0 0 0 0 0 0 0 … 0 0
32 0 0 0 0 0 0 0 0 … 0 0
33 0 0 0 0 0 0 0 0 … 0 0
34 0 0 0 0 0 0 0 0 … 0 0
35 0 0 0 0 0 0 0 0 … 0 0
36 0 0 0 0 0 0 0 0 … 0 0
37 0 0 0 0 0 0 0 0 … 0 0
38 0 0 0 0 0 0 0 0 … 0 0
39 0 0 0 0 0 0 0 0 … 0 0
40 0 0 0 0 0 0 0 0 … 0 0

1975 1976 1977 1978 1979 1980 1981 1982 … 2009 2010
1 1,716,731 2,415,823 2,879,854 3,143,823 3,368,587 1,950,450 1,861,330 1,996,118 … 6,816,660 3,765,784
2 1,739,671 2,448,104 2,858,443 3,269,424 3,415,518 1,907,867 1,864,288 1,986,850 … 7,156,173 6,723,790
3 1,735,045 2,381,056 2,965,957 3,265,480 3,429,755 1,884,684 1,859,372 2,014,784 … 7,478,573 7,146,249
4 1,667,717 2,458,341 2,976,576 3,264,937 3,388,922 1,859,864 1,875,581 1,987,197 … 7,782,816 7,401,816
… … … … … … … … … … … …
26 229,689 329,210 415,832 505,596 502,617 246,500 255,923 276,519 … 312,387 450,131
27 197,691 289,805 399,388 452,733 452,792 215,595 223,836 241,850 … 258,017 274,525
28 173,875 270,615 354,133 399,354 395,270 188,206 195,400 211,126 … 213,030 230,865
29 162,660 242,343 320,112 348,306 344,744 164,148 170,423 184,138 … 182,167 191,683
30 145,220 216,331 278,970 303,540 300,436 143,051 148,520 160,472 … 331,042 164,698
31 129,439 188,345 242,881 264,273 261,570 124,545 129,306 139,712 … 274,098 298,226
32 112,706 163,997 211,483 230,110 227,756 108,445 112,591 121,652 … 236,433 241,781
33 97,897 142,448 183,694 199,873 197,829 94,196 97,796 105,667 … 153,881 213,720
34 85,203 123,978 159,876 173,957 172,178 81,982 85,115 91,965 … 91,660 137,364
35 74,048 107,746 138,944 151,181 149,635 71,248 73,972 79,925 … 107,970 81,700
36 64,239 93,473 120,538 131,155 129,813 61,810 64,173 69,337 … 0 97,920
37 0 0 0 0 0 0 0 0 … 0 69,550
38 0 0 0 0 0 0 0 0 … 0 0
39 0 0 0 0 0 0 0 0 … 0 0
40 0 0 0 0 0 0 0 0 … 0 0

Vehicle
Age

Vehicle
Age

Car Fleet (by Model Year)

Truck Fleet (by Model Year)
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The Sales Data worksheet contains projected vehicle production for sale in the U.S. between 
model years 2005 and 2064.  The Sales worksheet is used to estimate additional car and truck 
fleet values, beyond what is available on the Fleet Data worksheet. 
 

Table 27. Sales Data Worksheet (Sample) 

 
 
A.6.2 No CAFE Data 
 
The No CAFE Data worksheet contains estimated fuel economy levels and fuel shares covering 
the years between 1975 and 2064, assuming the absence of the CAFE program.  Data is provided 
for gasoline and diesel fuel types and is separated by passenger cars and light trucks.  The values 
are flatlined after 1977, all the way to 2064.  The fuel shares of additional fuel types (E85, 
electricity, and hydrogen) are assumed to be 0. 
 

Table 28. No CAFE Data Worksheet 
Category Model Characteristic Units Definition/Notes 

N
o 

C
A

FE
 D

at
a Passenger Cars (FE) mpg Historic fuel economy levels for passenger cars, assuming the 

absence of the CAFE program. 

Passenger Cars (Share) percentage Historic fuel shares for passenger cars, assuming the absence 
of the CAFE program. 

Light Trucks (FE) mpg Historic fuel economy levels for light trucks, assuming the 
absence of the CAFE program. 

Light Trucks (Share) percentage Historic fuel shares for light trucks, assuming the absence of 
the CAFE program. 

 
A.6.3 Overcompliance Data 
 
The Overcompliance Data worksheet contains additional parameters used when considering the 
effect of voluntary overcompliance.  The worksheets contains growth rates by fleet type 
(passenger cars and light trucks) and fuel type (gasoline, diesel, ethanol-85, electricity, and 
hydrogen), to estimate additional fuel economy growth beyond the last model year covered 
during the study period.  For this analysis, the last year examined was 2025, and the growth rates 

2005 7,698,885 8,125,438 15,824,323
2006 7,809,903 7,875,145 15,685,047
2007 7,704,630 7,474,079 15,178,708
2008 7,159,772 6,691,989 13,851,761
2009 5,158,841 4,659,383 9,818,224
2010 6,128,381 5,061,799 11,190,180
2011 6,721,506 5,459,894 12,181,400
2012 7,111,912 5,886,988 12,998,900
2013 7,990,815 6,641,885 14,632,700
2014 8,408,316 6,845,284 15,253,600
2015 8,668,506 6,897,994 15,566,500
2016 8,859,916 7,002,284 15,862,200
2017 8,846,492 6,965,608 15,812,100
2018 8,753,615 6,851,785 15,605,400
… … … …

2059 12,479,020 8,729,677 21,208,697
2060 12,578,178 8,799,043 21,377,221
2061 12,678,537 8,869,248 21,547,784
2062 12,780,040 8,940,255 21,720,295
2063 12,882,676 9,012,053 21,894,729
2064 12,986,312 9,084,551 22,070,863

Model
Year TotalLight

Trucks
Passenger

Cars
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are specified for model years between 2026 and 2064.  Different growth rates are provided for 
the baseline alternative and the action alternatives. 
 

Table 29. Overcompliance Data Worksheet 
Category Model Characteristic Units Definition/Notes 

O
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a Baseline Growth Rates for 
Voluntary Overcompliance  

Growth rates used to estimate additional fuel economy 
growth beyond the last model year covered during the 
study period for the baseline scenario. 

Passenger Cars (FE) percentage Baseline scenario growth rates for passenger cars. 
Light Trucks (FE) percentage Baseline scenario growth rates for light trucks. 

Action Alternatives Growth Rates 
for Voluntary Overcompliance  

Growth rates used to estimate additional fuel economy 
growth beyond the last model year covered during the 
study period for the action alternatives. 

Passenger Cars (FE) percentage Action alternatives growth rates for passenger cars. 
Light Trucks (FE) percentage Action alternatives growth rates for light trucks. 
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A.7 EIS Tailpipe Emissions 
 
The EIS tailpipe emissions file contains pollutant emission factors necessary for EIS analysis.  
Emission factors are specified in grams per mile by vehicle age, fuel type (gasoline, diesel, and 
ethanol-85), and fleet type (LDV and LDT).  Different pollutant values are provided for model 
years covering the period between 1975 and 2011.  After 2011, these values are assumed to hold 
steady.  The included pollutants are:  acetaldehyde, acrolein, benzene, butadiene, CH4, CO, 
diesel PM10, formaldehyde, MTBE, N2O, NOx, PM, and VOC. 
 

Table 30. EIS Tailpipe Emissions Worksheet 
Category Model Characteristic Units Definition/Notes 

 Vehicle Age age   
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M
od

el
 Y

ea
r) Gasoline - LDV grams/mile Vehicle operation emission rate for passenger cars for gasoline fuel. 

Gasoline - LDT grams/mile Vehicle operation emission rate for light trucks for gasoline fuel. 
Diesel - LDV grams/mile Vehicle operation emission rate for passenger cars for diesel fuel. 
Diesel - LDT grams/mile Vehicle operation emission rate for light trucks for diesel fuel. 
Ethanol-85 - LDV grams/mile Vehicle operation emission rate for passenger cars for ethanol-85 fuel. 
Ethanol-85 - LDT grams/mile Vehicle operation emission rate for light trucks for ethanol-85 fuel. 
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Appendix B Model Outputs 
 
The system produces eight output files in comma separate values (CSV) format.  The system 
places all files in the “reports” folder, located in the user selected output path (ex: C:\cafe\demo-
run\demo\reports-csv).  Table 31 lists the available output types and their contents.  With this 
revision of the modeling system, the structure of all outputs generated has changed from earlier 
versions.  The “raw” modeling results are stored as plain text (without any additional 
formatting), in a “database-like” style.  Most of the modeling reports have been extended to 
include additional information, while some were scaled down to contain only the relevant 
portions.  As discussed earlier, the first scenario appearing in the scenarios file is assigned to 
Scenario 0 and is treated as the baseline.  The action alternatives are then assigned to Scenario 1, 
2, and so on, in order of appearance.  Unlike in the previous outputs, the CSV reports for the 
action alternatives do not include relative changes compared to the baseline; only absolute values 
are reported.  To obtain the relative changes, the users may subtract results reported for Scenario 
0 from results reported for action alternative scenarios. 
 

Table 31. Output Files 
Output File Contents 

Technology Utilization Report 

Contains manufacturer-level and industry-wide technology application and 
penetration rates for each technology, model year, and scenario analyzed.  
The results are disaggregated by regulatory class, as well as combined over 
the entire fleet. 

Compliance Report 
Contains manufacturer-level and industry-wide summary of compliance 
model results for each model year and scenario analyzed.  The results are 
disaggregated by regulatory class, as well as combined over the entire fleet. 

Societal Effects Report 

Contains industry-wide summary of energy and emissions effects for each 
model year and scenario analyzed.  The results are disaggregated by 
regulatory class and fuel type, as well as combined across all fuels and over 
the entire fleet. 

Societal Costs Report  

Contains industry-wide summary of consumer and social costs for each 
model year and scenario analyzed.  The results are disaggregated by 
regulatory class and fuel type, as well as combined across all fuels and over 
the entire fleet. 

Annual Societal Effects Report  This output file is similar to the Societal Effects Report, except it further 
disaggregates the results by calendar year. 

Annual Societal Costs Report  This output file is similar to the Societal Costs Report, except it further 
disaggregates the results by calendar year. 

Vehicles Report 
Contains disaggregate vehicle-level summary of compliance model results, 
providing a detailed view of the final state of each vehicle examined by the 
model, for each model year and scenario analyzed. 

Optimization Report 

Contains functional coefficients and CAFE levels (required and achieved) 
for each iteration that was evaluated during optimization.  This output file 
also contains a brief snapshot of industry-wide results, per iteration, that 
aided the model in picking the optimum levels for each model year that was 
optimized. 

 
The remainder of this section discusses the contents of the output files. 
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B.1 Technology Utilization Report 
 
The Technology Utilization Report contains manufacturer-level and industry-wide technology 
application and penetration rates for each technology.  The application rates represent the amount 
of technology that was applied by the modeling system during analysis while the penetration 
rates represent the amount of technology that was either on the vehicle initially at the start of the 
analysis, or applied by the modeling system during analysis.  If a technology was present on or 
applied to a vehicle, but later superseded during the modeling process by another technology (for 
example, DCP superseding ICP), the superseded technology on that vehicle will not count 
toward the penetration rate. 
 
When the Technology Utilization Report is generated, the modeling system combines the 
application and penetration rates of some of the discrete technologies into a single entry.  This 
merging occurs only for technology entries that represent the same technology, but are modeled 
separately given the differences in costs and fuel improvements attributed to different engine 
sizes.  For example, TRBDS1_SD, TRBDS1_MD, and TRBDS1_LD, all represent the same 
technology, and the application and penetration rates of these three technologies were summed 
and reported as TRBDS1.  Furthermore, some of the technologies which are present in the 
baseline fleet, but are not explicitly analyzed by the modeling system also appear in the report.  
This technologies include DSL (standard diesels) and E85 FFV (ethanol-85 flex-fuel vehicles). 
 
The following table lists the contents of the Technology Utilization Report. 
 

Table 32. Technology Utilization Report 
Column Units Contents 

Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above 
represent the action alternatives. 

Scenario Name text A short name describing the key features of the scenario. 
Model Year model year Model years analyzed during the study period. 

Manufacturer text Manufacturers analyzed during the study period.  A value of "<Industry>" is used to 
represent industry-wide results. 

Reg-Class text The regulatory class for which the application and penetration rates are reported.  A 
value of "<Total>" is used to represent the sum across all regulatory classes. 

Technology 
(abbreviation) text The technology for which the application and penetration rates are reported. 

App-Rate number The application rate of the technology, specified as a proportion of total sales. 
Pen-Rate number The penetration rate of the technology, specified as a proportion of total sales. 
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B.2 Compliance Report 
 
The Compliance Report contains manufacturer-level and industry-wide summary of compliance 
model results for each model year and scenario analyzed.  The results are reported by regulatory 
class, as well as aggregated for the entire fleet.  Most of the metrics, which are reported 
independently by model year, are further summed (or averaged) over the entire analysis period.  
The report provides various cost values associated with the rule, represented as “totals” across all 
vehicle models, as well as “averages” per single vehicle unit.  The following table lists the 
contents of the Compliance Report. 
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Table 33. Compliance Report 
Column Units Contents 
Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action alternatives. 
Scenario Name text A short name describing the key features of the scenario. 

Model Year model 
year 

Model years analyzed during the study period.  A value of "Total" is used to represent the sums (or averages) 
across all model years for some of the outputs, where applicable. 

Manufacturer text Manufacturers analyzed during the study period.  A value of "<Industry>" is used to represent industry-wide 
results. 

Reg-Class text The regulatory class for which the compliance results are reported.  A value of "Total" is used to represent the 
sums (or averages) across all regulatory classes for some of the outputs, where applicable. 

Sales units Total production of vehicles for sale for a specific model year, manufacturer, and regulatory class (as well as sum 
across any of the attributes, where applicable). 

k.Labor Hours hours 
(k) 

Thousands of employment hours associated with the production of vehicle models.  (The modeling system applies 
any employment hours specified in the input file; however, the system reflects no predetermined assumptions 
regarding the context for these inputs.) 

Prelim-Stnd mpg Preliminary value of the required CAFE standard (before the "alternative minimum CAFE standard", as outlined 
in the scenarios input section, is applied). 

Standard mpg The value of the required CAFE standard. 

CAFE (2-cycle) mpg The value of the achieved CAFE standard, using a 2-bag test cycle, not including the adjustment for improvements 
in air conditioning or off-cycle credits. 

CAFE mpg The value of the achieved CAFE standard, including the adjustment for improvements in air conditioning and off-
cycle credits.  This value is used for compliance purposes. 

Average CW lbs. Average curb weight of analyzed vehicles. 
Average FP sq.ft. Average footprint of analyzed vehicles. 

Tech Cost dollars Total amount of technology costs accrued by all vehicles for a specific model year, manufacturer, and regulatory 
class. 

Fines dollars Total amount of fines paid by a manufacturer for a specific model year and regulatory class. 

Reg-Cost dollars Total amount of regulatory costs accrued by all vehicles for a specific model year, manufacturer, and regulatory 
class.  The regulatory costs are the sum of technology costs and fines. 

Value Loss dollars Total loss in value to the consumer due to decreased range of pure electric vehicles. 
Rel. Value Loss dollars Total relative loss in value to the consumer due to due to decreased operating life of pure electric vehicles. 
Maint Cost dollars Total maintenance costs accrued due to application of additional technologies. 
Repair Cost dollars Total repair costs accrued due to application of additional technologies. 

Taxes/Fees dollars Total amount of taxes & fees paid by the consumers for purchasing new vehicles for a specific model year, 
manufacturer, and regulatory class. 

Financing dollars Total amount paid by the consumers for financing new vehicles for a specific model year, manufacturer, and 
regulatory class. 

Insurance dollars Total amount paid by the consumers for insuring new vehicles for a specific model year, manufacturer, and 
regulatory class. 

Total Consumer 
Costs dollars 

The total consumer costs accumulated by the manufacturer for a specific model year and regulatory class.  The 
consumer costs are the sum of:  technology costs, fines, taxes & fees, financing costs, insurance costs, 
maintenance costs, repair costs, loss of value, and relative loss of value. 

Total Social Costs dollars The total social costs accumulated by the manufacturer for a specific model year and regulatory class.  The social 
costs are the sum of:  technology costs, maintenance costs, repair costs, loss of value, and relative loss of value. 

Avg Tech Cost dollars Average technology costs per single vehicle unit. 
Avg Fines dollars Average fines paid per single vehicle unit. 
Avg Reg-Cost dollars Average regulatory costs per single vehicle unit. 
Avg Value Loss dollars Average loss in value per single vehicle unit. 
Avg Rel. Value Loss dollars Average relative loss in value per single vehicle unit. 
Avg Maint Cost dollars Average maintenance costs per single vehicle unit. 
Avg Repair Cost dollars Average repair costs per single vehicle unit. 
Avg Taxes/Fees dollars Average taxes & fees per single vehicle unit. 
Avg Financing dollars Average financing costs per single vehicle unit. 
Avg Insurance dollars Average insurance costs per single vehicle unit. 
Avg Consumer Costs dollars Average consumer costs per single vehicle unit. 
Avg Social Costs dollars Average social costs per single vehicle unit. 

Credits Earned vehicle
-mpg 

Total credits accumulated by the manufacturer for a specific model year and regulatory class.  Manufacturers earn 
one compliance credit for each tenth of an mpg that its achieved value of CAFE standard is above the required 
value of the CAFE standard (i.e., CreditsEarned = MAX(ROUND(AchievedCAFE, 1) - RequiredCAFE, 0) * 10). 

Credits Out vehicle
-mpg 

Total credits transferred out of a specific regulatory class (such as from domestic passenger automobiles to light 
trucks) or carried forward from a previous model year. 

Credits In vehicle
-mpg Total credits transferred into a specific regulatory class or carried forward into the present model year. 
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B.3 Societal Effects Report and Societal Costs Report 
 
The Societal Effects Report contains industry-wide summary of energy and emissions effects, 
while the Societal Costs Report contains corresponding industry-wide summary of consumer and 
social costs for each model year and scenario analyzed.  The results are reported by regulatory 
class, as well as aggregated for the entire fleet.  Most of the metrics, which are reported 
independently by model year, are further summed (or averaged) over the entire analysis period. 
 
The Societal Effects Report also disaggregates energy and emissions effects by fuel type, as well 
as providing aggregate totals across all fuels.  The report contains calculated levels of energy 
consumed by fuel type in MBTU, thousands of gallons, megawatt hours, and thousands cubic 
feet during the full useful life of all vehicles sold in each model year.  For gasoline, diesel, and 
ethanol-85 fuel types, fuel consumption is specified in gallons of appropriate fuel.  For electricity 
and hydrogen, fuel consumption is specified in gasoline equivalent gallons.  Full useful life 
travel (in thousands of miles) and average fuel economy levels are also presented to provide a 
basis for comparison.  The rated fuel economy levels reported are not comparable to the value of 
achieved CAFE standard shown in the compliance report.  The values contained in the Societal 
Effects Report are computed as total VMT divided by total gallons (with the effect of the on-road 
gap backed out), and do not incorporate some of the compliance credits. 
 
The Societal Effects Report also presents estimates of full fuel cycle carbon dioxide and criteria 
pollutant emissions by fuel type.  As shown in Table 34 below, carbon dioxide emissions are 
reported in million metric tons of carbon-equivalent emissions (one metric ton of carbon dioxide 
is equivalent to 12/44 of a metric ton of carbon), and all criteria pollutants are reported in short 
tons (one ton equals 2,000 pounds).  Furthermore, to account for global warming potential of 
non-CO2 gasses, methane and nitrous oxide emissions are also presented in million metric tons. 
 
The Societal Costs Report contains monetized consumer and social costs including fuel 
expenditures, travel and refueling value, economic and external costs arising from additional 
vehicle use, as well as owner and societal costs associated with emissions damage.  In all cases, 
these costs are calculated for the fleet of vehicles sold in each model year over their full useful 
lives, discounted using the rate specified in the benefits model parameters file, and reported in 
thousands of constant year-2010 dollars.  Chapter Three, Section 6 of the primary text discusses 
these types of costs and benefits in greater detail, and Appendix A (Model Inputs) discusses 
corresponding input assumptions. 
 
Table 34 below lists the full contents of the Societal Effects Report and Table 35 lists the full 
contents of the Societal Costs Report. 
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Table 34. Societal Effects Report 
Column Units Contents 

Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action 
alternatives. 

Scenario Name text A short name describing the key features of the scenario. 

Model Year model 
year 

Model years analyzed during the study period.  A value of "Total" is used to represent the sums (or 
averages) across all model years for some of the outputs, where applicable. 

Reg-Class text The regulatory class for which the societal effects are reported.  A value of "Total" is used to represent the 
sums (or averages) across all regulatory classes for some of the outputs, where applicable. 

Fuel Type text The fuel type for which the societal effects are reported.  A value of "Total" is used to represent the sums (or 
averages) across all fuel types for some of the outputs, where applicable. 

Sales units Total production of vehicles for sale for a specific model year, regulatory class, and fuel type (as well as 
sum across any of the attributes, where applicable). 

kVMT miles 
(k) 

Thousands of miles traveled by all vehicles over their lifetime in a specific model year and for a specific 
regulatory class and fuel type. 

MBTU MBTU Energy used by all vehicles over their lifetime in a specific model year and for a specific regulatory class 
and fuel type. 

kGallons gallons 
(k) 

Amount of gallons of liquid fuel consumed, or amount of gasoline equivalent gallons of fuel consumed (for 
electric fuel type), by all vehicles over their lifetime in a specific model year and for a specific regulatory 
class and fuel type. 

mW-h mW-h 
Amount of electricity consumed by all plug-in hybrid/electric vehicles or pure-electric vehicles over their 
lifetime in a specific model year and for a specific regulatory class.  This value is only applicable when fuel 
type is "Electricity" or "Total". 

Mcf Mcf Amount of hydrogen fuel consumed by all fuel-cell vehicles over their lifetime in a specific model year and 
for a specific regulatory class.  This value is only applicable when fuel type is "Hydrogen" or "Total". 

Rated FE mpg The average fuel economy rating of vehicles. 
On-road FE mpg The average on-road fuel economy rating of vehicles. 

CO-2 (mmT) mmT 
Amount of Carbon Dioxide emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated 
over the lifetime of all vehicles for a specific model year, regulatory class, and fuel type. 

CO (tons) tons 

Amount of Carbon Monoxide emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle 
operation, aggregated over the lifetime of all vehicles for a specific model year, regulatory class, and fuel 
type. 

VOC (tons) tons 

Amount of Volatile Organic Compounds emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle 
operation, aggregated over the lifetime of all vehicles for a specific model year, regulatory class, and fuel 
type. 

NOx (tons) tons 
Amount of Nitrogen Oxides emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated 
over the lifetime of all vehicles for a specific model year, regulatory class, and fuel type. 

PM (tons) tons 
Amount of Particulate Matter emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated 
over the lifetime of all vehicles for a specific model year, regulatory class, and fuel type. 

SOx (tons) tons 
Amount of Sulfur Dioxide emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated 
over the lifetime of all vehicles for a specific model year, regulatory class, and fuel type. 

CH4 (mmT) mmT 
Amount of Methane emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over 
the lifetime of all vehicles for a specific model year, regulatory class, and fuel type. 

N2O (mmT) mmT 
Amount of Nitrous Oxide emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated 
over the lifetime of all vehicles for a specific model year, regulatory class, and fuel type. 

Fatals PC units 
Changes in fatalities, for the Passenger Car safety class, resulting from reduction in vehicle curb weight, 
aggregated over the lifetime of all vehicles for a specific model year and regulatory class.  A negative 
number indicates a reduction in fatalities, while a positive number indicates an increase in fatalities. 

Fatals CM units 
Changes in fatalities, for the CUV/Minivan safety class, resulting from reduction in vehicle curb weight, 
aggregated over the lifetime of all vehicles for a specific model year and regulatory class.  A negative 
number indicates a reduction in fatalities, while a positive number indicates an increase in fatalities. 

Fatals LT units 
Changes in fatalities, for the Light Truck/SUV safety class, resulting from reduction in vehicle curb weight, 
aggregated over the lifetime of all vehicles for a specific model year and regulatory class.  A negative 
number indicates a reduction in fatalities, while a positive number indicates an increase in fatalities. 
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Table 35. Societal Costs Report 
Column Units Contents 

Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action 
alternatives. 

Scenario Name text A short name describing the key features of the scenario. 

Model Year model 
year 

Model years analyzed during the study period.  A value of "Total" is used to represent the sums (or 
averages) across all model years for some of the outputs, where applicable. 

Reg-Class text The regulatory class for which the societal costs are reported.  A value of "Total" is used to represent the 
sums (or averages) across all regulatory classes for some of the outputs, where applicable. 

Disc-Rate number Social discount rate applied to future benefits.  A value of 0 indicates undiscounted costs. 
Pre-Tax Fuel 
Cost 

dollars 
(k) 

Total pre-tax fuel expenditures accumulated across all vehicles over their lifetime in a specific model year 
and for a specific regulatory class. 

Fuel Tax Cost dollars 
(k) 

Total fuel tax revenues accumulated across all vehicles over their lifetime in a specific model year and for a 
specific regulatory class. 

Drive Surplus dollars 
(k) 

Benefits from the additional driving that results from improved fuel economy, accumulated across all 
vehicles over their lifetime in a specific model year and for a specific regulatory class. 

Refuel Surplus dollars 
(k) 

Benefits from reduced refueling frequency due to the extended vehicle range and improved fuel economy, 
accumulated across all vehicles over their lifetime in a specific model year and for a specific regulatory 
class. 

Market 
Externalities 

dollars 
(k) 

Economic costs of oil imports not accounted for by price, accumulated across all vehicles over their lifetime 
in a specific model year and for a specific regulatory class. 

Congestion 
Costs 

dollars 
(k) 

Congestion costs from additional vehicle use, accumulated across all vehicles over their lifetime in a specific 
model year and for a specific regulatory class. 

Accident Costs dollars 
(k) 

Accident costs from additional vehicle use, accumulated across all vehicles over their lifetime in a specific 
model year and for a specific regulatory class. 

Noise Costs dollars 
(k) 

Noise costs from additional vehicle use, accumulated across all vehicles over their lifetime in a specific 
model year and for a specific regulatory class. 

Fatality Costs dollars 
(k) 

Cost from additional fatalities resulting from reduction in vehicle curb weight, accumulated across all 
vehicles over their lifetime in a specific model year and for a specific regulatory class. 

CO-2 Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Carbon Dioxide damage, aggregated over the lifetime of all vehicles 
for a specific model year and regulatory class. 

CO Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Carbon Monoxide damage, aggregated over the lifetime of all 
vehicles for a specific model year and regulatory class. 

VOC Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Volatile Organic Compounds damage, aggregated over the lifetime of 
all vehicles for a specific model year and regulatory class. 

NOx Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Nitrogen Oxides damage, aggregated over the lifetime of all vehicles 
for a specific model year and regulatory class. 

PM Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Particulate Matter damage, aggregated over the lifetime of all vehicles 
for a specific model year and regulatory class. 

SOx Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Sulfur Dioxide damage, aggregated over the lifetime of all vehicles 
for a specific model year and regulatory class. 

CH4 Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Methane damage, aggregated over the lifetime of all vehicles for a 
specific model year and regulatory class. 

N2O Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Nitrous Oxide damage, aggregated over the lifetime of all vehicles for 
a specific model year and regulatory class. 

Retail Fuel 
Costs 

dollars 
(k) 

Total retail fuel expenditures (pre-tax fuel cost + fuel tax cost) accumulated across all vehicles over their 
lifetime in a specific model year and for a specific regulatory class. 

Total 
Consumer 
Costs 

dollars 
(k) 

Total consumer costs accumulated by the industry for a specific model year and regulatory class.  The 
consumer costs are the sum of:  retail fuel costs, drive surplus, and refueling surplus. 

Total Social 
Costs 

dollars 
(k) 

Total social costs accumulated by the industry for a specific model year and regulatory class.  The social 
costs are the sum of:  pre-tax fuel costs, drive surplus, refueling surplus, market externalities, congestion 
costs, accident costs, noise costs, fatality costs, and emissions damage costs (CO2, CO, VOC, NOx, PM, 
SOx, CH4, and N2O). 
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B.4 Annual Societal Effects Report and Annual Societal Costs Report 
 
The Annual Societal Effects Report and the Annual Societal Costs Report contain similar results 
as the Societal Effects Report and the Societal Costs Report, except these outputs further 
disaggregate the results by calendar year.  Table 36 lists the full contents of the Annual Societal 
Effects Report and Table 37 lists the full contents of the Annual Societal Costs Report. 
 

Table 36. Annual Societal Effects Report 
Column Units Contents 

Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action 
alternatives. 

Scenario Name text A short name describing the key features of the scenario. 

Model Year model 
year 

Model years analyzed during the study period.  A value of "Total" is used to represent the sums (or 
averages) across all model years for some of the outputs, where applicable. 

Calendar Year calendar 
year 

Calendar years analyzed for the effects calculations.  Each calendar year corresponds to vehicle's vintage.  
A value of "Total" is used to represent the sums (or averages) across all calendar years for some of the 
outputs, where applicable. 

Reg-Class text The regulatory class for which the societal effects are reported.  A value of "Total" is used to represent the 
sums (or averages) across all regulatory classes for some of the outputs, where applicable. 

kVMT miles (k) Thousands of miles traveled by all vehicles in a specific model year and calendar year, and for a specific 
regulatory class. 

MBTU MBTU Energy used by all vehicles in a specific model year and calendar year, and for a specific regulatory class. 

kGallons gallons 
(k) 

Amount of gallons of liquid fuel consumed, or amount of gasoline equivalent gallons of fuel consumed 
(for electric fuel type), by all vehicles in a specific model year and calendar year, and for a specific 
regulatory class. 

mW-h mW-h 
Amount of electricity consumed by all plug-in hybrid/electric vehicles or pure-electric vehicles in a 
specific model year and calendar year, and for a specific regulatory class.  This value is only applicable 
when fuel type is "Electricity" or "Total". 

Mcf Mcf Amount of hydrogen fuel consumed by all fuel-cell vehicles in a specific model year and calendar year, 
and for a specific regulatory class.  This value is only applicable when fuel type is "Hydrogen" or "Total". 

CO-2 (mmT) mmT 
Amount of Carbon Dioxide emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle 
operation, aggregated for all vehicles in a specific model year, calendar year, and regulatory class. 

CO (tons) tons 
Amount of Carbon Monoxide emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle 
operation, aggregated for all vehicles in a specific model year, calendar year, and regulatory class. 

VOC (tons) tons 
Amount of Volatile Organic Compounds emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle 
operation, aggregated for all vehicles in a specific model year, calendar year, and regulatory class. 

NOx (tons) tons 
Amount of Nitrogen Oxides emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle 
operation, aggregated for all vehicles in a specific model year, calendar year, and regulatory class. 

PM (tons) tons 
Amount of Particulate Matter emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle 
operation, aggregated for all vehicles in a specific model year, calendar year, and regulatory class. 

SOx (tons) tons 
Amount of Sulfur Dioxide emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, 
aggregated for all vehicles in a specific model year, calendar year, and regulatory class. 

CH4 (mmT) mmT 
Amount of Methane emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated 
for all vehicles in a specific model year, calendar year, and regulatory class. 

N2O (mmT) mmT 
Amount of Nitrous Oxide emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, 
aggregated for all vehicles in a specific model year, calendar year, and regulatory class. 

Fatalities units 
Changes in fatalities, from all safety classes, resulting from reduction in vehicle curb weight, aggregated 
over the lifetime of all vehicles for a specific model year and regulatory class.  A negative number 
indicates a reduction in fatalities, while a positive number indicates an increase in fatalities. 
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Table 37. Annual Societal Costs Report 
Column Units Contents 

Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action 
alternatives. 

Scenario Name text A short name describing the key features of the scenario. 

Model Year model 
year 

Model years analyzed during the study period.  A value of "Total" is used to represent the sums (or 
averages) across all model years for some of the outputs, where applicable. 

Calendar Year calendar 
year 

Calendar years analyzed for the effects calculations.  Each calendar year corresponds to vehicle's vintage.  
A value of "Total" is used to represent the sums (or averages) across all calendar years for some of the 
outputs, where applicable. 

Reg-Class text The regulatory class for which the societal effects are reported.  A value of "Total" is used to represent 
the sums (or averages) across all regulatory classes for some of the outputs, where applicable. 

Disc-Rate number Social discount rate applied to future benefits.  A value of 0 indicates undiscounted costs. 
Pre-Tax Fuel 
Cost 

dollars 
(k) 

Total pre-tax fuel expenditures accumulated across all vehicles in a specific model year and calendar 
year, and for a specific regulatory class. 

Fuel Tax Cost dollars 
(k) 

Total fuel tax revenues accumulated across all vehicles in a specific model year and calendar year, and 
for a specific regulatory class. 

Drive Surplus dollars 
(k) 

Benefits from the additional driving that results from improved fuel economy, accumulated across all 
vehicles in a specific model year and calendar year, and for a specific regulatory class. 

Refuel Surplus dollars 
(k) 

Benefits from reduced refueling frequency due to the extended vehicle range and improved fuel 
economy, accumulated across all vehicles in a specific model year and calendar year, and for a specific 
regulatory class. 

Market 
Externalities 

dollars 
(k) 

Economic costs of oil imports not accounted for by price, accumulated across all vehicles in a specific 
model year and calendar year, and for a specific regulatory class. 

Congestion 
Costs 

dollars 
(k) 

Congestion costs from additional vehicle use, accumulated across all vehicles in a specific model year 
and calendar year, and for a specific regulatory class. 

Accident Costs dollars 
(k) 

Accident costs from additional vehicle use, accumulated across all vehicles in a specific model year and 
calendar year, and for a specific regulatory class. 

Noise Costs dollars 
(k) 

Noise costs from additional vehicle use, accumulated across all vehicles in a specific model year and 
calendar year, and for a specific regulatory class. 

Fatality Costs dollars 
(k) 

Cost from additional fatalities resulting from reduction in vehicle curb weight, accumulated across all 
vehicles in a specific model year and calendar year, and for a specific regulatory class. 

CO-2 Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Carbon Dioxide damage, aggregated for all vehicles in a specific 
model year, calendar year, and regulatory class. 

CO Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Carbon Monoxide damage, aggregated for all vehicles in a specific 
model year, calendar year, and regulatory class. 

VOC Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Volatile Organic Compounds damage, aggregated for all vehicles 
in a specific model year, calendar year, and regulatory class. 

NOx Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Nitrogen Oxides damage, aggregated for all vehicles in a specific 
model year, calendar year, and regulatory class. 

PM Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Particulate Matter damage, aggregated for all vehicles in a specific 
model year, calendar year, and regulatory class. 

SOx Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Sulfur Dioxide damage, aggregated for all vehicles in a specific 
model year, calendar year, and regulatory class. 

CH4 Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Methane damage, aggregated for all vehicles in a specific model 
year, calendar year, and regulatory class. 

N2O Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Nitrous Oxide damage, aggregated for all vehicles in a specific 
model year, calendar year, and regulatory class. 

Retail Fuel 
Costs 

dollars 
(k) 

Total retail fuel expenditures (pre-tax fuel cost + fuel tax cost) accumulated across all vehicles in a 
specific model year and calendar year, and for a specific regulatory class. 

Total Consumer 
Costs 

dollars 
(k) 

Total consumer costs accumulated by the industry for a specific model year, calendar year, and 
regulatory class.  The consumer costs are the sum of:  retail fuel costs, drive surplus, and refueling 
surplus. 

Total Social 
Costs 

dollars 
(k) 

Total social costs accumulated by the industry for a specific model year, calendar year, and regulatory 
class.  The social costs are the sum of:  pre-tax fuel costs, drive surplus, refueling surplus, market 
externalities, congestion costs, accident costs, noise costs, fatality costs, and emissions damage costs 
(CO2, CO, VOC, NOx, PM, SOx, CH4, and N2O). 
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B.5 Vehicles Report 
 
The Vehicles Report contains disaggregate vehicle-level summary of compliance model results, 
providing a detailed view of the final state of each vehicle examined by the model, for each 
model year and scenario analyzed.  The report includes basic vehicle characteristics (such as 
vehicle code, manufacturer, engine and transmission used, curb weight, footprint, and sales 
volumes), fuel economy information (before and after the analysis), final technology utilization, 
and cost metrics associated with application of additional technology. 
 
The vehicle’s fuel economy ratings prior to the start of the analysis as well as at the end of each 
compliance model year are presented.  The fuel economy values are specified per fuel type 
(wherever applicable) in addition to an overall value, which used for compliance purposes.  For 
multi-fuel vehicles, the multiple fuel economy ratings are combined according to the statutory 
requirements.  For flex-fuel vehicles (those that operate on gasoline and ethanol-85), only the 
gasoline fuel economy rating is considered for compliance.  For plug-in hybrid/electric vehicles 
(PHEVs operating on gasoline and electricity), the overall fuel economy rating is harmonically 
averaged based on the share of each fuel type.  The vehicle’s fuel share indicates the amount of 
miles driven by the vehicle on each fuel type.  For vehicles operating on a single fuel (e.g., 
gasoline, diesel, or electricity), the fuel share for that fuel type only is specified.  For vehicles 
operating on multiple fuels (FFVs and PHEVs), the fuel shares are specified for gasoline and 
ethanol-85 or for gasoline and electricity. 
 
The Vehicles Report provides initial and final sales volumes as well as initial and final MSRPs.  
The initial sales and MSRP represent the starting values as obtained from the input file, and do 
not reflect changes associated with the modeling analysis.  The final sales volumes are specified 
by model year and will typically match the initial values, unless modeling options for sales 
mixing are selected (such as the Dynamic Fleet Share Model).  The final MSRPs are specified by 
model year as well, and incorporate additional costs arising from technology application or fine 
payment. 
 
Due to its size, the contents of the Vehicles Report are split among several tables.  Table 38, 
Table 39, Table 40, and Table 41 below list the full contents of the Vehicles Report. 
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Table 38. Vehicles Report (1) 
Column Units Contents 

Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action 
alternatives. 

Scenario Name text A short name describing the key features of the scenario. 

Model Year model 
year Model years analyzed during the study period. 

Manufacturer text Manufacturers analyzed during the study period. 
Veh Index integer Unique index assigned to each vehicle by the modeling system during runtime. 
Veh Code integer Index of the vehicle (unique per manufacturer), as read from the input file. 

Model text Vehicle model.  This field is used by the modeling system to group similar vehicles together when applying 
technologies from the "aerodynamics" group. 

Name Plate text Vehicle nameplate. 
Platform text Reserved for future use. 

Eng Code integer 
Index of the engine used by a vehicle.  If the modeling system splits an engine (due to different redesign 
schedules or other conflicts of multiple vehicles), the value in this field would show a new engine code, with 
the original in parentheses; for example: "12 (3)". 

Eng Fuel text Fuel used by the engine.  Available options are: G for gasoline, D for diesel, G+E85 for gasoline/ethanol-85 
flex fuel vehicles. 

Eng Type text Brief information about the engine, including engine configuration, number of cylinders, and engine 
displacement. 

Eng HP horse-
power Engine horsepower. 

Trn Code integer 
Index of the transmission used by a vehicle.  If the modeling system splits an transmission (due to different 
redesign schedules or other conflicts of multiple vehicles), the value in this field would show a new 
transmission code, with the original in parentheses; for example: "45 (6)". 

Trn Type text 
Brief information about the transmission, including the transmission type (A=automatic, M=manual, 
CVT=continuously variable transmission, AMT=automated manual transmission, DCT=dual-clutch 
transmission) and number of gears (if applicable). 
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Table 39. Vehicles Report (2) 
Column Units Contents 
FE Initial (Gas) 

mpg Vehicle's initial fuel economy rating when operating on a specific fuel type.  This represents the 
starting value as read from the input file. 

FE Initial (Dsl) 
FE Initial (E85) 
FE Initial (Elc) 
FE Initial (Hgn) 

FE Initial mpg 
Vehicle's overall initial fuel economy rating.  For FFVs (gasoline/ethanol-85), only the gasoline 
component is considered; for PHEVs (gasoline/electricity), the fuel economy rating is 
harmonically averaged based on the share of each fuel type. 

FS Initial (Gas) 

ratio Vehicle's initial fuel share, indicating the amount of miles driven by the vehicle on each fuel 
type.  This represents the starting value as read from the input file. 

FS Initial (Dsl) 
FS Initial (E85) 
FS Initial (Elc) 
FS Initial (Hgn) 

Fuel Initial text 
Fuel types initially used by the vehicle.  Available options are: G for gasoline, D for diesel, 
G+E85 for gasoline/ethanol-85 flex fuel vehicles, G+E for plug-in hybrid/electric vehicles, E for 
electric vehicles. 

FE (Gas) 

mpg 
Vehicle's fuel economy rating when operating on a specific fuel type, in a specific model year, 
taking into account the effect of technology additions made by the modeling system.  This value 
does not include adjustment for improvements in air conditioning or off-cycle credits. 

FE (Dsl) 
FE (E85) 
FE (Elc) 
FE (Hgn) 

FE mpg 

Vehicle's overall fuel economy rating in a specific model year, taking into account the effect of 
technology additions made by the modeling system.  For FFVs (gasoline/ethanol-85), only the 
gasoline component is considered; for PHEVs (gasoline/electricity), the fuel economy rating is 
harmonically averaged based on the share of each fuel type.  This value does not include 
adjustment for improvements in air conditioning or off-cycle credits. 

Delta FE AC (Gas) 

mpg Amount of fuel economy gain attributed to the adjustment for improvements in air conditioning 
for a specific fuel type, in a specific model year. 

Delta FE AC (Dsl) 
Delta FE AC (E85) 
Delta FE AC (Elc) 
Delta FE AC (Hgn) 

Delta FE AC mpg Overall amount of fuel economy gain attributed to the adjustment for improvements in air 
conditioning in a specific model year. 

Delta FE Off-Cycle (Gas) 

mpg Amount of fuel economy gain attributed to the off-cycle credits for a specific fuel type, in a 
specific model year. 

Delta FE Off-Cycle (Dsl) 
Delta FE Off-Cycle (E85) 
Delta FE Off-Cycle (Elc) 
Delta FE Off-Cycle (Hgn) 
Delta FE Off-Cycle mpg Overall amount of fuel economy gain attributed to the off-cycle credits in a specific model year. 
FE Adj (Gas) 

mpg 
Vehicle's fuel economy rating when operating on a specific fuel type, in a specific model year, 
taking into account the effect of technology additions made by the modeling system, adjusted for 
improvements in air conditioning and off-cycle credits. 

FE Adj (Dsl) 
FE Adj (E85) 
FE Adj (Elc) 
FE Adj (Hgn) 

FE Adj mpg 

Vehicle's overall fuel economy rating in a specific model year, taking into account the effect of 
technology additions made by the modeling system, adjusted for improvements in air 
conditioning and off-cycle credits.  For FFVs (gasoline/ethanol-85), only the gasoline component 
is considered; for PHEVs (gasoline/electricity), the fuel economy rating is harmonically averaged 
based on the share of each fuel type.  This value is used for compliance purposes. 

FS (Gas) 

ratio Vehicle's fuel share in a specific model year. 
FS (Dsl) 
FS (E85) 
FS (Elc) 
FS (Hgn) 

Fuel text 
Fuel types used by the vehicle in a specific model year.  Available options are: G for gasoline, D 
for diesel, G+E85 for gasoline/ethanol-85 flex fuel vehicles, G+E for plug-in hybrid/electric 
vehicles, E for electric vehicles. 
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Table 40. Vehicles Report (3) 
Column Units Contents 
Reg Class text Vehicle's regulatory class (DomesticAuto, ImprotedAuto, or LightTruck). 
Tech Class text Vehicle's technology class (used for technology selection and application). 
Mobile6 Class text Vehicle's Mobile6 class (used for some of the effects calculations). 

Safety Class text Vehicle's safety class (PC=Passenger Car, CM=CUV/Minivan, LT=Light Truck/SUV; used for safety 
calculations). 

Redesign State text 
Vehicle's redesign state, whether the vehicle is at redesign (being redesigned in the current model year) or 
"in shadow" of redesign (was redesigned within the past 4 years or will be redesigned within the next 4 
years). 

Refresh State text Vehicle's refresh state, whether the vehicle is at refresh (being refreshed in the current model year) or "in 
shadow" of refresh (was refreshed in the past year or will be refreshed in the next year). 

Sales Initial units Vehicle's production volumes in a specific model year.  This represents the starting value as read from the 
input file. 

Sales Final units 
Vehicle's final production volumes in a specific model year.  If modeling options for sales mixing are used 
(such as the Dynamic Fleet Share Model), this value will differ from the initial production volumes; 
otherwise, this value will be the same the initial one. 

MSRP Initial dollars Vehicle's initial MSRP value in a specific model year.  This represents the starting value as read from the 
input file. 

MSRP Final dollars Vehicle's final MSRP value in a specific model year, including additional costs arising from technology 
application or fine payment. 

k.Labor Hours hours 
(k) 

Thousands of employment hours associated with the production of the vehicle models in a specific model 
year. 

CW Initial lbs. Vehicle's initial curb weight.  This represents the starting value as read from the input file. 

CW Final lbs. Vehicle's final curb weight in a specific model year, taking into account any mass reduction technology 
applied by the modeling system. 

Footprint sq.ft. Vehicle's initial footprint.  This represents the starting value as read from the input file.  The vehicle's 
footprint does not change during the analysis. 

Tech Cost dollars Unit costs accumulated by the vehicle model from technology application in a specific model year. 

Price Increase dollars Increase in vehicle price accumulated by the vehicle model from technology application and fine payment 
in a specific model year. 

Tax Credit dollars   

Value Loss dollars Loss in value to the consumer due to decreased range of pure electric vehicles.  This value does not apply 
if the vehicle is not an EV. 

Rel. Value Loss dollars Relative loss in value to the consumer due to due to decreased operating life of pure electric vehicles.  This 
value does not apply if the vehicle is not an EV. 

Maint Cost dollars Unit maintenance costs accumulated by the vehicle model from technology application in a specific model 
year. 

Repair Cost dollars Unit repair costs accumulated by the vehicle model from technology application in a specific model year. 
Taxes/Fees dollars Taxes & fees paid by the consumers for purchasing a new vehicle model in a specific model year. 
Financing dollars Financing costs paid by the consumers for purchasing a new vehicle model in a specific model year. 
Insurance dollars Insurance costs paid by the consumers for purchasing a new vehicle model in a specific model year. 
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Table 41. Vehicles Report (4) 
Column Units Contents 
LUB1 

text 

The utilization of technologies on a vehicle model in a specific model year.  The following define the utilization 
codes used by the modeling system: 
  U = technology was initially in use on a base vehicle before modeling began 
  A = technology was applied to a vehicle by the modeling system 
  US = technology was in use on a base vehicle, but was later superseded when another technology was applied 
by the modeling system 
  AS = technology was applied to a vehicle by the modeling system, but was later superseded when another 
technology was applied 
  PA = technology has exceed its phase-in threshold in the current model year, however, it was still applied by 
the modeling system in order to satisfy backfilling constraints of another technology 
  P = technology has exceed its phase-in threshold in the current model year, and thus was not applied by the 
modeling system 
  X = technology is not available for application on a vehicle in the current model year 
  <blank> = technology is available for application on a vehicle in the current model year, but the modeling 
system has not yet applied it 

EFR1 
LUB2_EFR2 
CCPS 
DVVLS 
DEACS 
ICP 
DCP 
DVVLD 
CVVL 
DEACD 
SGDI 
DEACO 
VVA 
SGDIO 
TRBDS1_SD 
TRBDS1_MD 
TRBDS1_LD 
TRBDS2_SD 
TRBDS2_MD 
TRBDS2_LD 
CEGR1_SD 
CEGR1_MD 
CEGR1_LD 
CEGR2_SD 
CEGR2_MD 
CEGR2_LD 
ADSL_SD 
ADSL_MD 
ADSL_LD 
6MAN 

text (same as above) 

HETRANSM 
IATC 
NAUTO 
DCT 
8SPD 
HETRANS 
SHFTOPT 
EPS 

text (same as above) 

IACC1 
IACC2 
MHEV 
ISG 
SHEV1 
SHEV1_2 
SHEV2 
PHEV1 
PHEV2 
EV1 
EV2 
EV3 
EV4 
FCV 
MR1 

text (same as above) 

MR2 
MR3 
MR4 
MR5 
ROLL1 
ROLL2 
ROLL3 
LDB 
SAX 
AERO1 
AERO2 
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B.6 Optimization Report 
 
0 (below) discusses use of the model to estimate the “optimal” stringency of CAFE standards.  
This operating mode involves incrementally increasing the stringency of the standards over a 
specific range, and estimating corresponding costs, fuel savings, and benefits at each iteration.  
The Optimization Report contains functional coefficients and CAFE levels (required and 
achieved) for each iteration that was evaluated during optimization.  This output file also 
contains a brief snapshot of industry-wide results, per iteration, that aided the model in 
determining the optimum levels for each model year that was optimized.  The following table 
lists the contents of the Optimization Report. 
 

Table 42. Optimization Report 
Column Units Contents 

Model Year model 
year 

Model years analyzed during the study period.  Only the model years that were evaluated as part of 
optimization modeling are reported. 

Iteration integer Index of the optimization iteration (unique per model year). 

Is Optimal text A value of "Y" indicates if a specific iteration was selected as the optimal for a specific model year.  Each 
model year contains only one optimal solution. 

Coef-A mpg 

The value of the A- through H-coefficients of the functional form evaluated for a specific optimization 
iteration. 

Coef-B mpg 
Coef-C gpm 
Coef-D gpm 
Coef-E mpg 
Coef-F mpg 
Coef-G gpm 
Coef-H gpm 

Standard mpg The value of the required CAFE standard (resulting from corresponding functional form coefficients) 
evaluated for a specific optimization iteration. 

CAFE mpg The value of the achieved CAFE standard resulting from the functional form coefficients of a specific 
optimization iteration. 

Total Social Costs dollars 
(m) Total social costs resulting from the functional form coefficients of a specific optimization iteration. 

Total Social Benefits dollars 
(m) 

Total undiscounted social benefits resulting from the functional form coefficients of a specific optimization 
iteration. 

Disc Social Benefits dollars 
(m) 

Total discounted social benefits resulting from the functional form coefficients of a specific optimization 
iteration. 

Net Benefits (m$) dollars 
(m) 

Total net benefits (discounted social benefits - total social costs) resulting from the functional form 
coefficients of a specific optimization iteration. 

Fuel Savings (m-gal) gallons 
(m) Total fuel savings resulting from the functional form coefficients of a specific optimization iteration. 
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Appendix C “Optimization” of CAFE Standards 
 
The modeling system contains algorithms that may be used to “optimize” the average stringency 
(that is, the average required fuel economy) of an attribute-based system by estimating the 
stringency at which a given condition is met.  “Optimizing” the stringency, in the current 
modeling system, is done either by estimating the stringency level at which net societal benefits 
are maximized (maximum net benefits), or by finding the level where the absolute value of net 
benefits is minimized, after the maximum has occurred (total cost equals total benefits).30  
Optimization of CAFE Standards may be set up and run using directions provided in Appendix E 
below. 
 
Using the functional form defined in the scenarios file, the optimized stringency for either the 
passenger car or light truck fleet is determined for the entire industry, and for each year, by 
adjusting the entire function at a user-specified increment, for a given number of iterations above 
and below the initial shape.31  To ensure the correct “carry-over” of technology costs and 
improvements, the model years are optimized sequentially.  At the end of each model year, the 
system re-runs the entire passenger car or light truck fleet using the optimized stringency, then 
carries the costs and improvements into the next year. 
 
With the varying functional form, the stringency is slightly altered between new iterations (or 
trials).  As the system examines each trial, it performs typical compliance modeling.  At the end 
of each iteration, the model calculates and saves the final incremental technology costs, 
discounted social benefits, fuel savings, and net benefits for each manufacturer and industry 
overall.  Once all iterations have been processed, the modeling system calculates the stringency 
by finding the first iteration that satisfies the net-benefit-maximizing or absolute-value-of-net-
benefit-minimizing criterion. 
 
Below, Figure 8 illustrates how the model maximizes net benefits.  The plot on the left shows 
curves specifying fuel economy targets for three iterations (i.e., stringency levels) examined 
under a sample optimization.  For each of these iterations, colored points in the plot on the right 
show the corresponding stringency (in terms of average required fuel economy) and the 
calculated net benefits (in $m).  The black line in the plot on the right shows stringency and net 
benefits for all other iterations included in the optimization.  In this example, the least stringent 
of the three highlighted iterations, shown in red, produces net benefits of about $2,700m at a 
stringency of 31.2 mpg.  As stringency increases, net benefits reach a peak or maximum, shown 
in green, of about $3,100m at a stringency of 31.7 mpg.  The corresponding curve is shown in 
green in the plot on the left.  As stringency increases beyond this point, more expensive 

                                                 
30 Use of the term “optimize” was first applied in this model in reference to the concept of estimating the “socially 
optimal” stringency—that is, the stringency producing the greatest increase in benefits relative to the increase in 
costs, where both benefits and costs are measured on a societal basis, excluding economic transfers such as fuel 
taxes and civil penalties.  This approach involves maximizing net benefits.  Considering public comments, NHTSA 
also required the availability to examine stringencies at which total costs equal total benefits (or, within the scope of 
available technologies, most nearly equal).  As currently used, the term “optimize” refers to either approach. 
31 The model currently optimizes stringency for only one fleet (i.e., passenger car or light truck) in a single model 
run.   
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technologies are required, such that net benefits decrease.  By the point stringency reaches 31.2 
mpg, shown in blue, net benefits fall to about $2,800m. 
 

            
Figure 8. Maximizing Net Benefits 

 
This example also illustrates a scenario in which net benefits stop decreasing before total costs 
equal total benefits (when total costs equal total benefits, net benefits equal zero).  In this 
example, all available technologies are exhausted when stringency reaches 32.5 mpg, at which 
point net benefits are about $500m. Once technologies are exhausted, no additional cost or 
benefits will be realized – the manufacturer’s fleet will remain static. Above this stringency, civil 
penalties are incurred.  However, as economic transfers, civil penalties are not counted as costs 
to society.  Therefore, net benefits do not change as stringency increases beyond 32.5 mpg. 
 
The last step of the modeling process is to use the optimized standard (i.e., the standard defined 
by the user-specified shape and then shifted vertically by the model to produce the optimized 
stringency) to obtain the corresponding fleet (i.e., the fleet that reflects estimated manufacturer 
responses at the optimized stringency) for the model year.  As under regular (i.e., non-
optimizing) modeling exercises, this step is necessary to properly carry over added technologies 
from one model year to the next. 
 
As originally designed, the model only performed optimization by accounting for each 
manufacturer separately, and then using the industry-wide sum of manufacturer-specific results 
to estimate optimal stringency.  In the current version, the model also provides an optional 
setting to merge the fleet (i.e., combine the vehicles of all individual manufacturers into a single 
group) throughout the optimization process.  As explained below, under some circumstances, 
this option can provide more stable optima than when accounting for each manufacturer 
separately.  The effect of this setting is illustrated below for a hypothetical fleet involving two 
manufacturers:  “OEM1,” a “laggard” which produces a fleet of vehicles with generally low 
baseline fuel economy relative to fuel economy targets; and “OEM2,” a “front runner” which 
produces a fleet of vehicles with generally high baseline fuel economy relative to fuel economy 
targets. Typically, a manufacturer with a “laggard” fleet will experience application of 
technologies to its fleet at a lower stringency than that of a manufacturer with a more fuel 
efficient fleet. This will result in a different shape net benefits curve, as well as a different 
placement of the peak of maximum net benefits. 
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Below, Figure 9 shows net benefits (attributable separately to OEM1 and OEM2) on the y axis, 
with stringency (in terms of the average required fuel economy) on the x axis.  As stringency 
increases (moving from left to right on the chart), OEM1, shown in orange, begins to be 
impacted by new standards when the average stringency (i.e., the average fuel economy required 
of the industry) reaches 29.0 mpg.32  For OEM1, net benefits increase as stringency increases 
past 29.0 mpg, peak when stringency reaches 31.9 mpg, decline as stringency continues to 
increase, and stabilize when stringency increases beyond past 32.8 mpg, at which point OEM1 
exhausts all available technology applications.  For OEM2, shown in blue, net benefits do not 
begin to increase until stringency increases past 34.3 mpg.  Subsequently, net benefits 
attributable to OEM2 peak when stringency reaches 40.1 mpg, decline as stringency continues to 
increase, and stabilize when stringency increases beyond past 41.2 mpg, at which point OEM2 
exhausts all available technology applications. 
 

 
Figure 9. Net Benefits versus Stringency for Hypothetical 2-Manufacturer Fleet 

 
Figure 10 shows the corresponding total net benefits for the industry (i.e., the sum of net benefits 
attributable to both OEM1 and OEM2) as a dashed line superimposed on the net benefits 
attributable separately to OEM1 and OEM2.  In this example, the significant difference between 
OEM1 and OEM2 in terms of baseline performance as compared to targets causes the total net 
benefits for the industry to exhibit two distinct peaks, one at 32.8 mpg and one at 40.1 mpg.  

                                                 
32 At stringencies of about 29.0-30.2 mpg, net benefits attributable to OEM1 are negative.  This indicates the market 
forecast for OEM1 fell short of the baseline standards, and that for OEM1, standards of 29.0-30.2 mpg (again, in 
terms of average fuel economy required of the industry) would require technology beyond that required under the 
market forecast for OEM1, but not as much as would be required under the baseline standards. 

-4,000

-3,000

-2,000

-1,000

0

1,000

2,000

3,000

4,000

28 29 30 31 32 33 34 35 36 37 38 39 40 41 42

N
et

 B
en

ef
its

 ($
m

; O
E

M
1,

 O
E

M
2,

 O
E

M
1 

+ 
O

E
M

2)

Average Required Fuel Economy (mpg)

OEM1 OEM2



 

81 

Below 34.3 mpg, OEM2 is unaffected, such that results for OEM1 account for all of the net 
benefits for the industry.  Above 34.3 mpg, the net benefits attributable to OEM2 are augmented 
by approximately $500m in net benefits attributable to OEM1 once OEM1 has exhausted 
available technologies (at 32.8 mpg).33  In this example, relative sales volumes are such that the 
“OEM2 peak” at 40.1 mpg is dominant.  However, if OEM1’s market share had been somewhat 
greater than in this example, the “OEM1” peak at 32.8 mpg would have been dominant. 
 

 
Figure 10. Sum of Net Benefits Attributable to OEM1 and OEM2 

 
For the same hypothetical fleet, Figure 11 demonstrates the effect of selecting the “merged fleet” 
setting when running the model.  With distinctions between OEM1 and OEM2 removed, the 
baseline average fuel economy of the merged fleet exceed are 30.2 mpg and technologies are not 
required until average stringency reaches 30.3 mpg. This higher average fuel economy is because 
the relatively high performance of OEM2’s fleet balances the relatively low performance of 
OEM1’s fleet.  Net benefits subsequently increase, peak at 33.8 mpg, and then decline (except 
for a slight secondary peak at 34.2 mpg) until all technology options are exhausted when 
stringency reaches 34.4 mpg. 
 

                                                 
33 If a manufacturer exhausts available technologies without achieving compliance with a given standard, the model 
calculates the resultant civil penalties.  However, because civil penalties are economic transfers, the model does not 
add these to estimated costs; therefore, the plot of net benefits attributed to an individual manufacturer becomes flat 
at stringencies beyond the point where the manufacturer exhausts available technology options. 
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Figure 11. Net Benefits for Hypothetical Merged Fleet 

 
Figure 12 compares the net benefits obtained with the merged fleet to those obtained for the 
underlying individual manufacturers, and for the industry as represented maintaining the 
distinction between the two manufacturers.  Without merging the fleet, the model obtains a net 
benefits plot that has two widely separated peaks.  Because the relative heights of these peaks 
could be impacted differently by relatively modest changes in model inputs (including 
manufacturers’ market shares and sometimes other inputs), these widely separated peaks lead to 
unstable (albeit correctly calculated) results.  For example, relatively modest changes in model 
inputs such as manufacturer sales volumes or economic factors (e.g., discount rate, rebound 
effect, fuel price) can change which peak is dominant, thereby causing a significant change in 
estimated optimized stringency.  The merged fleet produces a much more stable peak that falls 
between the two peaks obtained without applying this option. 
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Figure 12. Comparison of Net Benefits with and without Merging of Fleet 

 
  

0

2,000

4,000

6,000

8,000

10,000

12,000

-4,000

-3,000

-2,000

-1,000

0

1,000

2,000

3,000

4,000

28 29 30 31 32 33 34 35 36 37 38 39 40 41 42

N
et

 B
en

ef
its

 ($
m

; M
er

ge
d 

Fl
ee

t)

N
et

 B
en

ef
its

 ($
m

; O
E

M
1,

 O
E

M
2,

 O
E

M
1 

+ 
O

E
M

2)

Average Required Fuel Economy (mpg)

OEM1
OEM2
OEM1 + OEM2
Merged Fleet



 

84 

Appendix D Monte Carlo Analysis 
 
Probabilistic uncertainty analysis (for example, Monte-Carlo simulation) may be performed, 
such that all included scenarios are examined under varying technology costs and fuel 
consumption effects, pretax fuel prices, post-compliance payback periods, rebound effect, price 
shock costs, and mileage schedules.  Monte-Carlo analysis may be set up and run using 
directions provided in the CAFE Model Software Manual document.  While the modeling system 
could potentially be set up to analyze multiple alternative scenarios within a single run, given the 
resource restrictions associated with multiyear modeling, as well as time constraints placed on 
the development of the CAFE Model, at present the system only supports one alternative 
scenario per individual run.  Multiple modeling instances, however, may be set up to evaluate 
additional alternatives. 
 
The results of the analysis are located in the output folder selected during modeling.  During 
Monte-Carlo simulation, the CSV outputs that are typically produced with regular compliance or 
optimization modeling are not generated.  Instead, plain text Monte-Carlo log files can be found 
under the “MC-logs” subdirectory.  As with regular modeling runs, however, the per-scenario 
logs are numbered in order of appearance, starting at 0, with the first scenario (Sn0) being the 
baseline to which all others are compared.  The following files are generated at the end of the 
Monte-Carlo simulation: 

• MC_trials.csv:  Contains Monte-Carlo trials used as input to the analysis.  The contents 
of this file are summarized in Table 43 below. 

• MC_tech_costs.csv:  Specifies the sales-weighted average technology costs for each 
technology, adjusted by the randomized cost scales from the MC_trials.csv file. The 
average costs for a technology are computed across all vehicle technology classes that 
were used during modeling as follows:  
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where SALESi represent the sales of vehicle i, COSTi,t is the base (unadjusted) cost of 
technology t as it applies to vehicle i, and SCALEt is the randomized value specifying the 
amount by which to scale the technology cost of technology t. 

• MC_tech_fcs.csv:  Specifies the sales-weighted average technology fuel consumption 
improvements for each technology, adjusted by the randomized fuel consumption scales 
from the MC_trials.csv file. The average fuel consumption improvements for a 
technology are computed across all vehicle technology classes that were used during 
modeling as follows:  
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where SALESi represent the sales of vehicle i, FCi,t is the base (unadjusted) fuel 
consumption improvement of technology t as it applies to vehicle i, and SCALEt is the 
randomized value specifying the amount by which to scale the technology fuel 
consumption improvement of technology t. 

• MC_Sn*_data.csv:  Includes the results of pseudo-randomly generated Monte-Carlo 
trials for all scenarios.  The log file for the results of the baseline scenario (Sn0) provides 
the totals accrued during that scenario.  The log file for the results of the non-baseline 
scenario (Sn1) contains changes compared to the baseline.  The contents of the file are 
summarized in Table 46 below. 

 
D.1 Monte-Carlo Input Sampling 
 
In the previous versions of the CAFE Model, the sampling of trials for Monte-Carlo analysis was 
performed internally by the modeling system.  With the current revision, the Monte-Carlo trials 
are generated externally and are fed into the system in the form of an input file.  The “MC trials” 
file is provided as part of the current rulemaking analysis, and may be obtained to perform 
additional modeling by users.  Alternatively, users wishing to experiment with various 
distributions and sampling techniques may generate their own trials, provided the resulting input 
file is congruent with the original used for the analysis.  The sampling procedure employed for 
generating the Monte-Carlo trials is outlined below. 
 
The CAFE model requires entries for each of the variables in Table 43 (below) for every trial, as 
well as the set of input files necessary to produce a normal run (i.e., those specifying technology 
and fleet inputs, economic assumptions, regulatory scenarios, etc.).  For the “MC trials” file that 
was used in the final analysis of the 2017–2025 CAFE program, a number of different 
distributions and technology groupings were used to produce the set of trials.  A detailed 
description of the distributions used and the technology groups can be found in chapter XII of the 
NHTSA Regulatory Impact Analysis for the 2017–2025 CAFE standards. 
 

Table 43. Monte-Carlo Input Data 
Column Contents 
Index Unique index of the trial. 

FleetShare Additional constant sampled from the distribution of residuals in the statistical relationship 
that defines the Dynamic Fleet Share Model and dynamically adjusts the PC/LT fleet share. 

FuelPriceEstimates Seed value to use for calculating the fuel prices. 

PaybackPeriod_OC Randomized value of the post-compliance payback period that manufacturers use with 
voluntary overcompliance. 

ReboundEffect Randomized value of the rebound effect. 
PriceShockCost Randomized value of the price shock cost. 

MilesCars0 Randomly sampled seed value for the annual miles driven by passenger automobiles in "age 
0", where the VMT for the remaining ages will be computed from this seed. 

MilesAllLTs0 
Randomly sampled seed value for the annual miles driven by all light trucks (vans, SUVs, 
and pickups) in "age 0", where the VMT for the remaining ages will be computed from this 
seed. 

Cost_[Technology] Randomized value specifying the amount by which to scale the technology costs for each 
technology. 

FC_[Technology] Randomized value specifying the amount by which to scale the technology fuel consumption 
improvement for each technology. 

 
The FleetShare uncertainty is sampled from the distribution of residuals of an empirical model 
that estimates the share of new passenger cars as a function of fuel prices and other factors. The 
residuals themselves are small and approximately normally distributed about zero.  Users who 
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wish to omit this variable should simply substitute a value of zero in each run, or draw random 
samples from the trials file used in the analysis of the final rule.  The FuelPriceEstimates variable 
is drawn from a uniform distribution on [0, 1].  Each unique draw is used by the CAFE model to 
generate a time series of fuel prices for that trial.  The PaybackPeriod_OC is drawn from a 
Poisson distribution with a lambda value of 0.85.  The CAFE model expects discrete (rather than 
continuous) values for this variable, so users should either use discrete distributions or modify 
their samples accordingly.  The ReboundEffect is sampled from a beta distribution, then rescaled 
and shifted to produce values that are non-positive, and between 0 and -0.35. The 
PriceShockCost is drawn from a normal distribution intended to represent the range of values 
produced by Paul Leiby of the Oak Ridge National Laboratory. The midpoint of the range 
represents the mean of the normal distribution, and each endpoint is two standard deviations 
away from the mean.  The two mileage accumulation variables (MilesCars0 and MilesAllLTs0) 
are smapled from normal distributions with means of 13,215 and 14,757, and standard deviations 
of 108 miles and 129 miles, respectively34. 
 
Technology costs and effectiveness are sampled in groups, though not the same groups. It is also 
the case that technologies within a single group may have different cost distributions, although 
the grouping ensures that all technologies within a group are at similar quantiles of their 
respective distributions.  Table 44 shows the unique cost distribution associated with each 
technology, as well as the group in which it is sampled for the Monte Carlo draws. In order to 
create the values that are passed to the CAFE model, a randomly sampled quantile (essentially 
just a uniform random number between zero and one) is generated for each group, for each draw. 
Then each of these is transformed by taking the value at the corresponding quantile of the beta 
distribution associated with each cost uncertainty. That value is then scaled by the width of the 
range between the “low index” and “high index”, and then shifted by adding the “low index”. 
These transformed values are then passed to the CAFE model, which treats them as scalars on 
the value of the technology cost in the technologies input file. The quantile of each beta 
distribution is the same for every group, for every draw, but the actual values passed to the 
model vary based on the shape of the underlying beta distribution specific to each technology. 
 

Table 44. Technology Cost Sampling Groups and Distributions 

Technology 
Tech 

Group 

Beta Parameters Index Values 
α Shape 

Parameter 
β Shape 

Parameter 
Low 

Index 
Mode 
Index 

High 
Index 

Low Friction Lubricants - Level 1 1 1.8 3.14 0.6806 1 1.8484 
Engine Friction Reduction - Level 1 1 1.8 3.14 0.9619 1 1.1013 
Low Friction Lubricants and Engine Friction Reduction - Level 2 1 1.8 3.14 0.8726 1 1.3384 
Variable Valve Timing (VVT) - Coupled Cam Phasing (CCP) on SOHC 1 1.8 3.14 0.9046 1 1.2533 
Discrete Variable Valve Lift (DVVL) on SOHC 1 1.8 3.14 0.811 1 1.502 
Cylinder Deactivation on SOHC 1 1.8 3.14 -2.287 1 9.7305 
Variable Valve Timing (VVT) - Intake Cam Phasing (ICP) 1 1.8 3.14 0.9046 1 1.2533 
Variable Valve Timing (VVT) - Dual Cam Phasing (DCP) 1 1.8 3.14 0.8713 1 1.3418 
Discrete Variable Valve Lift (DVVL) on DOHC 1 1.8 3.14 0.811 1 1.502 
Continuously Variable Valve Lift (CVVL) 1 1.8 3.14 0.9378 1 1.1653 
Cylinder Deactivation on DOHC 1 1.8 3.14 -2.287 1 9.7305 
Stoichiometric Gasoline Direct Injection (GDI) 1 1.8 3.14 0.8767 1 1.3274 
Cylinder Deactivation on OHV 1 1.8 3.14 0.5069 1 2.3098 
Variable Valve Actuation - CCP and DVVL on OHV 1 1.8 3.14 0.9809 1 1.0508 

                                                 
34 The sample used in the final rule includes a process that averages in the usage characteristics of new fleet 
vehicles, which are typically used more intensively than household vehicles. Entries for the two l=mileage varibales 
in the trials will differ from the distributions described above for this reason. 
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Stoichiometric Gasoline Direct Injection (GDI) on OHV 1 3.14 1.8 0.793 1 1.0779 
Turbocharging and Downsizing - Level 1 (18 bar BMEP) - SD 2 3.14 1.8 0.7632 1 1.0892 
Turbocharging and Downsizing - Level 1 (18 bar BMEP) - MD 2 3.14 1.8 -10.82 1 5.451 
Turbocharging and Downsizing - Level 1 (18 bar BMEP) - LD 2 3.14 1.8 0.8452 1 1.0583 
Turbocharging and Downsizing - Level 2 (24 bar BMEP) - SD 2 1.8 3.14 0.536 1 2.2327 
Turbocharging and Downsizing - Level 2 (24 bar BMEP) - MD 2 1.8 3.14 0.8767 1 1.3274 
Turbocharging and Downsizing - Level 2 (24 bar BMEP) - LD 2 1.8 3.14 0.8767 1 1.3274 
Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) - SD 2 1.8 3.14 0.8767 1 1.3274 
Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) - MD 2 1.8 3.14 0.8767 1 1.3274 
Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) - LD 2 1.8 3.14 0.8767 1 1.3274 
Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) - SD 2 1.8 3.14 0.8909 1 1.2898 
Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) - MD 2 1.8 3.14 0.8909 1 1.2898 
Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) - LD 2 3.14 1.8 1.1501 1 0.9435 
Advanced Diesel - Small Displacement 2 1.8 3.14 0.9404 1 1.1584 
Advanced Diesel - Medium Displacement 2 3.14 1.8 0.9899 1 1.0038 
Advanced Diesel - Large Displacement 2 1.8 3.14 0.9658 1 1.0909 
6-Speed Manual/Improved Internals 3 1.8 3.14 0.8415 1 1.4209 
High Efficiency Gearbox (Manual) 3 1.8 3.14 0.8726 1 1.3384 
Improved Auto. Trans. Controls/Externals 3 1.8 3.14 0.8415 1 1.4209 
6-Speed Trans with Improved Internals (Auto) 3 1.8 3.14 4.6303 1 -8.6431 
6-speed DCT 3 3.14 1.8 1.0138 1 0.9948 
8-Speed Trans (Auto or DCT) 3 1.8 3.14 0.8767 1 1.3274 
High Efficiency Gearbox (Auto or DCT) 3 1.8 3.14 0.8726 1 1.3384 
Shift Optimizer 3 1.8 3.14 0.8726 1 1.3384 
Electric Power Steering 4 1.8 3.14 0.7987 1 1.5348 
Improved Accessories - Level 1 4 1.8 3.14 0.7698 1 1.6115 
Improved Accessories - Level 2  4 3.14 1.8 0.9813 1 1.0071 
12V Micro-Hybrid (Stop-Start) 4 1.8 3.14 0.3081 1 2.8379 
Integrated Starter Generator 5 1.8 3.14 0.7295 1 1.7185 
Strong Hybrid - Level 1 5 3.14 1.8 -0.801 1 1.6782 
Conversion from SHEV1 to SHEV2 5 1.8 3.14 0.8805 1 1.3174 
Strong Hybrid - Level 2 5 3.14 1.8 -0.757 1 1.6616 
Plug-in Hybrid - 30 mi range 5 3.14 1.8 0.5384 1 1.1738 
Plug-in Hybrid             
Electric Vehicle (Early Adopter) - 75 mile range 5 3.14 1.8 1 1 1 
Electric Vehicle (Early Adopter) - 100 mile range             
Electric Vehicle (Early Adopter) - 150 mile range             
Electric Vehicle (Broad Market) - 150 mile range 5 3.14 1.8 1 1 1 
Fuel Cell Vehicle             
Mass Reduction - Level 1 6 1.8 3.14 -15.01 1 43.521 
Mass Reduction - Level 2 6 1.8 3.14 -1.276 1 7.0453 
Mass Reduction - Level 3 6 1.8 3.14 0.0199 1 3.6035 
Mass Reduction - Level 4 6 1.8 3.14 0.5377 1 2.2279 
Mass Reduction - Level 5 6 1.8 3.14 0.711 1 1.7676 
Low Rolling Resistance Tires - Level 1 1 1.8 3.14 -0.45 1 4.8517 
Low Rolling Resistance Tires - Level 2 1 3.14 1.8 0.7204 1 1.1053 
Low Rolling Resistance Tires - Level 3             
Low Drag Brakes 1 1.8 3.14 0.8726 1 1.3384 
Secondary Axle Disconnect 1 1.8 3.14 0.8415 1 1.4209 
Aero Drag Reduction, Level 1 1 1.8 3.14 0.7502 1 1.6636 
Aero Drag Reduction, Level 2 6 1.8 3.14 0.7977 1 1.5373 

 
The uncertainty for technology effectiveness is sampled in a similar way to the cost uncertainty, 
with the only significant difference being the introduction of multiple types of distributions. 
While all of the cost uncertainties are described by beta distributions (of several shapes), 
effectiveness uses both beta and normal distributions. The beta distributions are sampled (and 
translated) in the same manner described above, while the normal distributions are sampled in a 
less complicated way. Each draw merely uses the sampled value of the group’s quantile (a 
uniform random number between zero and one) to select an appropriate value from the normal 
distribution (i.e., the one occurs at that quantile). Table 45 describes the grouping scheme 
associated with the incremental improvement from adding new fuel economy technology, as well 
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as the probability distributions associated with the amount of improvement achieved by the 
additional of each technology. 
 

Table 45. Technology Effectiveness Sampling Groups and Distributions 

Technology 
Tech 

Group 
Distribution 

Type 

Normal Dist 
Parameters Beta Parameters Index Values 
Std Dev (in 
0:1 range) 

α Shape 
Parameter 

β Shape 
Parameter 

Low 
Index 

Mode 
Index 

High 
Index 

Low Friction Lubricants - Level 1 1 Beta   1.2 1.0549956 0.6623 1 1.09285 
Engine Friction Reduction - Level 1 1 Beta   1.2 1.0549956 0.4877 1 1.14087 
Low Friction Lubricants and Engine Friction Reduction - Level 2 1 Beta   1.1 1.4108074 0.7598 1 1.98687 
Variable Valve Timing (VVT) - Coupled Cam Phasing (CCP) on SOHC 1 Normal 0.145           
Discrete Variable Valve Lift (DVVL) on SOHC 1 Normal 0.29           
Cylinder Deactivation on SOHC 1 Normal 0.29           
Variable Valve Timing (VVT) - Intake Cam Phasing (ICP) 1 Normal 0.145           
Variable Valve Timing (VVT) - Dual Cam Phasing (DCP) 1 Normal 0.29           
Discrete Variable Valve Lift (DVVL) on DOHC 1 Normal 0.29           
Continuously Variable Valve Lift (CVVL) 1 Normal 0.29           
Cylinder Deactivation on DOHC 1 Normal 0.29           
Stoichiometric Gasoline Direct Injection (GDI) 1 Normal 0.29           
Cylinder Deactivation on OHV 1 Normal 0.29           
Variable Valve Actuation - CCP and DVVL on OHV 1 Normal 0.29           
Stoichiometric Gasoline Direct Injection (GDI) on OHV 1 Normal 0.29           
Turbocharging and Downsizing - Level 1 (18 bar BMEP) - SD 2 Normal 0.29           
Turbocharging and Downsizing - Level 1 (18 bar BMEP) - MD 2 Normal 0.29           
Turbocharging and Downsizing - Level 1 (18 bar BMEP) - LD 2 Normal 0.29           
Turbocharging and Downsizing - Level 2 (24 bar BMEP) - SD 2 Normal 0.29           
Turbocharging and Downsizing - Level 2 (24 bar BMEP) - MD 2 Normal 0.29           
Turbocharging and Downsizing - Level 2 (24 bar BMEP) - LD 2 Normal 0.29           
Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) - SD 2 Normal 0.29           
Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) - MD 2 Normal 0.29           
Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) - LD 2 Normal 0.29           
Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) - SD 2 Normal 0.29           
Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) - MD 2 Normal 0.29           
Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) - LD 2 Normal 0.29           
Advanced Diesel - Small Displacement 2 Beta   1.1 1.4108074 0.746 1 2.04325 
Advanced Diesel - Medium Displacement 2 Beta   1.1 1.4108074 0.746 1 2.04325 
Advanced Diesel - Large Displacement 2 Beta   1.1 1.4108074 0.8831 1 1.48027 
6-Speed Manual/Improved Internals 3 Normal 0.145           
High Efficiency Gearbox (Manual) 3 Normal 0.145           
Improved Auto. Trans. Controls/Externals 3 Normal 0.145           
6-Speed Trans with Improved Internals (Auto) 3 Normal 0.145           
6-speed DCT 3 Normal 0.29           
8-Speed Trans (Auto or DCT) 3 Normal 0.29           
High Efficiency Gearbox (Auto or DCT) 3 Normal 0.145           
Shift Optimizer 3 Normal 0.145           
Electric Power Steering 3 Beta   1.1 1.4108074 0.8248 1 1.71969 
Improved Accessories - Level 1 3 Beta   1.2 1.0549956 0.7284 1 1.07468 
Improved Accessories - Level 2  3 Beta   1.2 1.0549956 0.1343 1 1.23804 
12V Micro-Hybrid (Stop-Start) 3 Beta   1.1 1.4108074 0.8387 1 1.66283 
Integrated Starter Generator 4 Beta   1.1 1.4108074 0.9138 1 1.35425 
Strong Hybrid - Level 1 4 Beta   1.2 1.0549956 -0.5208 1 1.4182 
Conversion from SHEV1 to SHEV2 4 Beta   1.1 1.4108074 0.9069 1 1.38236 
Strong Hybrid - Level 2 4 Beta   1.2 1.0549956 -2.9104 1 2.07527 
Plug-in Hybrid - 30 mi range 4 Normal 0.435           
Plug-in Hybrid                 
Electric Vehicle (Early Adopter) - 75 mile range 4   0.435           
Electric Vehicle (Early Adopter) - 100 mile range                 
Electric Vehicle (Early Adopter) - 150 mile range                 
Electric Vehicle (Broad Market) - 150 mile range 4   0.435           
Fuel Cell Vehicle                 
Mass Reduction - Level 1 3 Normal 0.145           
Mass Reduction - Level 2 3 Normal 0.145           
Mass Reduction - Level 3   Normal 0.145           
Mass Reduction - Level 4   Normal 0.29           
Mass Reduction - Level 5   Normal 0.29           
Low Rolling Resistance Tires - Level 1 1 Beta   1.1 1.4108074 0.9353 1 1.26581 
Low Rolling Resistance Tires - Level 2 1 Beta   1.2 1.0549956 0.7836 1 1.05949 
Low Rolling Resistance Tires - Level 3                 
Low Drag Brakes 1 Beta   1.1 1.4108074 0.8938 1 1.43641 
Secondary Axle Disconnect 1 Normal 0.145           
Aero Drag Reduction, Level 1 1 Beta   1.2 1.0549956 0.5676 1 1.11891 
Aero Drag Reduction, Level 2 3 Beta   1.1 1.4108074 0.8794 1 1.49534 

 
D.2 Monte-Carlo Output Data 
 
The modeling system produced two data outputs as part of the Monte-Carlo analysis:  
MC_Sn0_data.csv and MC_Sn1_data.csv.  The former contains results of the baseline scenario 
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(Sn0), which are specified as the totals accrued during analysis of the baseline, while the latter 
contains results of the alternative scenario (Sn1), which are presented as incremental changes 
over the baseline.  In both output files, results are provided for each model year analyzed (where 
the years span multiple columns), separated into the PC and the LT fleets (according to the 
regulatory classification of vehicles), as well as aggregated across the entire industry (combining 
PC and LT fleets).  Some of the outputs reported do not apply to the baseline scenario.  In 
particular, since the “net benefits” and the “benefit:cost ratios” are the direct results of 
improvements realized in the alternative scenario over the baseline scenario, these values would 
appear as “0” in the baseline’s output file (MC_Sn0_data.csv). 
 
The following table lists the full contents of the Monte-Carlo Output Data file. 
 

Table 46. Monte-Carlo Output Data 
Column Contents 
Index Unique index of the trial. 
Sales_PC_[MY] Total sales volumes for the PC fleet in each model year. 
Sales_LT_[MY] Total sales volumes for the LT fleet in each model year. 
Sales_[MY] Total sales volumes for the entire industry (PC and LT fleets) in each model year. 

PCShare_[MY] 
Passenger automobile share of the total industry sales.  The PC shares presented in the outputs are 
computed based on the regulatory classification of vehicles.  Conversely, for the Dynamic Fleet Share 
Model, the modeling system computes PC shares based on the style of the vehicles. 

TechCosts_PC_[MY] Total technology costs accumulated by the PC fleet in each model year. 
TechCosts_LT_[MY] Total technology costs accumulated by the LT fleet in each model year. 
TechCosts_[MY] Total technology costs accumulated by the entire industry (PC and LT fleets) in each model year. 
Fines_PC_[MY] Total fines owed resulting from undercompliance by the PC fleet in each model year. 
Fines_LT_[MY] Total fines owed resulting from undercompliance by the LT fleet in each model year. 

Fines_[MY] Total fines owed resulting from undercompliance by the entire industry (PC and LT fleets) in each model 
year. 

SocialCosts_PC_[MY] Total social costs accumulated by the PC fleet in each model year. 
SocialCosts_LT_[MY] Total social costs accumulated by the LT fleet in each model year. 
SocialCosts_[MY] Total social costs accumulated by the entire industry (PC and LT fleets) in each model year. 
SocialBenefits_PC_[MY] Discounted social benefits accumulated by the PC fleet in each model year. 
SocialBenefits_LT_[MY] Discounted social benefits accumulated by the LT fleet in each model year. 
SocialBenefits_[MY] Discounted social benefits accumulated by the entire industry (PC and LT fleets) in each model year. 
NetBenefits_PC_[MY] Net benefits attributed to the PC fleet in each model year. 
NetBenefits_LT_[MY] Net benefits attributed to the LT fleet in each model year. 
NetBenefits_[MY] Net benefits attributed to the entire industry (PC and LT fleets) in each model year. 
AdditionalVMT_PC_[MY] Total additional vehicle miles traveled by the PC fleet in each model year. 
AdditionalVMT_LT_[MY] Total additional vehicle miles traveled by the LT fleet in each model year. 
AdditionalVMT_[MY] Total additional vehicle miles traveled by the entire industry (PC and LT fleets) in each model year. 
FuelSavings_PC_[MY] Fuel savings (in dollars) accumulated by the PC fleet in each model year. 
FuelSavings_LT_[MY] Fuel savings (in dollars) accumulated by the LT fleet in each model year. 
FuelSavings_[MY] Fuel savings (in dollars) accumulated by the entire industry (PC and LT fleets) in each model year. 
FuelSavingsGal_PC_[MY] Fuel savings (in gallons) accumulated by the PC fleet in each model year. 
FuelSavingsGal_LT_[MY] Fuel savings (in gallons) accumulated by the LT fleet in each model year. 
FuelSavingsGal_[MY] Fuel savings (in gallons) accumulated by the entire industry (PC and LT fleets) in each model year. 
BCRatio_PC_[MY] Ratio of social benefits to total technology costs for the PC fleet in each model year. 
BCRatio_LT_[MY] Ratio of social benefits to total technology costs for the LT fleet in each model year. 

BCRatio_[MY] Ratio of social benefits to total technology costs for the entire indusry (PC and LT fleets) in each model 
year. 

 
  



 

90 

Appendix E CAFE Model Software Manual 
 
E.1 Warnings 
 
This software was developed for analysis by U.S. Department of Transportation staff of potential 
fuel economy requirements. 
 
This software uses input files containing detailed information regarding vehicles manufactured 
for sale in the United States and creates output files containing similarly detailed information 
regarding such vehicles.  If input files containing information in any way (e.g., based on 
entitlement under 5 U.S.C 552 to confidential treatment) protected from disclosure to the public 
are used, some output files created by this software must also be protected from disclosure to the 
public. 
 
E.2 Notice 
 
The CAFE Model software is a U.S. government work not subject to copyright pursuant to 17 
USC 105; however, some of the third-party works used by the software are subject to usage 
agreements, as described below. 
 
The button controls in the application toolbar of the CAFE Model use images from the Glaze 
Icon Set (version 0.4.6, released on 3/06/2006) obtained from http://www.notmart.org.  All icons 
and/or images within the Glaze Icon Set are distributed under the GNU Lesser General Public 
License (LGPL), version 2.1.  The version 2.1 of the GNU LGPL may be obtained 
from http://www.gnu.org/licenses/old-licenses/lgpl-2.1.html. 
 
Some of the compiled or object code used by the CAFE Model was obtained from third-party 
sources.  Specifically, the code for randomizing the forecast data for the average fuel prices, 
which is executed as part of the CAFE Model’s uncertainty analysis, makes use of the inverse of 
the beta cumulative probability density function contained within the Meta.Numerics library (in 
particular, the InverseLeftProbability method of the BetaDistribution class is used).  The 
Meta.Numerics library (version 2.0.0, released on 4/06/2011) was obtained 
from http://www.meta-numerics.net and is distributed under the Microsoft Public License (Ms-
PL).  The latest version of the Ms-PL may be obtained from http://www.microsoft.com/en-
us/openness/licenses.aspx. 
 
If users of the CAFE model have any questions about this notice, please contact the current 
administrators of the CAFE Model project. 
 
  

http://www.notmart.org/
http://www.gnu.org/licenses/old-licenses/lgpl-2.1.html
http://www.meta-numerics.net/
http://www.microsoft.com/en-us/openness/licenses.aspx
http://www.microsoft.com/en-us/openness/licenses.aspx
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E.3 Installation and System Requirements 
 
The CAFE Compliance and Effects Modeling System (abbreviated: CAFE Model) runs on IBM-
compatible computers using the Microsoft® Windows operating system.  Although the software 
does not have strict hardware requirements, beyond what is needed to run the operating system, a 
1 GHz or faster Intel compatible processor, with at least 2 GB of physical memory (RAM) is 
strongly recommended.  The software has been developed and tested on computers using 
Windows XP/7 and Windows Server 2003/2008, but may operate properly on machines using 
older versions of Windows (e.g., Windows 2000), or newer versions (e.g., Windows 8), as long 
as a compatible Microsoft® .NET Framework is installed. 
 
The CAFE Model software uses Microsoft® Excel to read input files needed for modeling.  As 
such, Excel must be installed on the system.  The software also uses the Microsoft® .NET 
Framework, version 3.5.  If the Framework is not already present, it must be installed.  
Instructions for downloading and installing the .NET framework are available on the Internet 
at http://www.microsoft.com/download/en/details.aspx?id=22. 
 
Based on the characteristics of machines used in the development of this software, the following 
table provides a summary of system requirements: 
 

Table 47.  CAFE Model System Requirements 
Intel compatible processor (1 GHz or faster recommended) 
512 MB RAM (2 GB recommended) 
10 MB hard drive space for installation 
(additional disk space will be required during runtime) 
Microsoft® Windows XP/Vista/7 
Microsoft® Windows Server 2003/2008 
Microsoft® .NET Framework 3.5 
Microsoft® Office 2003 or later 

 
Once the system requirements have been met, the latest version of the CAFE Model may be 
obtained by contacting NHTSA or Volpe Center staff. 
 
The current version of the software is packaged in a way that does not require installation.  To 
operate the model, place the “CAFE Model.exe” file on the desktop and execute it35. 
 
  

                                                 
35 The CAFE Model files provided may be in a zip archive, which will need to be extracted using a zip utility such 
as WinZip (www.winzip.com) or 7Zip (www.7-zip.org). 

http://www.microsoft.com/download/en/details.aspx?id=22
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E.4 CAFE Model Graphical User Interface 
 
The CAFE Model Graphical User Interface (GUI) provides users with a set of tools necessary to 
set up and run multiple modeling test scenarios, which are commonly referred to as CAFE Model 
sessions.  Each CAFE Model session can be configured independently, each with its own set of 
model inputs and settings.  Once configured, the session may be saved for future runs, or 
executed immediately.36  When the model runs, the system displays the progress of the 
compliance modeling process in each session’s window. 
 
The model GUI consists of two primary screens:  the main CAFE Model window and the 
Modeling Settings window.  The CAFE Model window is used for managing the modeling 
sessions, while the Modeling Settings window is used to configure them. 
 
To run the modeling system, click on the CAFE Model executable file located on the desktop.  
When the application launches, a Warnings dialog box is displayed (Figure 13).  The user must 
read and understand the warnings listed prior to using the modeling system. 
 

 
Figure 13. Warnings Dialog Box 

 
After clicking the OK button in the Warnings dialog box, the main CAFE Model window, 
described below, opens. 
  

                                                 
36 It is recommended that users save the sessions prior to running them in order to assign a meaningful title to each 
session. 
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E.4.1 CAFE Model Window 
 
The main CAFE Model window (Figure 14) is used to create, configure, and manage CAFE 
modeling sessions.  The main window also controls the model operation, allowing users to start 
and stop modeling simulation. 
 

 
Figure 14. CAFE Model Window 

 
When the model first starts up, most of the menu items and toolbar icons are disabled, until a 
new session is created, or an existing one is opened. 
 
The model GUI is operated using a simple, easy to use file-menu (Figure 15), with most 
commonly used shortcuts also available on the model toolbar (Figure 16).  For user convenience, 
most of the menu entries may also be controlled using keyboard shortcuts. 
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Figure 15. CAFE Model File Menu 

 

 
Figure 16. CAFE Model Toolbar 

 
Some of the most commonly used file menus are: 

• File > New Session:  Creates a new CAFE Model Session and displays the Modeling 
Settings window to the user. 

• File > Open Session:  Opens an existing CAFE Model Session. 

• File > Close Session:  Closes the active CAFE Model Session. 

• File > Save Session:  Saves the active CAFE Model Session. 

• File > Start Modeling:  Begins the modeling process for the active CAFE Model Session. 

• File > Stop Modeling:  Suspends the modeling process of the active CAFE Model 
Session. 

• File > Exit:  Exits the CAFE Model.  If any of the modeling sessions are still opened, 
they will be closed prior to exiting the model. 

• View > Modeling Settings:  Displays the Modeling Settings window, where all modeling 
options and settings may be configured. 

• View > Optimization Settings:  Displays the Manage Optimization window, where 
additional options for Optimization modeling can be configured. 

• View > Monte-Carlo Settings:  Displays the Manage Monte-Carlo window, where 
additional options for Monte-Carlo modeling can be configured. 

• View > Output Location:  Opens the Windows Explorer and browses to the location 
where the output files and reports of the active session are saved. 
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E.4.2 Modeling Settings Window 
 
The Modeling Settings window contains multiple panels for configuring all of the runtime 
options available to the model.  The user can operate this window to set up a new session, or 
modifying an existing one, before starting the modeling process.  Each of the available 
configuration panels is outlined in the sections below. 
 
E.4.2.1 General Compliance Settings Panel 
 
The General Compliance Settings panel (Figure 17) is used to specify what type of modeling 
the user would like to run.  Each model is tailored to different type of analysis, using its own set 
of assumptions and configuration settings.  Presently, four model types are available: 

• Standard Compliance Model:  The Standard Compliance Model is the default mode of 
operation for the CAFE modeling system.  This model type is used to evaluate 
technology costs and benefits in response to the required CAFE standards defined in the 
modeling scenarios. 

• Compliance Model with EIS:  This model type is similar to the Standard Compliance 
Model, except additional analysis necessary for the Environmental Impact Statement is 
performed. 

• Optimization Model:  This model type should be used to perform analysis for optimizing 
the shape of the required CAFE standard. 

• Monte-Carlo Model:  The Monte-Carlo Model is a specialized CAFE modeling type, 
which is used for running customized Monte-Carlo simulations necessary for uncertainty 
analysis. 
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Figure 17. General Compliance Settings Panel 
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E.4.2.2 Input Settings Panel 
 
On the Input Settings panel (Figure 18), the user can select the input data files for use with the 
modeling system.  To protect Confidential Business Information (CBI), some of the input files 
may be password protected.  The system, therefore, provides an option for users to enter an input 
password prior to loading such files. 
 

 
Figure 18. Input Settings Panel (1) 
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When selecting input files, the model will attempt to verify if an appropriate file was used.  If 
incorrect file path is entered, an error message will be displayed (Figure 19). 
 

 
Figure 19. Input Settings Panel (2) 
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E.4.2.3 Output Settings Panel 
 
The Output Settings panel (Figure 20) is used to configure the location where modeling results 
will be saved. 
 

 
Figure 20. Output Settings Panel 
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The modeling system automatically generates the following eight output files (in CSV format) 
during runtime: 

• Technology Utilization Report:  Provides manufacturer-level and industry-wide 
technology application and penetration rates for each technology, model year, and 
scenario analyzed.  The results are disaggregated by regulatory class, as well as combined 
over the entire fleet. 

• Compliance Report:  Provides manufacturer-level and industry-wide summary of 
compliance model results for each model year and scenario analyzed.  The results are 
disaggregated by regulatory class, as well as combined over the entire fleet. 

• Societal Effects Report:  Provides industry-wide summary of energy and emissions 
effects for each model year and scenario analyzed.  The results are disaggregated by 
regulatory class and fuel type, as well as combined across all fuels and over the entire 
fleet. 

• Societal Costs Report:  Provides industry-wide summary of consumer and social costs for 
each model year and scenario analyzed.  The results are disaggregated by regulatory class 
and fuel type, as well as combined across all fuels and over the entire fleet. 

• Annual Societal Effects Report:  This output file is similar to the Societal Effects Report, 
except it further disaggregates the results by calendar year. 

• Annual Societal Costs Report:  This output file is similar to the Societal Costs Report, 
except it further disaggregates the results by calendar year. 

• Vehicles Report:  Provides a detailed view of the final state of each vehicle examined by 
the model, for each model year and scenario analyzed. 

• Optimization Report:  Provides functional coefficients and CAFE levels (required and 
achieved) for each iteration that was evaluated during optimization.  This output file also 
contains a brief snapshot of industry-wide results, per iteration, that aided the model in 
picking the optimum levels for each model year that was optimized. 
Note:  the Optimization Report is only generated when the Optimization Model is run. 

 
E.4.2.4 Runtime Settings Panel 
 
The Runtime Settings panel (Figure 21) provides additional modeling options to further 
customize the model behavior, beyond what is available in the input files: 

• Operate in “Maximum Technology” mode:  Specifies that the model should operate in 
“maximum technology” mode, where each manufacturer is assumed to be unwilling to 
pay CAFE fines, all vehicle refresh and redesign schedules are ignored, and all 
technologies are available for application immediately and without being subject to 
phase-in constraints. 

• Allow Voluntary Overcompliance:  Specifies that the model should continue to apply 
technologies after reaching compliance during a given model year, as long as the 
application of additional technologies is cost effective. 
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• Allow Credit Transfers and Carry Forward:  Specifies whether the model should be able 
to transfer credits between fleets (PC and LT) within the same manufacturer and model 
year, and whether the model should be able to carry past credits forward for up to five 
years within the same fleet and manufacturer. 

• Enable the Dynamic Fleet Share Model:  Specifies whether the model should 
dynamically adjust the model year’s PC/LT fleet share based on achieved CAFE levels 
from the previous year, the PC share from the previous year, and the current year’s fuel 
prices. 

• Merge the Fleet for Modeling:  Specifies whether to merge the entire industry into a 
single large manufacturer before beginning the modeling process. 

 
Some of the options loaded from a parameters input file may be overridden using the Runtime 
Settings panel as well.  If an “override” option is checked off (not selected), a default value from 
the input file is used.  If an override option is checked on (selected), that value will be used in 
place of what was loaded from the parameters file.  In Figure 21 below, the options for 
overriding the rebound effect and the discount rate are selected, and set to 20% and 7% 
respectively. 
 
The following options from the parameters file may be overridden: 

• Override Fuel Price Estimates:  Specifies whether to use the low, average, or high fuel 
price estimates from the parameters input file.  By default, average fuel price estimates 
are used. 

• Override CO2 Estimates:  Specifies whether to use low, average, high, or very-high 
carbon dioxide cost estimates from the parameters input file.  By default, average CO2 
cost estimates are used. 

• Override Rebound Effect:  Overrides the Rebound Effect value read in from the 
parameters file with a user defined value.  Valid values are between -1.00 and 1.00. 

• Override Discount Rate:  Overrides the Discount Rate value read in from the parameters 
file with a user defined value.  Valid values are between 0.00 and 1.00. 

• Override Value of Travel Time per Vehicle:  Overrides the Value of Travel Time per 
Vehicle value read in from the parameters file with a user defined value. 

• Override Military Security Cost:  Overrides the Military Security component of 
economic costs read in from the parameters file with a user defined value. 

• Scale Consumer Benefits During Effects Calculations:  Specifies whether the model 
should scale the private consumer benefits by a specific percentage during the effects 
calculations.  Valid values are between 0.00 and 1.00. 
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Figure 21. Parameters Overrides Panel 
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E.4.3 Manage Optimization Window 
 
The Manage Optimization window (Figure 22) provides additional options necessary for 
configuring the system for optimization modeling. 
 
The first set of options determines the type of optimization – that is, which fleet the model 
should optimize: 

• Cars:  Forces the modeling system to optimize vehicles regulated as passenger 
automobiles only.  If the market data input file contains any vehicles regulated as light 
trucks, the value of CAFE standard for those vehicles will be kept at a constant rate 
throughout optimization. 

• Trucks:  Forces the modeling system to optimize vehicles regulated as light trucks only.  
If the market data input file contains any vehicles regulated as passenger automobiles, the 
value of CAFE standard for those vehicles will be kept at a constant rate throughout 
optimization. 

• Auto-detect:  Allows the model to automatically determine whether to optimize 
passenger automobiles or light trucks.  This option is useful if the market data input file 
contains only one class of vehicles (e.g., cars-only or trucks-only).  If the market data file 
includes a mixed fleet of vehicles (passenger autos and light trucks), this option should 
not be used. 

 
The next set of options determines the optimization mode the model should use when identifying 
the optimum value of the CAFE standard: 

• Optimize based on maximum Net Benefits:  Specifies that the optimization model should 
optimize the value of CAFE standard based on the difference between the discounted 
social benefits and technology costs, by maximizing that difference. 

• Optimize by minimizing Net Benefits, after the maximum has occurred:  Specifies that 
the optimization model should optimize the value of CAFE standard based on the 
difference between the discounted social benefits and technology costs, by finding the 
lowest positive difference after the maximum difference has occurred. 

 
Additional optimization options are: 

• Iterations above optimum:  Indicates the number of iterations to examine above the 
initially calibrated shape of the target function, by moving the function upwards in GPM 
space.  Raising the function produces a less stringent value of CAFE standard.  Valid 
values are between 0 and 1000. 

• Iterations below optimum:  Indicates the number of iterations to examine below the 
initially calibrated shape of the target function, by pushing the function downwards in 
GPM space.  Lowering the function produces a more stringent value of CAFE standard.  
Valid values are between 0 and 1000. 

• Increment by:  Specifies the value by which to increment the target function in GPM 
space.  Valid values are between 0.00001 and 0.1. 
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• Begin optimizing starting with the specified year:  Specifies the first model year to 
optimize. 

 

 
Figure 22. Manage Optimization Window 
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E.4.4 Manage Monte-Carlo Window 
 
The Manage Monte-Carlo window (Figure 23) provides additional options necessary for 
configuring the system for Monte-Carlo modeling.  During modeling, the system will use an 
input file specified here, containing trials to use for analysis.  Upon completion of the modeling 
process, the system will automatically generate Monte-Carlo log files. 
 

 
Figure 23. Monte-Carlo Model Settings Panel 
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E.5 CAFE Model Usage Examples 
 
This section provides examples for configuring and running the CAFE Model sessions using 
various model types. 
 
E.5.1 Example 1 – Configuring for Standard Compliance Modeling 
 
This example demonstrates the steps necessary for configuring the modeling system to perform a 
regular Compliance Model run. 

• Run the CAFE Model by clicking on the CAFE Model executable located on the 
desktop.  Read through the Warnings dialog box, and then click the OK button. 

• Select File > New Session to create a new modeling session.  The Modeling Settings 
window appears.  Note the errors at the bottom of the window; these indicate that the 
input files have not been selected. 

• On the General Compliance Settings panel, select the Standard Compliance Model as 
shown in Figure 24 below. 

 

 
Figure 24. Select Standard Compliance Model 
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• Click on the Input Settings panel to select the input files to use for modeling (Figure 25).  
Note that once all the input files have been selected appropriately, the error messages 
disappear. 

 

 
Figure 25. Select Input Files 
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• On the Output Settings panel, select the location for output files (Figure 26). 
 

 
Figure 26. Select Output Location 
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• The Runtime Settings panel is not used for this exercise. 

• Click the Save button to save the modeling settings and load the input files (Figure 27). 
 

 
Figure 27. Save Modeling Settings 
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• Once loading completes, click the Close button to return the main CAFE Model 
window.  A new Compliance Model session, titled “Session 1” has now been created 
(Figure 28). 

 

 
Figure 28. New Compliance Model Session Created 
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• Save the new session by selecting File > Save Session As....  Enter “demo.cmsd” in the 
dialog box that appears, and click the Save button (Figure 29). 

 

 
Figure 29. Save New Session 
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• After the session has been saved, notice the title of the session has changed to “demo” 
(Figure 30). 

 

 
Figure 30. “demo” Session Saved 
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• Select File > Start Modeling to start the compliance modeling process.  As the model 
runs, the progress of the Compliance Model is displayed in the session window (Figure 
31). 

 

 
Figure 31. Modeling Progress from the Compliance Model 
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• After modeling has completed, the “Modeling Completed!” message appears at the 
bottom of the main CAFE Model window (Figure 32). 

 

 
Figure 32. Compliance Model Completed 

 

• Select View > Output Location to open Windows Explorer and browse to the location 
where model outputs for the “demo” session are saved. 

• Exit the session by selecting File > Close Session. 

• Exit the CAFE Model by selecting File > Exit, or proceed to the next example. 
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E.5.2 Example 2 – Configuring for Optimization Modeling 
 
This example demonstrates how the take an existing session created in Example 1 – Configuring 
for Standard Compliance Modeling, and modify it to run the Optimization Model. 

• Run the CAFE Model by clicking on the CAFE Model executable located on the 
desktop.  Read through the Warnings dialog box, and then click the OK button. 

• Select File > Open Session to open an existing modeling session.  Select “demo.cmsd” 
in the dialog box that appears, and click the Open button (Figure 33). 

 

 
Figure 33. Open “demo” Session 
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• Once the session has been loaded, select View > Modeling Settings to bring up the 
Modeling Settings window.  There select the Optimization Model as in Figure 34. 

 

 
Figure 34. Select Optimization Model 
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• Under the Input Settings panel, select a market data file containing data for the light 
truck fleet only, as well as a scenarios file required for optimization modeling (Figure 
35). 

 

 
Figure 35. Select Scenarios File for Optimization 
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• The Output Settings and Runtime Settings panels are not used for this exercise. 

• Click the Save button to save the updated modeling settings; then click Close, once 
saving completes. 

• Select View > Optimization Settings to bring up the Manage Optimization window, 
then configure the system for optimization modeling as specified in Figure 36.  (**Note:  
with this version of the model, the system has been modified from using linear/additive 
stringency increments to multiplicative stringency increments.  Hence, setting the 
increment incorrectly may lead to undesired behavior.) 

 

 
Figure 36. Configure Optimization Model Settings 

 

• Click the Save button to save the Optimization Model settings; then click Close. 
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• To prevent overwriting results from the “demo” session, select File > Save Session As... 
to save the modified session with a new name.  For this example, the optimization session 
was saved as “demo-opt.cmsd” (Figure 37). 

 

 
Figure 37. Save Modified Session 

 
  



 

120 

• Select File > Start Modeling to start the optimization modeling process.  As the model 
runs, the progress of the Optimization Model is displayed in the session window (Figure 
38). 

 

 
Figure 38. Modeling Progress from the Optimization Model 

 

• After optimization modeling has completed, the “Modeling Completed!” message 
appears at the bottom of the main CAFE Model window.  Select File > Exit to exit the 
model. 
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